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CHAPTER ONE
GETTING STARTED

INTRODUCTION

Your Atari MEGA STE computer system combines the latest micro-
computer technology with an easily understood and simple-to-use
working environment. MEGA STE computers come standard with
the following:

« A 16 MHz 68000 processor

A palette of 4,096 colors; three different video modes

+ An 80-column display

» Two or four megabytes of RAM, depending on the model

e An optional 68881/2 floating point coprocessor for faster
information processing

A built-in double-sided floppy disk drive that stores up to 726,016
bytes of information

e A built-in hard disk drive

« Ports for adding: an additional floppy disk drive, ACS| (DMA)
devices, a parallel device, serial devices, MIDI instruments, and
stereo speakers

e A Local Area Network (LAN) interface
e A VMEbus for high speed asynchronous parallel data transfer
» A cache option for faster information processing

e The operating system, TOS, permanently installed in memory.
TOS includes GEM, the powerful Graphics Environment Manager.
GEM provides the visual representation of the computer’s
operations

« The Control Panel desk accessory contained on the built-in hard
disk drive and on the USA Language floppy startup disk

« A complete collection of hard disk utilities on the Atari Hard Disk
Ultilities disk

Gelling Started
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Using This Manual

Operating your computer is easy. This manual explains in clear,
nontechnical language how to operate your computer. After you
become familiar with the computer, use this manual as a reference
guide to individual procedures and specific information.

Computer owners living in the United Kingdom should refer to
Appendix G for additional instructions when connecting their system.

A summary of each manual section follows:

Chapter One: Getting Started familiarizes you with the compo-
nents of the computer system. This chapter explains how to unpack
the computer and connect the system components, and explores
the major features and available options.

Chapter Two: Using the MEGA STE introduces more basic
computer concepts, describes how to start up and switch off your
system, and discusses the GEM Desktop environment.

Chapter Three: Basic Skills Tutorial explains how to use the
elements of the GEM desktop to manage information, both on
screen and on disk. The tutorial teaches how to use the cursor,
work with windows, copy and delete icons, folders and files, and
format a floppy disk.

Chapter Four: Advanced Desktop continues where the tutorial
left off and explains advanced desktop functions such as: updating
a directory display, entering information when a dialog box displays,
and advanced menu bar commands.

Chapter Five: Directories, Folders, and Files teaches you all
about files, filenames, folders and directory structures. This chapter
also explains how to use files and directories (folders) to develop
and maintain an efficient working environment.

Chapter Six: Desk Accessories explains how to install and use
desk accessories, and also describes in detail the Control Panel
desk accessory included with your system.

Getting Started
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Appendix A: MEGA STE Panels and Ports presents labelled
drawings of the MEGA STE's side and rear panels.

Appendix B: Pointer Control Quick Reference is a chart
describing pointer actions and how to achieve them using the
mouse or keyboard. Keep this chart near the system for quick
reference.

Appendix C: Advanced Hard Disk Utilities describes how to
use the hard disk drive utilities.

Appendix D: Troubleshooting and Preventive Maintenance
offers solutions to problems you may encounter while connecting or
operating the MEGA STE computer. The appendix includes guide-
lines for proper maintenance of the computer system.

Appendix E: MEGA STE Computer Specifications sum-
marizes the major features and requirements of the MEGA STE
computer.

Appendix F: Connector Pinout Specifications shows the pin
assignments of the computer ports.

Appendix G: Power Connection in the United Kingdom
provides additional setup instructions for MEGA STE computer
owners in the United Kingdom.

Glossary defines common technical terms used in this manual as
they relate to your computer.

Index helps you locate terms and procedures used or explained in
the manual.

Customer Support tells where to find more information about
the Atari MEGA STE computer as well as other Atari computer
products.

Gelting Started
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Special Notations

Characters enclosed by square brackets ([ 1) represent keys on the
computer keyboard. Sometimes a procedure requires you to use
two or more keys at the same time. For example, [Control] [X]
means to hold down the [Control] key while you press the [X] key.

Paragraphs marked Note or Warning appear throughout the
manual.

Note: Notes contain useful hints and other information
relevant to the topic being discussed.

@ Warning: Warnings alert you to potential problems and
suggest ways to avoid those problems.

SETTING UP YOUR SYSTEM

o

Set up your system in a workspace that is both healthy for the
computer and comfortable for you. Choose a workspace with

a sturdy, level surface close to an electrical outlet, with plenty of
room for airflow around the system. Protect the system from dust,
grease, extreme temperatures, direct sunlight. and high humidity.
An environment that works well for a television or stereo system
will also suit the computer.

Carefully unpack the computer console, keyboard, mouse, and
monitor. Remove all packing materials (including the protective
inserts in the floppy disk drive and the mouse) and save them for
storing or shipping the system later. Then follow the instructions in
this section for connecting the system.

Note: You will find labelled diagrams of the MEGA STE 's panels
and ports in Appendix F, MEGA STE Panels and Ports.

Getting Started
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Connecting the Keyboard

Keyboard and Mouse

One of your computer's convenient features is the detached key-
board. You can pasition the keyboard at whatever angle is most
comfortable for you. If you prefer a sloped keyboard, turn the
keyboard upside down and flip the two plastic retractable feet on
the bottom of the keyboard towards the back. This raises the back
of the keyboard. Flip the feet back into the retracted position to
make the keyboard lie flat.

A mouse is a device that allows a special type of communication
with your computer. Rolling the mouse on a flat surface moves a
cursor on the screen. You move the mouse and click the mouse
buttons to perform select, move, delete, edit, and other operations
on icons, text, and graphics displayed on your screen.

A coiled cord with a standard phone connector connects the key-
board to the computer console. Plug the connector into the jack on
the left side panel of the MEGA STE .

Connecting the Mouse %

The mouse connects to the computer through the keyboard. The
mouse and joystick ports are located on the sides of the keyboard.

To connect the mouse, insert the mouse cable connector into the
Mouse/Joystick port on the right side of the keyboard.

Monitor

You can use a computer monitor to provide the video display for
your computer. If you are using a television for your video display,
refer to the next section, Television.

Getting Started
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Connecting the Monitor $

First connect the monitor's video cable into the monitor (if not
already attached). Connect the other end of the cable to the
Monitor port on the back panel of the computer. Use of an adaptor
plug (supplied with the monitor) may be required.

Connect the power cable to the back of the monitor, then insert the
plug into a gr%unded wall outlet or power strip. (Consult the manual
supplied with the monitor for further information.)

Television

The MEGA STE computer is equipped with a television port. You
can use a television instead of a monitor as the computer video

display.

@V Connecting the Television

& o0
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You will need the following to connect a television to a MEGA STE:

* A color or black and white television.
e A small flat-bladed screwdriver.
« Adaptors (VHF or antenna cable) to complete the setup.

1. Disconnect your present VHF antenna cable or cable television
line from the VHF terminal on the back of your television.

2. If the cable or line has a flat twin-lead connector, attach it directly
to the screw terminals on the bottom of the television switch box
and use a screwdriver to tighten the connection.

If the antenna cable or line has a round screw-on connector,
attach it to a VHF adaptor (a 75 to 300 ohm converter) and then
attach the VHF adaptor to the screw terminals on the bottom of
the television switch box. (You can buy this VHF adaptor at most
television or electronics stores.) Use a screwdriver to tighten the
connection.

3. Connect the twin-lead cable from the switch box to the VHF
terminal on the back of your television. If the VHF terminal has
two screws, attach the switch box cable directly to the screws.
Use a screwdriver to tighten the connection.

If the VHF terminal has a screw-on connector, you'll need a line
transformer (a 300 to 75 ohm converter). This transformer is
available at most television or electronics stores. Attach the twin
leads on the switch box to the screws on the transformer, then
plug the transformer into the VHF terminal.

4. Move the sliding switch on the switch box to the COMPUTER
position.

5. Plug one end of the video cable into the port labeled COMPUTER
on the switch box, and the other end into the TV port on the back
of the MEGA STE.

6. Set the Lo/Hi switch on the back of the MEGE STE to Lo if
channel 3 broadcasts in your area. Set the Lo/Hi switch to Hi
if channel 2 broadcasts in your area.

Getting Started
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‘ Power Cable

The computer’s power cable provides power to the computer and
the built-in (internal) disk drives. The green light on the computer
lights up when power to the computer is switched on. The disk drive
busy light is lit when the drive is sending, receiving, or saving data.

Connecting the Power Cable

o

o
The On/Off switch turns the The power cable connects the
computer on and off; | is on, computer to the electrical
O is off. outlet.

Toggle the computer’s power switch to the off position. Remove
theggrotective insert from the floppy disk drive. Connect one end of
the power cable into the jack marked Power on the back panel

of the computer. Then insert the cable’s three-pronged plug into a
grounded wall outlet or power strip.

Built-in Floppy Disk Drive

Your computer comes with a built-in double-sided ilqppy disk drive.
The floppy disk drive slot is located on the computer’s front panel.

The built-in floppy drive is known as drive A. However, the desktop
displays two floppy disk icons, A and B. In systems with only one
floppy disk drive, the built-in floppy drive acts as both drive A and

drive B.

Getling Started
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Built-in Hard Disk Drive

A hard disk drive stores much more information and transmits that
information faster than a floppy disk drive. The hard disk is a rigid
plate coated with a substance which can receive and store data.
The disk is sealed into the drive, protected from dust and physical
damage. As the drive spins the disk at a very high speed, informa-
tion is written to or read from the disk. Read/write heads. similar

to those on a tape player or VCR, cruise across the disk and read
or write information without actually making contact with the disk.
Information on your hard disk is transferred to and from the com-
puter's memory through electronic circuitry.

Your built-in hard disk was formatted and partitioned at the factory
and is ready to use. If you would like more detailed information
about the utilities on the Advanced Hard Disk Utilities Disk, includ-
ing how to reformat or repartition your hard disk, see Appendix C,
MEGA STE Advanced Hard Disk Ulilities.

You can also connect additional hard disk drives to your computer.
(See Acsl.)

Reset Button o

The reset button restarts the computer without switching it off.
Restarting the computer this way is known as a warmboot. You can
also perform a warmstart by pressing [Control] [Alternate] [Delete] .

Cartridge Slot

Cartridges containing programs can be inserted into the cartridge
slot. Cartridges contain all the memory needed for running the
cartridge program. A single cartridge can contain up to 131, 072
bytes (128 kilobytes) of program information. The system recog-
nizes the cartridge slot as drive c.

Getting Started
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Inserting a Cartridge

Switch off the computer and all peripherals. Insert the cartridge,
label side up, into the cartridge slot. Switch on your system. The
program on the cartridge loads automatically.

Quick Start

You have connected your system, and you know some information
about your computer's basic components and features. The follow-
ing section describes additional ports and expansion slots and
explains how to connect various peripheral devices. If you have no
devices to connect and you wish to start your system now, skip
ahead to Starting your System in Chapter Two.

MEGA STe PORTS AND EXPANSION SLOTS

The panels on your computer contain ports. A port is an entryway
into your computer through which you can connect peripheral
devices such as printers and hard disk drives. Your computer
communicates with peripheral devices by sending and receiving
signals through the ports. Small icons identify most ports. This
section discusses each port and its use. (See Appendix A, MEGA
STE Panels and Ports, for labelled drawings.)

Your computer also contains a VMEbus expansion slot. You can
connect high speed VME devices to your computer through this
expansion slot.

Switch off your computer and all peripheral devices before
connecting any new peripheral device. Some peripheral cables
have small retaining screws or clips on the sides of the connector.
Tighten the screws or attach the clips to maintain a strong
connection between the computer and the peripheral. This will also
help eliminate interference which might affect television or radio
reception in the area.

Warning: Never touch the exposed contacts on any port or expan-
sion slot. Static electricity could harm the sensitive electronics inside

the computer.

Getting Started

External Floppy Disk Drive

g

In addition to the floppy disk drive built into the compu

t
connect a second, external floppy disk drive. This sgf:o?mrc'{ ¥lg:§§? %
disk drive can be either the Atari SF314 or 354 double sided 3V2-
inch disk drive or the Atari PCF554 5V4-inch disk drive. A second

disk drive makes copy operations, and dat i
more convenient. ' a storage and retrieval

Note: The Atari PCF554 5Va-inch disk drive lets you
| . use MS-
format compatible SVa-inch data disks with your cyornputer. YOBOS
\.n\.?ilt-lt?tytong:a” a sp?cualcdevtlce recognition program to use this drive
computer. Contact Atari Cust
el GO omer Support or your dealer

Connecting an External Floppy Disk Drive @
N

o

Switch off the computer and all peripherals and rem &
tive ujsgrt from the disk drive. Connect one end of th%vﬁc:SSypé?stEc
drive's interface cable into the port labeled Floppy Disk on the back
panel of the computer. Connect the other end into the port labeled
In on the back of the drive. Insert the round plug on the drive's
ggf:r?r_?aptor m:otr:he jack labeled Power on the back of the disk

. I'hen insert the power adaptor's three- '
grounded wall outlet or power str?p. =Rihasepug e

Note: You can connect only one external flo i i

ppy disk drive to the
computer system. The computer always refer
floppy disk drive as drive B. g L

ACSI| (DMA)

The Atari Computer Systems Interface (ACSI) port is a hi

Direct Memory Access (DMA) interface. The DRAA chi?) rijriug)rr-lc:ffr)%d
computer allows connected DMA devices to communicate directly
with the computer's memory, without having to go through the CPU
The DMA chip transfers data much faster than the CPU can, and '
using the DMA chip frees the CPU for other tasks. J

1-10 Getting Started
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You can attach an Atari DMA hard disk drive, Atari SLM laser
printer, CDAR504 compact disc drive or other high-speed DMA
peripheral to this port. You can daisy-chain up to four DMA devices
to the computer through the DMA port.

Daisy-chaining is a way to connect more than one peripheral device
to a single port. The first device in the chain connects to the com-
puter, and the rest of the devices in the chain connect to each
other. For example, device A would connect to the computer,
device B would connect to device A, device C would connect to
device B, and so on. See the manual supplied with the peripheral
for more detailed information.

Connecting a DMA Device o/

Switch off the computer and all peripherals. Connect one end of the
DMA device's interface cable to the port labeled DMA on the back
panel of the computer. Connect the other end of the interface cable
to the IN port on the back of the DMA device. Connect the power
cable to the power jack on the back of the device, then insert the
three-pronged plug into a grounded wall outlet or power strip.

Printer

The Printer port is a standard parallel interface. You can attach
almost any parallel printer to this port. (Refer to the manual
supplied with your printer for further instructions.) However, you
must use the ACSI port to connect an Atari laser printer.

Connecting a Parallel Printer @,

Switch off the computer and all peripherals. Connect one end of the
printer’s interface cable to the port labeled Printer on the back panel
of the computer. Connect the other end to the port on the printer.
Connect the power cable to the power jack on the printer, then
insert the three-pronged plug into a grounded wall outlet or power
strip.

Getling Started
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Modem and Serial

The Modem and Serial ports are used for serial (one bit at a time)
transmission of data over a single wire. You can connect a standard
modem to either or both fully configured RS232 Modem ports. The
computer uses a modem to transmit and receive information to and
from other computers over telephone lines. You can use the Serial
or Modem ports to connect any serial printer or other serial device
to your computer.

There is one serial port on your computer. You can connect serial
devices to the serial port unless you are also using the Local Area
Network (LAN) port. If your computer is connected to a LAN, the
serial port is disabled.

Modem Serial

LAN

A Local Area Network (LAN) is a communications channel that

connects computers and other devices together. Each device or

computer in the network is called a node. Nodes are usually

So_mputers and input/output devices such as printers and disk
rives.

ssses

Sharing access to network devices is very convenient when more
than one user must have access to the same information. For
example, a user at one location could update an inventory database
by adding received goods, while a user in another location could
deduct sales from the same database.

VMEDbus

You can install a VME card into the VME-compatible Eurocard
(A24, D16) expansion slot. Use the VMEbus for high speed
asynchronous parallel data transfer between the computer and any
VME device. For complete instructions on how to connect a VME
device to your computer, consult the device's owner’s manual.

Getting Started
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Stereo

A stereo amplifier connected to the RCA stereo ports on your
computer provide stereo sound when used with software that
supports this feature. The 8-bit digital-to-analog sound converters
contain hardware filters to. prevent digital distortions (such as

aliasing), resulting in realistic Pulse Code Modulated (PCM) sound.

Connecting a sound system also improves the sound quality of
software not specifically designed to take advantage of stereo.

Connecting Stereo Headphones or Speakers R J" L
Switch off the computer and all peripherals. Connect the left and

right audio cable plugs to the corresponding stereo ports on the
computer.

Joystick

Joysticks control the screen action of some computer games. (See

the manual supplied with the game for specific information on using

the joystick.)

Note: Joysticks must be purchased separately.

Connected joysticks can interfere with the initialization of keyboard
functions during the starting process.

Connecting a Joystick #}

Connect Atari-compatible joysticks through either mouse/joystick
port O or joystick port 1.

Getting Started
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Warning: Disconnect joysticks before switching on your computer.

MIDI

MIDI stands for Musical Instrument Digital Interface. The MIDI
capabrlmes', of your computer help you create and record music one
track at a time. You can connect your computer to electronic
musical instruments through the two MIDI ports. The Midi In port
allows the computer to control a synthesizer or any MIDI-equipped
!nstrument; Thrqugh the Midi Out port, the computer controls an
Instrument’s digital interface, letting you play complex compositions
while changing the volume, tempo, and instrumentation. MIDI
interfaces and appropriate software can allow your computer to
function as a sophisticated sound studio recorder.

Connecting an Electronic Musical Instrument J‘

Connect a MIDI instrument to the Midi In and Midi Out ports on the

left sidq panel. Refer to your MIDI instrument's manual for
instructions.

Getting Started
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CHAPTER TWO
USING THE MEGA STE

FUNDAMENTAL CONCEPTS

This section explains how a computer works, what memory is, and

how to start up your system from the built-in hard disk drive or from
a floppy startup disk.

How the MEGA STE Works

A computer processes instructions to perform a task. Two examples
of instructions are the operating system instructions on your com-
puter’'s Read Only Memory (ROM) chip, and the instructions in an
executable program contained on a disk. Your computer receives
these instructions as electronic signals to be processed and/or
stored. The processing and storing of data (sets of electronic

signals grouped together) is handled by a system of electronic
components and integrated circuits.

Memory

Your computer uses two types of memory: internal memory, and
external memory. Internal memory is information storage_location_s
on microchips inside your computer. External memory is information

storage locations on hard disks, removable cartridges, floppy disks,
and CD-ROM discs.

A computer’s memory capacity is measured in bytes. Since
computer language is based on the binary numbers system, the

smallest data unit is one Blnary digiT, or BIT. Groups of 8 bits are
called bytes.

A Kilobyte is 1,024 bytes; a megabyte is 1,024 kilobytes. Each

MEGA STE has 256 kilobytes of ROM and 2 or 4 megabytes of
RAM.

Using the MEGA STE
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Internal Memory Storage

There are the two types of internal memory: ROM and RAM.

ROM means Read Only Memory. As its name implies, you cannot
write more information into a ROM storage area. The information in
ROM is permanent, and cannot be erased. ROM chips inside the
computer contain the operating system information.

RAM means Random Access Memory. The RAM area within a
computer is for temporary storage of information. RAM is the
computer’s chalkboard. The computer can quickly and efficiently
access programs and data files written into RAM. To save informa-
tion stored in RAM, you must transfer the information from RAM
into external memory storage. Turning off your computer erases the
RAM chalkboard.

External Memory Storage

External memory storage disks include cartridges, floppy disks,
standard hard disks, hard disks in removable cartridges, and
CD-ROM discs.

Floppy and hard disks store information which can be read from the
disk into RAM, modified if desired, and later saved back to the disk

from RAM. Information on floppy and hard disks can be erased and
the disk reused. Magnetic floppy disks for your computer can store

either 357,376 bytes (single-sided disks) or 726,016 bytes (double-
sided disks) of data.

CD-ROM discs store information that can be read into RAM for
processing. You cannot write any additional data onto a CD-ROM

disc.

TOS

TOS is the name of the computer’s operating system. TOS controls
the way the computer works, handling tasks such as reading from
and writing to disks, translating mouse movement into onscreen
cursor movement, and displaying information on the screen.

Using the MEGA STE
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GEM, the Graphics Environment Manager, is an important part of
TOS. GEM provides a graphic interface for the computer. This
allows a screen display of information as graphic images (such as
picture icons and windows) as well as letters, numbers, and
symbols.

STARTING YOUR SYSTEM

You have connected the hardware and you have learned the
fundamentals of how your computer works. The next step is to
switch on your system. The ROM chips inside your computer
contain the operating system, so you do not need a system (boot)
disk in the floppy drive to start your computer. However, you can
have your computer read additional startup information and files
during the startup process. All of the startup information read during
the startup process will be automatically available when the desktop
appears.

You can store startup information on a hard disk or a floppy startup
disk. Your built-in hard disk already contains startup information
and will automatically access this information when you switch on
your system. This is the quickest and most convenient way to start
your system.

In rare cases, storing startup information on floppy disks may be
necessary. For example, you may have a large number of desk
accessories, more than you can have active at one time. If you only
need certain desk accessories active when you are doing specific
tasks (such as word processing, using your database, etc.) you
could create a custom floppy startup disk for each activity. The
startup disk you use would depend on the activity. Most users will
find this to be unnecessary and time consuming. It is much more
convenient to store your startup information on the buili-in hard
disk.

If you wish to start your system from a floppy startup disk, skip to
the section Starting Your System from a Floppy Startup Disk. |f you
wish to start your system from the hard disk, continue to the next
section, Starting Your System from the Hard Disk.

Using the MEGA STE
23




Starting Your System from the Hard Disk

Your built-in hard disk contains the following startup information and
files:

« The Control Panel desk accessory (XCONTROL.ACC)

« An SHDRIVER.SYS file. This file contains the startup information
on the hard disk.

When you start your system, the computer reads the startup
information on the hard disk. When the startup procedure is
complete, the desk accessory will appear under the Desk menu,
and drive C will contain folders and files.

Follow these steps to start your system from the hard disk:
1. Switch off your computer and all peripherals.

2. If you have an Atari laser printer connected to your system,
switch it on.

3. Next switch on the monitor, second floppy disk drive, external
hard disk drive (see your hard disk drive owner's manual for
further instructions), all other devices (such as a second hard
disk, parallel printer, or modem).

If you have a connected external hard disk drive, wait until the
hard drive busy light goes off before switching on another
device.

4. Switch on your computer. When the internal hard drive has
completed its initialization, press any key. Pressing a key at this
stage speeds up the startup process by a considerable amount
of time. (The hard disk drive makes a certain sound during
initialization. When initialization is complete, the sound stops.)
The desktop displays.

Note: If the desktop does not appear on the screen, switch off the
computer. Make sure the monitor is switched on and all cable
connections are correct and secure. Switch on the system again. If
the desktop still fails to appear, see Appendix B, Troubleshooting and
Preventive Maintenance.
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That's all there is to it. There are several reasons other than the
ones already mentioned that may make it necessary for you to start
your system from a floppy startup disk. Some games and copy-
protected programs require that you start your system from the
floppy program disk. If you want to learn how to start your system
from a floppy startup disk, read the next section. Otherwise, skip
ahead to Initial Screen Display-GEM Desktop.

Starting Your System from a
Floppy Startup Disk

The easiest way to start your system from a floppy disk is to bypass
the installed hard disk driver on the internal hard disk drive. Then
you can run the AHDI.PRG program from the Advanced Hard Disk
Utilities disk so your computer will recognize the presence of the
hard disk drive.

It will be helpful for you to follow the tutorial in Chapter Three before
you attempt to start your system from a floppy disk. The tutorial will
teach you all the skills you need to easily follow the floppy disk
startup instructions.

Warning: Before starting your system from the USA Language

disk, follow the instructions in the next chapter to make a working

gp?‘y of the disk. Always use the working copy—-never the original
isk.

Follow these steps to start your system from a floppy startup disk:

1. With your computer switched off, insert the working copy of the
USA Language disk into drive A,

2. Switch on the computer. When the power light comes on,
immediately hold down [AIltl. As soon as the floppy drive busy
light comes on, release [Alt]. Wait several seconds, then press
any key. After a short delay the desktop displays, containing
three icons (floppy disk icons A and B, and the trash can icon)
and a menu bar.
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If you are starting your computer from a commercially prepared A hard disk icon is an entrance to the inf i
program disk, the program may run at this time and the desktop a partition. All hard disk icons are auténmg{g;};oasggﬁzgioarea e
may not display. You do not need to follow the additional steps.) Since your built-in hard disk drive has four partitions, four hra):guciisk

y . ‘ icons display on your sc
0 Note: If you are not using a commercially prepared program disk i i

to start your system, and the desktop does not display, switch off Each icon must have it ; ; "
the computer. Make sure the video display is switched on. the must be in alphabeticIsigggnzglq‘lrﬁé?gﬁé r'gi“gf'%ré aﬂd the letters
disk is correctly inserted in drive A, and all cable connections are been used for floppy disk icons, and the letters (?th il
correct and secure. Switch on the system again. If the desktop represent logical drives (the ookt Baritions ob your ﬁg?ggi;ﬂ

still fails to appear, see Appendix B, Troubleshooting and

Preventive Maintenance.
Flo ;
4 Remove the USA Language disk from drive A. Insert the working ppy Disk and Trash Can Icons

i:f(\)p)é_oi tl?e Advanced Hard Disk Utilities disk into drive A. Display Two of the disk icons that first appear are labeled FLOPPY DISK

e directory. ij_oth A and B icons appear even if you have only one floppy disk

5. Open the Auto folder. Open (run) AHDI.PRG. This will allow the Ursl,‘;e{r)]g?u LI'TSE these icons to access information on floppy disks.
computer to recognize the presence of the hard disk drive. After Gioka rash can icon to delete unwanted files or folders from

the program runs, close all windows.

The trash can icon works like an incinerator. Once you throw a file

6. To install hard disk icons, select Install Devices from the Options ! }
or folder in the trash, that file or folder is gone forever.

menu. All hard disk icons appear on the screen.

Menu Bar

Initial Screen Display-GEM Desktop

When you switch on your system, the computer reads the startup
information from the hard disk or the startup floppy disk and loads
that information into RAM. The desktop appears on your screen.

The desktop also displays four menu names alo

_ ng the top ed
the screen. Each menu bar heading (Desk, File, \%ew, anpd Ogt?oﬁfs)
has its own drop-down menu, from which you can select options
(chapter Four gives a detailed description of the menu bar optioris.)

GEM Desktop is the starting point for almost everything you do with
the computer. The basic desktop contains two floppy disk icons,
four hard disk icons, and a trash can icon on the left edge of the
screen. a menu bar at the top of the screen, and a pointer.

Pointer

The final basic desktop element is the poi
: pointer (cursor). The
can also appear in the shape of an |-bar or a busy bee icon.wrsor

Hard Disk Icons ggp?r?dir;g c;n the activity. The I-bar usually represents an insertion
int for ¢
Your built-in hard disk drive is already formatted and divided into computer?g p'?gtcrgé:iﬂg Lhat?ab.usy bee icon appears when your

sections (partitions). Having more than one partition makes it easier
for you to organize your files. For example, you can use one
partition to store all of your word processing programs and files,
another for databases, efc.
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KEYBOARD FEATURES

Much of what you will do with the computer will involve pressing
keys. The keys you will use most often with word processing
applications are letter keys. You will use number keys most often
with spreadsheet programs.

The computer keyboard is similar to a conventional typewriter
keyboard in both design and function. For example, the [Return] key
on the computer keyboard acts like the carriage return lever (or
key) on a typewriter. Pressing [Return] moves the cursor down the
screen.

Most keys automatically repeat when held down. (For information
on changing the rate of automatic repeat, see Control Panel in
Chapter Six.)

I | A
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The alphanumeric keys (letters, numbers, and symbols) usually
have the same function as similar keys on a typewriter. Press [S] to
produce a lowercase letter s and press [Shift] [S] to produce the
uppercase letter S. Press [Caps Lock] to toggle (switch back and
forth) between upper and lower case letters.

In addition, several keys on the computer’s keyboard perform
special functions not found on a typewriter.

For example, you can use [Control], [Alternate], and [Shiit] in
conjunction with another key to produce a secondary function or
code. Hold down one or more of these keys while pressing another
key.
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Along the top of the keyboard are the function keys [F1
[F10]. Holding down [shift] while pressing funclior): k(leys]atgé%léggs

ten more function keys: [F11] through [F20]. Sof cest
often assign special functions to thgse keyg_ tware aplications

Use the four arrow keys to move the cursor in the directi
Use e direction
indicated by the arrow. The cursor is a movable graphic screen

symbol (often an arrow, block, or vertical lin
next action will take place. e) that marks where the

Note: The presence of a text cursor (usually a vertical line or

a block) indicates that the computer is
something. ready for you to type

The calculator keypad usually functions as an altern
_ ate method fo
entering numbers and math symbols, producing the same effect a;

typing the number or symbol from the keyboard. [Enter] acts as
[Return].

SWITCHING OFF THE SYSTEM

There are two ways of switching off and restartin

way our s !
Completely switching off the system for any perio?:lyof !imgsltoenrger
than 10 seconds is called a coldstart. This completely resets the

machine and clears all information from R
e Dlotely Cloar At AM. A warmstart does not

Coldstart

You can coldstart your system from the keyboard without switching

the system on and off. Simply press [Cont e L
[Deletel]. [Control] [Alternatel] [Right Shift]

You can also coldstart the system in the following way. Swi

| . Swi
system components in the reverse order that yOL? swi?ched gggr?'nﬁo?]”
Wait at least 10 seconds before switching the computer back on.
This completely resets the computer. '
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Some applications and desk accessories require that you coldstart
after changing certain options.

Warmstart

To warmstart the system from the keyboard without switching the
system on and off, simply press [Control] [Alternate] [Deletel].

You can also warmstart the system by pressing the reset button on
the back panel.

Using the MEGA STE
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Front of Disk

Write-Protect Notch

CHAPTER THREE
BASIC SKILLS TUTORIAL

This chapter presents the information you need to work with the
different basic elements of the desktop. By following the tutorial,
you will learn how to control the onscreen pointer using the mouse
or the keyboard, manipulate icons and windows, make selections
from the menu bar, format and copy a floppy disk.

To follow the copying and formatting sections of the tutorial, you
must have two blank unformatted floppy disks available. You will
use the disks to make working copies of your USA Language disk,
and your Advanced Hard Disk Ultilities disk.

Before you begin the tutorial, you must do the following:

e Start your system and display the desktop as described in the
previous chapter

e Insert your USA Language disk into drive A

Inserting and Removing Floppy Disks

When you insert a floppy disk into a floppy drive, a mechanical
catch inside the drive slides the metal sleeve open, exposing the
sensitive magnetic disk to the drive's read/write head. The disk
stares information in concentric rings called tracks. The read/write
head moves from one track to another as the disk spins.

Metal Sleeve

Back of Disk

Sliding Tab
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Always be sure the floppy drive's busy light is off before you insert
or remove a floppy disk. To practice inserting and removing a
floppy disk, follow these steps:

1. Align one of the blank, unformatted floppy disks with the floppy
drive slot, the metal sleeve against the slot and the write-protect
tab on the left.

@ Warning: Do not slide the metal sleeve open or touch the
magnetic disk. Doing so may damage the disk and the
information on it.

2. Slide the floppy disk into the drive slot until it drops down and
seats within the slot.

3. Remove the floppy disk by firmly pressing the eject button on the
front of the floppy disk drive. The disk ejects part way. Remove
the disk.

DESKTOP ELEMENTS

Icons, windows, and the menu bar are the three important elements
of the desktop. Desktop icons are graphic representations of drives
(logical drives and floppy disks), devices such as printers and
cartridge drives, and the trash can. Window icons represent folders
and files. Files and folders can be displayed as either text or
graphics. A text display is simply the name of the file or folder
appearing on the screen. A graphic display is the same as a
desktop icon; a small picture with the name of the file or folder
underneath. Files and folders displayed as text are also referred to
as icons.

There are two kinds of windows: directory windows and windows
known as dialog boxes. Directory windows display the contents of a
drive (floppy disk or logical drive¥ or folder. Dialog boxes communi-
cate information, receive commands, or both.

The third important element of the desktop is the menu bar. The
basic menu bar displays four menu headings: Desk, File, View, and

Options.
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When you first switch on your system, the deskto displa

- . . ‘ s t
floppy disk icons, four hard disk icons, the trash cgn ic%n,ypo::;?er
and menu bar. It will also display a cartridge icon if a cartridge is '
Inserted into the cartridge slot before you switch on the computer.

USING THE POINTER

The pointer is the key to all desktop operations. You us i
. | : e the pointer
:gpse#ecl lconts cI)rt rJ;nenL{ options, and to move objects on the dpesk-
. You control the pointer either by moving the mouse i
keystroke combinations. ¢ e

Controlling the Pointer with the Mouse

The mouse supplied with the computer controls the pointer. By
moving the mouse, you can position the pointer anywhere on the
desktop. Roll the mouse over a clean, hard, flat surface such as a
tabletop. The computer detects the motion of the mouse (direction
distance, and speed) and moves the pointer accordingly. '

Place the mouse near the computer with the cable pointi

‘ pointing away
from you. Roll the mouse. Notice how the pointer mov
as the mouse moves. P o

@ Note: If you touch the menu bar with the pointer a menu dr
down. Retract the menu by moving the pointer out o Rt
clicking the left mouse button. ? Lo

Controlling the Pointer with Keystrokes

You can use specific key combinations to move the point
. ] er around
the desktop instead of using the mouse. To use keygtroke combina-
}lon_?.trr:old Eown 1helf|rstdkey listed and press the second key
or it three keys are listed, hold down the fi
A ras e first two keys and press

Note: See Appendix B for a quick reference chart listing the
keystrokes for controlling the pointer.
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Your screen is divided into tiny sections known as pixels. When you
use keystroke combinations to move the pointer, the pointer moves
either one pixel at a time or in multiple pixel jumps. Try each key-
stroke combination to move the pointer.

« [Alternate] combined with any arrow key moves the pointer eight
pixels in the direction of the arrow.

- [Alternate] [Shiit] combined with any arrow key moves the pointer
one pixel in the direction of the arrow. Use this combination for

fine positioning.

Selecting a Single Item

Selecting a item (icon or menu option) tells the computer you want
to use the item. When an item is selected it highlights, which means
it displays on the desktop in different colors from your normal
desktop colors.

The first two sections below explain how to select using either

the mouse button or keystroke combinations. In the sections that
follow, it will be assumed that you are using the mouse to move
the cursor or make selections. If you are using keystroke combina-
tions, just substitute the instructions under Selecting with Keystroke
Combinations.

Selecting with the Mouse Button

Clicking is the mouse operation used to select an item or initiate a
procedure. Most actions require you to use the left mouse button.
Only use the right mouse button if specified.

Single clicking selects and highlights only. Double-clicking com-
bines two single-click actions in quick succession to both select and
initiate a procedure.

To click, press and release the mouse button once. To double-click,
quickly press and release the mouse button twice. (Double-clicking
correctly may take some practice.)
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@ Note: To adjust the responsiveness of the mouse buttons to your
clicking speed, see Control Panel in Chapter Six.

Follow these instructions to practice mouse button clicking and
double clicking:

1. Position the pointer over the drive A icon.

2. Click the left mouse button once. The drive A icon highlights.
You have selected the drive A icon. Now move the pointer to an
open area of the desktop and click the mouse button to deselect
the drive A icon.

3. Now to practice double clicking (selecting and opening the drive
A window in one maneuver), again position the pointer over the
drive A icon. Now, double click the mouse button. A window
opens and displays the contents of the disk in drive A.

@ Note: If you forgot to put the disk in the drive, an alert message
appears. Just place the disk in the drive, position the pointer over
the word OK, and click the mouse button. Try step 3 again.

4. To close the open window, position the pointer over the small
box in the upper left hand corner of the window and click the
mouse button. The window closes.

Selecting with Keystroke Combinations

Using the keystroke combination [Alternate] [insert] performs the
same function as clicking the left mouse button. To perform a
keystroke double-click, hold down [Alternate] and quickly press
[insert] twice.

Follow these instructions to practice selecting and initiating a
procedure using keystroke combinations:

1. Position the pointer over the drive A icon.
2. Press [Alternate] [Insert]. The drive A icon highlights. You have
selected the drive A icon. Now move the pointer to an open area

of the desktop and press [Alternate] [Insert] again to deselect the
drive A icon.
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3. Now to practice keystroke double clicking (selecting and opening
the drive A window in one maneuver), again position the pointer
over the drive A icon. Now, hold down [Alternate] and quickly
press [Insert] twice. A window opens and displays the contents of
the disk in drive A.

0 Note: If you forgot to put the disk in the drive, an alert message
appears. Just place the disk in the drive, position the pointer over
the word OK, and click the mouse button. Try step 3 again.

4. To close the open window, position the pointer over the small
box in the upper left hand corner of the window and press
[Alternate] [insert]l. The window closes.

Selecting an Icon

There are two types of icons: desktop icons (floppy and hard disk
drive icons, printer and cartridge icons, and the trash can icon), and
window icons (folder and file icons). Remember, files and folders
can be displayed as either text or graphics.

You selected an icon when you practiced clicking on the drive A
icon. An icon that has been selected appears highlighted.

Selecting a Menu Heading

Each menu heading on the menu bar has its own drop-down menu.
If you move the pointer onto the menu bar near one of the head-
ings that menu immediately drops down and displays its command
options. Moving the pointer away from the dropped menu to
another menu heading causes the new menu to drop down, and
the previously displayed menu to retract.

Follow these steps to practice displaying and choosing menu
options:

1. Position the pointer near the Options menu heading. The menu
drops down.
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Note: A drop-down menu may have both active and inacti

0 command options. Active options are in bold text and prggfjge an
action when selected. Inactive options appear as lightened text
Selecting an inactive option causes the menu to retract. Optioné
with a check mark to the left of them are currently selected.

2. Position the pointer over the Save Deskto -
The command highlights. p command option.

3. Click the mouse button. A dialog box appears. asking i
really want to save the desktop. i - 3Kt you
o Note: The box in bold type surrounding the word OK denotes

the default selection. You can always choose a de :
by pressing [Returnl. fault selection

Select Cancel by positioning the pointer over the word C i
_ ItI0 ancel
the dialog box and clicking once. The dialog box cjisapps,'arse g

To retract a menu without selecting a command opti j
g ' ption, just move
the pointer outside the menu and click the left mouse bultton.

Dragging

Holding down the mouse button and moving the poi i
. pointer is called
dragging. You can also use a key combination to perform dragging.

Dragging moves icons from one place to another. After you select
an icon, you can drag the selected icon to a new location. You can
perform dlife(ent pperat_ions by dragging, depending on the icon
type and the icon’s destination. You also use dragging to create a

Irubbe;-band box to select multiple icons. (See Selecting Multiple
cons.

Dragging with the Mouse

Using the mouse to drag is easy. Just move the mouse while h

. ) old-
ing down the mouse button. Any selected icon or group of icons will
be draggeed1 The pointer must be positioned over the selected icon
or group of icons for successful dragging.
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Dragging with Key Combinations

To drag with keystroke combinations, press [Alternate] [insert]
combined with any arrow key to drag a selected icon or group of
icons in the direction of the arrow. The pointer must be positioned
over the selected icon or group of icons for successful dragging.

Dragging an Icon

You need to drag to perform copy, move, or delete operations.
After you drag an icon or icons to a new destination and release the
mouse button, the icon or icons will be copied, moved, or deleted,
depending on the operation performed.

When you drag icons from one location to another, a ghost outline
of all selected icons follows the cursor from the original location to
the destination. The pointer shape also changes from a pointer to
an outline of a hand until you release the mouse button.

You will use the move operation to practice dragging. The copy and
delete operations will be explained in later sections of the tutorial.

Now practice dragging using one of the described methods. Move
the desktop icons into different configurations. If you accidently
drag one icon on top of another icon, a special window called a
dialog box will display. Select Cancel. The window disappears, and
the moved icon will return to the position it occupied before you
moved it.

0 Note: You can also drag more than one icon at once. See

Selecting Multiple Icons.

Selecting Multiple lcons

Sometimes you will want to select more than one icon at a time to
perform delete, copy, move, or other operations. There are two
ways to select multiple icons.

The first way is using the rubber band box to select icons that are
grouped together on the desktop or in a window. You use the
pointer to create a box on screen to surround the icons you wish
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selected. The box is called a rubber-band b i
or contracts when you drag the pointer. Gy Sl Sl

You can use shift-clicking to select multiple i indivi

. | ( iple icons ind

instead of having to select items that are physicallg? glfciggglcliy
together. The selected icons do not have to be in seguence on
list, or near each other on the desktop. .

Both methods of selecting multiple i
windol oo, g multiple icons can be used on desktop or

SELECTING WITH THE RUBBER-BAND BOX

Whenever you drag the pointer, a rubb
. : er-band box appe
screen. The first corner of the rubber-band box is cregﬁeda\r;\?h%r:etc:r

the pointer is positioned on the screen. Th i
direction of pointer movement. . The box expands in the

Follow these steps to practice - el L )
rubber band box: . selecting muitiple icons with the

1. Position the pointer above and to the left of the drive A icon. Try

not to touch the nearby menu headin
just retract the menu and try again g. If the menu drops down,

2. Now drag the pointer down and to the righ
t. Th -
box appears and expands with the point%r, FUEREr o

3. Surround the drive A and B icons with th
Release the pointer. The icons high!ighte rubber band box.

4. Move the pointer to a clear area of th i
e desk
mouse button to deselect the icons. R o el

SELECTING BY SHIFT-CLICKING

Shift-clicking lets you select muiltiple i
) ple items that are
other on the desktop, or in sequence in a window. s © S
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To practice selecting by shift-clicking, follow these steps to select
the drive A and C icons:

1. First, select the drive A icon.

2. Now hold down [shift] and position the pointer over the drive C
icon. Click the mouse button. Both the drive A and drive C icons
are now highlighted. The drive B icon in the middle remains
unselected.

0 Note: You must hold down [shift] until all desired icons are
selected. Once you release [Shift], no further icons can be added
to the selected group. If you attempt to select an icon after you
release [Shift], all previously selected icons will be deselected.

3. Move the pointer to a clear area of the desktop and click the
mouse button to deselect the icons.

SELECTING BY COMBINING RUBBER-BANDING
AND SHIFT-CLICKING

You can combine rubber-banding and shift-clickjng to select a
group of icons, then deselect any icons you don’t want in the group.

Follow these steps to practice combining the two methods of
selecting multiple icons:

1. First, use rubber-banding to select all three drive icons.

2. Now use shift-clicking to deselect the drive A icon. Only the drive
B and C icons are highlighted.

3. Now use shift-clicking to reselect the drive B icon. All three icons
are again highlighted.

4. Move the pointer to a clear area of the desktop and click the
mouse button to deselect the icons.

For additional practice, try selecting and dragging more than one
icon at once.
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USING WINDOWS

Most of the desktop activity takes place in windows. Windows are
small screens within the larger screen display. You can have up to
seven windows displayed at one time. When a window is displayed
on the screen it is open.

Opening and Closing a Window

You can only open directory windows. Dialog boxes simply appear
during certain operations or to give you information. Directory
windows can be opened in several ways by using the pointer and
mouse button. The first window you will open is the drive A direc-
tory window. Make sure the USA Language disk is in drive A before
you begin.

One way to open a window is to double click on the desired desktop
icon. Open the drive A window now by moving the pointer over the
drive A icon and double clicking. The contents of the drive appears
in the drive A directory window.

Note: If the drive A icon highlights but the window does not open,
it means that the MEGA STE has not recognized your click as a
double click, but only as a single click. Move the pointer to a clear
area of the desktop and click once to deselect the icon. Try again,
and remember that double clicking can be a bit tricky at first. Just
keep practicing.

Now you need to close the drive A directory window. In the upper
left corner of the window is a small box confaining an X icon. This is
the close box. Move the pointer over the close box and click once.
The window closes. 4

Another method of opening a window uses the menu bar. Open the
drive A window again by selecting the drive A icon. The icon high-
lights, but does not open. Now select the Open command from the
File menu. The drive A directory window opens.

Now close the window by selecting the Close Top Window
command from the File menu.

There are other ways to open windows and programs that will be
discussed in other sections of the manual.
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Window Elements

You have already learned about the close box in the upper left
hand corner of most windows. The following example displays all
window elements. Some are explained here, and others will be
explained as you use them in the tutorial.

Drve Identifier
Close Box File Mask Move Bar Full Box

X AR X
Bytes Used ~119770 bytes used in 4 items. Infarmation Line
@
T2 K i
=7}
CONTROL.ACC  DESKTOP . INF ._o.:at.w.a LOGO RS
W T ' 3. Scroll Bars
o[ A B
Scroll Arrow Scroll Box Size Box

The Drive |dentifier appears in the center of a window's move bar. It
shows the drive letter of the open drive, in this case floppy drive A.

The File Mask tells you what type of files are displayed in the
window. You can set the File Mask to display all the files in a
directory, or you can set up restrictions on the types of files
displayed. The window displays an icon for each folder in the
directory, and for every file in the directory that matches lhe‘flle
mask setting. For more detailed information on setting the File
Mask, see Set File Mask in Chapter Four.

The Information Line displays the Bytes Used (total number of bytes
of disk space used by the contents of the directpry). and Items (the
number of files and folders residing within the directory).

The other elements of a window are explained in the following
tutorial sections.
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The Active Window

When you have more than one window open at a time, you can
only work with the files and folders in the active window. In addition,
you can move, scroll, update, or resize only the active window. You
can identify which window is active by looking at the move bar. Only
the active window’s move bar is shaded.

You can open up to seven windows on the desktop. You can make
any window the active window by positioning the pointer anywhere
on the window and clicking the left mouse button.

Open windows may overlap. If they do, the active window is always
completely displayed. Activate a partly hidden, inactive window by
positioning the pointer anywhere on the window and clicking the left
mouse button. The active window moves to the front and displays
over the other windows.

Sizing a Window

Sizing windows is especially useful when you want to display more
than one window on the desktop at one time. To practice sizing a
window, follow these steps:

1. Open the drive A directory window.

2. Locate the size box in the lower right corner of the window.
Paosition the pointer over the size box and use dragging to move
the size box up and to the left. An outline of the window follows
the pointer movement. Release the mouse button when the
window outline is about half of the original window size.

3. Now locate and select the full box in the upper right corner of the
screen. Selecting the full box expands a window to fill the entire
screen.

4. Select the full box again. The window returns to the most recent
size and position.

5. Continue to practice sizing the window. Drag the size box down
towards the bottom of the screen to lengthen the window, up to
shorten the window, right to widen it, or left to narrow it. When
you have finished practicing, close the window.
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Moving a Window

i to any screen position
can use the move bar to move a window to r ) :
ggltcl:w the menu bar. Follow these steps to practice moving a window:

1. Open the drive A directory window.

lick on the SAMPLE.PRG icon. The Sample window
a Ic:i)ig;g?s? Eesize the window to about one half its original size.

iti i ; dragging to
sition the pointer over the shaded move bar. Use
i Eﬂ%ve the wir?dow to a new position on the screen, then release
the mouse button. The window displays in its new position.

i das
that when you dragged the window the cursor appeare d
E?\t:nd icon, ang an outline of the window followed the move
ment of the hand cursor until you released the mouse button.

4. Close the Sample window. Close the drive A directory window.

Scrolling a Window

i i directory will contain too many items to display
5310? ﬁmﬁ Zts ?r?tlaetime. Whyen. this occurs, some of the d_lcrigctory
items remain undisplayed, or hidden. You can view the El k en .
items by using the scroll bars. The scroll bars along the bo tg!rln
right edges of the window let you scroll the window horizontally
(right and left) or vertically (up and down).

irectory contains more items than will fit in the window, a
goit(ijcln;eof tge scroll bar will be shaded. The scroll box shov\.;? ttt:lere "
current position of the window relative to its total directory. eI_
gray above or below the scroll box, more of the directory is avai
able by scrolling the window in the direction of the gray area.

i ! try, one
here are three ways to scroll a window: entry by en ;
Lindow display at a time, or continuous scrolling. To practice

scrolling, follow these steps:

1. Open the drive A directory window.

2. Decrease the window's size until only two directory items are
displayed, one on top of the ather.
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3. To scroll by one directory entry at a time, position the cursor over
the scroll arrow that indicates the direction of the hidden contents.

Click once. Now click once on the opposite arrow to return to the
original window display.

4. To scroll by one window display at a time, position the cursor
over the shaded area of the scroll bar. Click once. The pre-
viously displayed items are now hidden, and the screen displays
previously hidden items.

Another way to accomplish this is by using the up and down
arrow keys to the right of the main keyboard. Each time you
press an arrow key the previously displayed items are hidden,
and the screen displays previously hidden items.

5. To scroll entries continuously, position the cursor over the scroll
arrow that indicates hidden items. Hold down the left mouse
button.

6. To scroll entries continuously one window at a time, position the
cursor over shaded area of the scroll bar. Hold down the left
mouse button.

You can also skip over some of a directory’s contents by
dragging the scroll box to a new position in the scroll bar.
The window will now display the contents of that portion of
the directory.

7. When you have finished practicing scrolling, close the drive A
directory window.

Note: Directory windows displayed as text instead of icons cannot

be scrolled horizontally. (See Show as Icons and Show as Text in
Chapter Four.)

USING FLOPPY DISKS

Floppy disks serve as permanent storage for programs and the
information you create. MEGA STE computers use 3V2-inch disks
that consist of a 3V2-inch rectangular plastic casing holding a
circular sheet (disk) of oxide-coated material. This material is the
magnetic media which holds data and which the disk drive reads.
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Its accessible section is protected by a sliding metal sleeve. Most
floppy disks also have a write-protect sliding tab. (See write-
Protecting a Floppy Disk in this chapter.)

Floppy disks can be either single-sided or double-sided. Both types
of disks look the same. On a single-sided disk, only one side of the
magnetic disk is certified by the manufacturer as safe for storing
information. Both sides of a double-sided disk are certified. A
single-sided disk can store up to 357,376 bytes of information; a
double-sided disk can store up to 726,016 bytes of information.

Formatting a Floppy Disk

You must format a new floppy disk before you can store programs
and data on the disk. Formatting prepares a floppy disk by com-
pletely erasing the disk’s contents, checking for damage to the
magnetic media, and setting patterns in place to hold information.
Floppy disks formatted by your computer are format compatible
with MS-DOS computers. This means information written to a
floppy disk formatted on your computer can be read by MS-DOS
computers and vice versa.

Single-sided floppy disks must be formatted as single-sided. Floppy
disks formatted as single-sided can be used in both single and
double-sided floppy disk drives. However, you can format floppy
disks certified for double-sided use as either double or single-sided.
Floppy disks formatted as double-sided can be used only in a
double-sided drive.

You can also reformat previously used floppy disks. Since format-
ting erases all information on a disk, it is sometimes more efficient
to reformat a floppy disk than to delete all of a floppy disk's files.

@ Warning: Formatting a floppy disk permanently erases all informa-
tion on the disk. Before you format any floppy disk, be sure to copy
any data you want to save. (See Copying Files and Folders in this
chapter.)

To format a disk, follow these steps:

1. With the computer switched on and the desktop displayed, insert
a blank, unformatted floppy disk into drive A.
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Note: If you have two floppy disk drives on your system, you can
format a disk in either drive A or drive B.

. Select the Format Floppy Disk command from the File menu.

The Copy/Format dialog box displays.

Note: Both Copy and Format operations are combined in one
dialog box so you can format, and then copy disks without
returning to the desktop after formatting. If you select the Format
option and decide to copy a disk instead, click on COPY. You
can also click on FORMAT after initiating a disk copy operation if
you must format a disk first.

. If you wish the disk to have a label, type in the label. Then select

the disk drive on which you want to format a disk. The default is
the disk drive you selected in step 2. Select SINGLE or DOUBLE
sided, depending on how you want to format the disk.

. Select OK.

The disk drive begins formatting the disk. The indicator bar
displays formatting progress.

Note: You must have a double-sided disk in a double-sided
drive to use the double-sided format option. (The built-in drive is
double sided.) Once you format a floppy disk as double-sided,
you can only use it in a double-sided drive. You may format a
double-sided floppy disk as single-sided, but only one side of the
disk will be used.

. When formatting is completed, an alert message appears telling

you that a double-sided disk has 726,016 (or 357,376 for a
single-sided format) bytes available.

Select OK.

Warning: If the computer does not report that the formatted disk

can hold 726,016 bytes of information for a double-sided disk or
357,376 bytes of information for a single-sided disk, the disk may
be defective. Try formatting the disk again. If the problem
persists, discard the bad disk and use another disk.

. To return to the desktop select Cancel.

Basic Skills Tutorial
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Note: If you try to use a disk without first formatting it, or if you try
to use a double-sided disk in a single-sided drive, the computer
displays an alert dialog box. The dialog box tells you that the disk
drive is not responding, and to please check the disk drive, or insert
a correctly formatted disk into the drive. Then you must select Retry
or Cancel (to tell the drive not to attempt to read that disk.)

Repeat the formatting process with the other blank, unformatted
floppy disk.

Copying a Floppy Disk

It is essential to make a backup copy of all important disks. This
protects you against loss of important files. Since it is especially
important to make a backup copy of the USA Language disk and
Advanced Hard Disk Utilities disk supplied with your computer, you
are going to make copies of the two disks now. After you make the
copies, store the original disks and use the backup copies as your
working disks.

You will copy the original disks supplied with your computer onto
the two floppy disks you just formatted. The original disk is known
as the Source disk, since it is the source of the information. The
disk you are copying to is the destination disk. A destination disk
need not be blank, but all data on it will be overwritten (erased)
during copying. You cannot copy a double-sided disk to a single-
sided disk, or vice-versa.

For systems with only one floppy disk drive, the internal floppy drive
is both drive A and drive B. This enables you to use a single floppy
disk drive to copy and move files between disks. During disk copy-
ing operations, the source disk is disk A and the destination disk is
disk B, or vice versa. Dialog boxes appear during the copy opera-
tion to tell you when to remove one floppy disk and insert the other
floppy disk. For systems with two floppy drives, the internal floppy
disk drive is drive A and the second, external floppy disk drive is
drive B, so you don't have to swap floppy disks when copying files
from one disk to another.

To copy an entire disk, follow these steps:

1. With the computer switched on and the desktop displayed. inser
the source disk (USA Language disk) into drivepA. I?ygu have t
two disk drives, insert the source disk into drive A (the internal
floppy drive) and the destination disk (formatted floppy disk) into
drive B (the external floppy drive).

0 Note: If you have one double-sided disk drive and one single-

sided disk drive, you cannot copy an entire disk using the disk
copy operation. You must transfer the files and folders from the
source drive to the destination drive. For detailed instructions
see Copying Files and Folders in this chapter.

2. Drag the drive A icon onto the drive B icon. When the floppy disk
icon for drive B highlights, release the mouse button.

3. An alert dialog box appears, warning you that copying the disk in
_dn;ej A tEL’? the disk in drive B will erase all information on the disk
in drive B.

If you have two floppy disk drives, make sure the source and
destlnau_on disks are in the correct floppy disk drives before
proceeding. Then select the OK button. The Copy/Format dialog
box appears.

4. Select OK to begin copying the source disk. The copy indicator
bar shows the progress of the copying process.

0 Note: If you have one disk drive, the computer prompts you

(with alert dialog ques) to switch disks from time to time as it
copies and then writes sections of information.

5. When copying is completed, select Cancel (or press [Return]) to
return to the desktop.

Now repeat the procedure, making a backup copy of the Advanced
Hard Disk Ulilities disk onto another formatted floppy disk. Store the
original disks in a safe place, and use the copies for all future
operations.
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Write-Protecting a Floppy Disk

o

Write-protecting a floppy disk prevents information from being
written to the disk. To write to a disk means to store information on
the magnetic media. (Similarly, to read a disk means to retrieve
information recorded on the disk.) The floppy disk drive and
computer work together to write information from the computer’s
memory onto the floppy disk, or to read information from the floppy
disk into the computer’s memory.

Most floppy disks have a small write-protect tab in their plastic
casing. Write-protect the working copy of the Advanced Hard Disk
Utilities disk now by sliding the tab until the notch is completely
exposed.

Note: Write protect 5% inch floppy disks by covering the write-
protect notch with special tape supplied with the floppy disk.

You cannot write to, format, or erase a write-protected disk. It is a
good idea to write-protect disks containing important information so
you do not inadvertently erase information from the disk, especially
when copying disks with a one-drive system. You can move the
write-protect tab back to the unprotected position at any time.

Note: Some commercial program disks may not have write-protect
tabs. These disks are permanently write-protected.

COPYING AND DELETING
FILES AND FOLDERS

You have already learned how to copy an entire floppy disk. But
most of the time you will want to copy selected files and folders

from one drive to another, or delete files or folders from a drive.

This section will explain how.
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Copying

You will be copying files and folders from one disk to another. The

same file copy procedure below ajso appli i
practice copying files and folders, fonoﬁﬁ&i‘ig’sfggﬁng ioldess. To

1. Display the drive C directory Window.

2. Drag the SAMPLE.PRG file icon

Files dialog box displays. Selaa onKto the drive D icon. The Copy

The SAMPLE.PRG file will be copijed onto lo

directory of drive D to make sure the file rea gical diive D. Display o

ched its destination.

Deleting

There are two ways to delete a file or fold

er. Y i
to be deleted onto the trash can icon, or select t?}l‘tla ?11%%3 %éhc? |ltetmd
and select Delete Item from the File menu. i

To practice deleting a file, follow these steps:
1. Display the directory for drive D_

2. Drag the SAMPLEFH_G icon o
the mouse button. A dialog box appears, asking if you really

want to delete the file. Since we are just practicing and we do not

want to delete the file yet, selec i
havs bt T t CANCEL. Selecting OK would

Nto the trash can icon. Release

3. Now you are going to practice the other method of deleting files.

Re t i i
higﬁﬁghtsstép 1. Now select the SAMPLE.PRG icon. The icon

4. Select Delete Item from the File menu i
ect | A
asking if you really want to delete the me.%?aﬂggtb(gﬁ.a\;p\fpheear{sthe

delete operation is complete, the SAMP [ ‘
from the directory. Close the drive D dirégbfﬁﬁj;%oorlvdlsappears
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Note: Only if the Confirm Deletes option (see set Preferences in
Chapter Four) is active will the dialog box appear to confirm the
delete action.

i tire contents
You can use the same delete operation to delete the en
of a disk. If you just want to remove an icon from the desktop, see
Remove Desktop Icon in Chapter Four.
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CHAPTER FOUR
ADVANCED DESKTOP

This chapter continues where the tutorial left off and explains
advanced desktop functions such as: updating a directory display,

entering information when a dialog box displays, and advanced
menu bar commands.

UPDATING A DIRECTORY DISPLAY

Being able to update a displayed directory is useful when you are
working with floppy disks. If you insert a disk into drive A and
display that disk's directory, and then remove that disk and insert a
new disk into drive A, the window does not automatically display the
new disk’s directory. You can update the directory displayed in the
window by pressing [Esc]. Your computer will read the directory of

the disk that is currently in the drive, and display that directory in
the window.

Displayed directories update automatically after you copy, move. or
delete a file or folder, or copy or format a disk_

DIALOG BOXES AND ALERT BOXES

Your MEGA STE computer can communicate with you through
dialog boxes which request information, and alert boxes which warn
you about an action. Some dialog boxes ask you to supply informa-
tion or make a choice. Use the keyboard or mouse to make a choice
or supply the information needed. An I-bar text insertion cursor indi-
cates where the next typed character will appear on a text field.

Some dialog boxes contain more than one field requesting informa-

tion. To select a field, position the pointer over that field. Click once.
The cursor jumps to that field.
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The following keys provide additional functions:

- [Left Arrow] —- Moves the cursor one character to the left within a
field.

- [Right Arrow] — Moves the cursor one character to the right within
the field.

- [Down Arrow] — Moves the cursor to the next field.
« [Up Arrow] — Moves the cursor to the previous field.
« [Tab] - Moves the cursor to the next field (same as [Down Arrow]).

« [Backspace] — Deletes the character or space to the left of the
cursor.

- [Delete] — Deletes the character or space to the right of the
cursor.

= [Esc] — Clears the current field.

- [Return] - Selects the default dialog button, if one is present. A
%onut'::)rder around the button indicates the default button.

ome fields contain punctuation marks such as periods (.) or back
?Iashes (\) to divide tpext. To advance past a punctuation mark, type
that mark. For example, you may see a field wnt? a period dividing
the field, such as the period that separates a file's name from the
extension. Type a period to advance to the second part of the field.

i i ialog box
When the computer needs to communicate with you, a dia
appears in the FtJ:enter of the desktop. To respond to a dialog box,
type in the requested answer or perform the requested action. Then
select one of the dialog buttons. If a dialog button has an enlarged
border, it is the default button and can be selected by pressing
[Return].

i i tion.
The computer uses alert boxes to bring something to your atten
Alert boxgs contain stop signs, question marks, or exclamation
points, and may either caution you about an intended action or tell
you that something went wrong.

When you see an alert box, follow its instructions, then select the
appropriate dialog button.
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THE MENU BAR

The top edge of the desktop contains the menu bar. The menu head-
ings are Desk, File, View, and Options. To see the commands within
any menu heading, position the pointer over the menu heading. The
heading highlights and the menu displays under the selected heading.

When the menu displays you can select an option. Options in black
text are active and available for use. Options in light text are
inactive. Inactive options are not available for use at the time you

display the menu. (See the specific option later in this chapter for
more information.)

Most of the commands listed under the menu headings can be
selected by using a single keystroke. Each command's keystroke is
listed in brackets to the right of the command name. To initiate the
command, just press the key indicated. It saves a lot of time if you
memorize the keystrokes for the commands you use frequently.
You can change the assigned keystroke of a command, or assign
a keystroke to a command that does not have one. (See Desktop
Configuration in this chapter.)

Desk Menu

The Desk menu is divided into two sections. The top section usually
contains a single entry which, when selected, displays information
about the application you are working with. This information can be
a complex series of windows explaining in detail how the application
works, or it could be a single dialog box display of copyright

information.

The lower section lists your active desk accessories. To be active, a
desk accessory file must have the extension .ACC and must be on
the root directory of drive C (or on a floppy startup disk in drive A)
when you switch on the computer.

You can open desk accessories from the desktop or from any
application that displays the menu bar. The desk accessaory
included on your USA Language

(XCONTROL.ACC). For detailed information on the Control Panel,
see Chapter Six.

Disk is the Control Panel
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Switching on the computer without active desk accessories frees
some RAM and displays the desktop faster.

Desktop Info

i the top section
display the Desk menu from the desktop,
g?ﬁg r);ﬁel#]u Iigts ){he Desktop Info option. If you select Desktop Info,
a window listing GEM and TOS copyright data displays.

File Menu

i i i i losing directory
enu contains options for opening and ¢ :
vTvli-]nedEUves rr;elec:ling all displayed fllesc?nd ffoldertst_for gir;kospe;rr?élon.
ting a file or folder, creating a folder, formatting s,
rc'jnec!l?e. %his section explains in detail each File menu option.

Open

The Open command can be performed on a disk or cartridge icon,
folder, or file, printer icon, or trash can icon.

i i t Open from the
i t the item you wish to open. Then selec i
E;Irgtrﬁgfﬁ. The resul% of the command depends upon which of the

following was highlighted:

Disk icon or folder- the disk or folder directory window
appears.

Cartridge icon (drive c) or executable file- The desktop
disappears and the program runs.

Printer icon- An alert box displays informing you that the icon
you attempted to open is a printing device.

Trash icon- An alert box displays.

i icati is linked to the
ile- If you have installed an application that is h
Eaith ti::tla?:urnint type as the data file y:jo;.lharg ctap?i?én% rt‘r;esagﬁh
ion will automatically open and load the data file.
g;gﬂgation is installed, a dialog box displays, giving you the
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choices show, print, or cancel. Show displays the contents of the
file on the screen as ASCJ| characters. Print prints the contents

of the file (only if you have a printer connected to your systeml),
and Cancel cancels the command.

Note: An alternative to using the Open menu command is to

position the pointer over the icon you wish to open and double-click
the left mouse button.

Show Information

When you highlight a floppy disk, logical drive, folder, or file icon
and select the Show Info option, the screen displays information
about the highlighted item.

When you select Show Info for a floppy disk or logical drive icon,
the Disk Information dialog box displays the following information:

Drive ID- The drive’s letter identifier.

Disk Label- The name you assigned to the drive. (This field can
be blank.)

Number of Folders- The total number of folders on the disk of
logical drive, including folders within folders.

Number of Files- The total number of files on the disk or logical
drive, including files within folders.

Bytes Used- The number of bytes used by all files and folders
on the disk or logical drive.

Bytes Available- The available storage space (measured in
bytes) left on the disk.

o Note: In the Disk Information dialog box, the number of bytes used

plus the number of bytes available for a floppy disk or logical drive
does not always equal the exact total storage capacity. This is
because the computer allocates space for each file in fixed-size
blocks, even if the file does not completely fill the last block. The
Bytes Available information is an accurate indicator of available
unused storage space.
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n you select Show Info for a file or folder, the File Information
ZYarllgg }I::ox or Folder Information dialog box displays the following
information:

Path- The top line lists the complete path of the file or folder. If
thi pathis tog long to display on the line, you can use the scroll
arrows to reveal the hidden part of the pathname.

e- The name of the folder or file. The text insertion cursor
?;pn;ars to the right of the name. To change the name of a file or
folder, press [Esc] to clear the name line. Type in the new name,
using eight characters or less. Type a period, then the three
character file extension (usually not used in folder names).

Size- Size, in bytes of the file or folder. Folder size is the total
number of bytes used by all the files within the folder.

Date- The date the file or folder was last modified.
Time- The time the file or folder was last modified.

Number of Folders- The number of folders within the folder.
This only applies to folders.

Number of Files- The total number of files within the folder,
including files within other folders. This only applies to folders.

ibute- The two choices are Read Only and Read/Write. I
?c:ltJ“\:f):{:l to make sure a file remains intact and no changes are
made to it, select Read Only. You will still be able to display and
copy the file, but you cannot modify or delete it. Read/Write
allows you to read the file, change it, or delete it. The Attribute

field does not apply to folders.

Search

earch command performs a file search on a floppy disk,
;E:g?cgl drive, or folder. When you select Search, the Search File
dialog box appears. You must set the parameters of the search by
typing in the name of the file for which you are searching. You can
also type in part of a filename, and Search will match the typed
characters. For example, if you wish to search for all files with the
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extension .DOC, type a period, then type DOC. Search opens the
window containing the first .DOC file it finds and asks you if it
should continue the search. If you select OK, Search will use the
same window to show the next .DOC file. and so on. When Search
can find no more .DOC files, an alert box displays to let you know
that no more files are to be found.

Before selecting Search, you should highlight the floppy disk,
logical drive, or folder upon which you wish the search performed. If
no item is highlighted, Search will perform the command upon the
active window. If there is no open window on the desktop and no
highlighted item, you cannot select Search from the menu.

0 Note: The Search dialog box may cover highlighted icons.

Delete

The Delete command deletes all highlighted files and folders. If you
highlight a floppy disk or logical drive icon and then select Delete,

all files and folders on the highlighted item will be deleted. The icon
remains on the desktop.

Create Folder

o

The Create Folder command creates a new folder in the active
window. When you select this command, the New Folder dialog box
appears. Type in a name for the folder, then select OK (or press

[Return]). The name of the new folder appears in the directory
window.

Note: Certain characters cannot be used within a folder name or

extension. For a list of illegal characters, see Files and Filenames in
Chapter Five.

Close Directory

The Close Directory command closes the top level of the active
window. For example, let's say the top window is a folder window,
and that folder resides in the main directory of drive C. When you
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i 's window closes, and the main | the Set File Mask dialog box appears. You must fill i ‘
selscEClase tiirac ory. theloldor s ' parameters, both file name and file extenséonUSI Wieiisups

directory window displays.

For example, if you want only those files beginning with the letters

ote: You can also close a directory by selecting the close box in ) ; '
0 me window'’s upper left corner. ?ESK to appear in the directory list, you would press escape to
clear the Name line. Then you would type DESK*.* and select OK
| Il?aeraiilé?é astertlrs]k ?lfter the \fvord DESK means that any file with
‘ | _ rS In the filename following the letters DESK
Close Top Window | displayed. The asterisk is known as a wild card charagtr;?fil(%gs File
The Close Top Window command completely closes the active ?_'%e;;:licalnon IN Chapter Five) The period is the separation between
window, including all levels of folder windows and the main file “rfj;-‘rrr'lanfj;e and the file extension. The second asterisk means any
directory window. If windows from other floppy disks or logical no matt iy ﬁn?me e et aclas shouid ke end
drives are open on the desktop, the most recently opened window describ eél\: e fie e S the fle mask as
cives are open on the desk scribed here would display files with different filenames and
| extensions, such as NEWDESK |NF and DESKACC.DOC, as lon
as the filename begins with the characters DESK. ] 1
Bottom to Top Ll ! . | |
| | e default file mask parameter is an asterisk for the f
o o Tob earrii SRR DeS MEINEIST an asterisk for the extension. This means all files a?g c;:sgf:r;:d?nd
overlapping windows displayed on the desktop. When you select LT3 :
R b iy th the top Note: Folders are not affected by Set File Mask_
of the stack and displays it as the active window. The current active T
window is sent to the bottom of the stack. he parameters selectedb for the open window remain in effect as
long as the window remains open. Once you close the window, the

parameters you chose are cleared.

Select All ltems

The Select All Items command highlights all files and folders in the Format Floppy Disk

tive window. The files and folders that are hidden, but would be : |
gﬁol:ven by scrolling, are also selected. However, files that are in the Fprmattlng prepares floppy disks to accept dats, You can format
directory but do not match the file mask parameters are not disks as either single or double-sided, Used disks can be reformatted
elected. (See Set File Mask.) ; . y
s : All disks formatted with TOS can be read by IBM PCs and compat-
0 Note: If the File Mask is ** (show all items), then all items, Ible computers using MS-DOS version 3.2 o later.
including all folders, are selected. If the File Mask is set to show ¥y
a selected filename or file extension or both, folders will not be To format a floppy disk, insert the disk into a floppy disk drive.
selected. Egr'fglteﬂgﬁg'f’ppy Flsk loon, then select the Format command. For
_ ormation on formatting disks i '
Disk in Chapter Three. 9 CISKS. see Formatting a Floppy
Set File Mask

The Set File Mask command allows you to choose the file type to
be displayed in the active window. When you select this command,
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: Wlinen directory enltries are shown as icons, different icons indicate
: different types of files or folders. The window displays icons in
View Menu T y— horizontal rows across the desktop. You can choose the shape of
The View menu lets you choo

desktop and window icons. See Install Icon in this chapter.
files and folders.

Iphabetically by name (filename or extension), or Kiiréir;‘lr% jf(izlgnSiget.hznlgéh; gafﬁi gglfdn grirr]% il{l;ael éiéeav\frglsdlearst_rnggdified.
those filenames alphabetica - display, select the . A : ‘ -
numerically by date cnrt 'I;!l.ecsl,-léik-ll-'l% ;T;?gl;}’c:gﬁon ig diga ey window displays files and folders as vertical text
menu option YOwaa“ : 0 Note: A triangle symbol appearing next to a file name indicates a
option is selected. : _ read-only file.

i lected from the View menu affect all directory wmtdo“{isdn
e S?)t select one option for one window and a different op Files and folders displayed as text may be opened, copied, and
fYocr)l; ﬁg:‘lhl'ler g deleted using the same procedure used with icons.
’ desktop, TOS saves all the View menu _
o 2‘%@5&'}3#2553 ?h):aoglrEWDES?(INF file on your startup disk. Sort by Name/Date/Size/Type

(See save Desktop in this chapter.)

It is sometimes necessary for you to have a list of your files and
folders presented in a certain order. Folders as a group are always

e e layed both as icons and as ngggias;bﬁrllﬁgzigg ;gfge(rgﬁgﬁﬁfe\ggﬁom;ga;syci;r:t SRUH, o
' ; i ies displaye
. The same directory, with entries g oo , _
|l text, is shown below: Sort by Name- Lists files and folders in alphabetical order

* Sort by Date- Displays files and folders chronologically. The

| 119778 butes used in 4 items. - most recently created or revised file or folder appears first
| E — * Sort by Size- Lists files and folders according to their size in
| o a.:c DESQINF LOGO .FRG Losc bytes

* Sort by Type- Lists files alphabetically according to their exten-

sion type. Files with common extensions are grouped together in
, alphabetical order by filename

‘ ¢l | * No Sort- Lists files and folders according to the order in which

a program would recognize them
9778 bytes used in 4 items. : ; _ :

‘ S TLoTRoL et 15616 11-20-85 12:63 an |0 Size to Fit

DESKTOP INF 478 11-20-85 :BK i When you select Size To Fit, all icons are displayed in horizontal

LOGO PRG 987786 11-28-85 12: a rows starting at the top of the window. Each row is only as wide as
| L0GO RSC 4986 11-20-85 12:84 an B the window and will automatically resize whenever the window is
‘ B resized.

01 |
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Set Color and Style

d style allows you to create a unique desktop
gr?:i(r:grlnc;:::r?t. Ygu can use Set Color and Style to chcu::_s:-zi a color
and fill pattern for both your desktop and for ops.jned windows.
When you select Set Color and Style, the following dialog box

appears:

SET COLOR AND STYLE

Set DeskiopMWindow ~—Set: m
: Color:
Fill Patterns g Cotor Paiatie

Preview Window

is highli is allows you to
ample the Desktop box is hlghllghtec!. This al
mc;zgye;ourpdesktop display. To modify the window display, the
Window box must first be highlighted.

To create your desktop environment, follow these steps:

1. Highlight the Desktop box.

2. Position the pointer over the solid black Style square and click
once.

iti i ired color
t a color, position your pointer over the desired
= gr? tsheelec?olor palettg and click once. The color displays in thﬁ-
Preview Box. (If you are using a monochrome monitor, position
your pointer anywhere on the black section of the color palette

and click once.)
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4. To select a fill pattern, position your pointer over the desired fill
pattern and click once. The fill pattern displays over the color in
the Preview Box.

5. Next highlight the Window box and repeat steps 2 through 4 to
modify your window display.

6. Select OK to select the chosen options and exit Set Color and
Style.

Options Menu

g

The Options menu includes commands that allow you to save your
desktop configuration, install icons, applications, and devices, and
print what is displayed on your screen. You can use the Set Prefer-
ences option under the Options menu to switch confirmation dialog
boxes on or off and set your screen resolution.

Note: When you save your desktop, TOS saves all the Options
menu choices you made to the NEWDESK_INF file on your startup
disk. (See save Desktop in this chapter.) Use Save Desktop to save
changes made with Options menu commands.

Install Icon

Install Icon allows you to choose the shape of your window and
desktop icons. The DESKICON.RSC file on your C drive or floppy
startup disk contains a collection of detailed icon shapes. You
access this file through Install Icon. Choose from a variety of icons
to create an interesting and entertaining desktop.

You can also use Install Icon to change a floppy disk’s or logical
drive's icon identifier and icon label.

When you select Install Icon from the Options menu, the select icon
type dialog box displays. You can select either Desktop or Window.
Desktop icons are: device icons (printer, floppy disk drive, logical
drive, and cartridge), and the trash can icon. Window icons are
folder and file icons.

Advanced Desktop
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DESKTOP ICON

When you select Desktop (icon), the following dialog box displays:

INSTALL DESKTOP ICON

Icon Identifier: |
Icon Label! o

Icon Type!

ST (Trash can][ Printer
Icon Shape!

To install a single desktop icon, follow these steps:

1. If you are installing a floppy disk or logical drive icon, type the
" drive identifier letter. Press [Tabl.

i ical drive. You can use
i name of the floppy disk or Iogtca
= ISF;S I1r12“t;r€1earacters. This step is optional; you do not have to
assign labels (names) to your desktop icons.

i i ish to install:
iti inter over the type of icon you wish to
= gcr)i?;m?riosﬁ{g:n. or Printer (see Using an Installed Printer icon
later in this section). Click the mouse button once.

i hoices. When
arrows to scroll through your icon chq
% %iecfggrzcg?gon displays, select OK to install. The icon appears
on your desktop.

i i f desktop items. For
assign an icon shape to a group o
:fal'ln:glg EJ‘ilisycf)ou wgnt all of your logical drive icons to hat\l"-ueattgﬁ:];ﬁo
disk icon. shape, in the same operation you can assign
all logical drive icons.
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To assign an icon shape to a group of desktop items, follow these
steps:

1. From the desktop, use rubber-banding or shift-clicking to
highlight the group of desktop items.

2. Select Install Icon from the Options menu. T
Icon dialog box displays. The
currently assigned icon sha
appears in the dialog box.

he Install Desktop
drive identifier. icon label, and

pe of the first selected desktop item

3. If the Drive box is not highlighted, position your pointer over the
Drive box and click the mouse button once.

4. Use the scroll arrows to display the desired icon shape. To
assign that icon shape t

o the first of the selected group of items,
select OK. The second item of the selected group displays in the
dialog box.

o Note: If you do not wish to assig
in the selected group, select Skj
dialog box. That item will retain

N a new icon shape to an item
p when that item displays in the
its current icon shape.

When you have completed the selection process for the final item in
|

the selected group, the dialog box disappears. The new icons for all
selected items appear on your desktop.

WINDOW ICON

There are two ways in which window items can be displayed in a
window: text and icons. You can assign icon shapes to window
items that are currently displayed as text, but the assigned icon

shapes will not display until Show as Icons (under the View menu)
is selected.

You can assign icon shapes to: a single window item (file or folder).
a group of window items, or a specific file type.

Advanced Deskiop
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INSTALL WINDOW ICONS

Name: !...__-_- -—

Icon Shape: @

File Type: [ FILE |

|Install] [Remove || Skip |[Cancel]

To assign an icon shape to a single window item (file or folder), or a
group of window items, follow these steps:

' ini ' [ i . Highlight
the window containing the desired window items. Hig
e Sgﬁ'\%le displayed window item or use rubber-banding to high-
light a group of displayed window items.

rom the Options menu. The Install Window
2 E’:ﬁlr?sctdliglséglIt:ggrcliifsplay& The name of the first selected desktop
item appears in the dialog box. Either the File or Folder bhox_ls
highlighted, designating the type of item displayed, and the icon
currently assigned to the item is displayed.

i i When
the scroll arrows to scroll through your icon choices.
= t-rjlseedesired icon displays, select Install to assign the icon shape
to the displayed item. The name of the selected group’s second
item displays in the dialog box, along with that item's current
icon.

: u do not wish to assign a new icon shgpe to an item
o m?:lee' e!!a?e%ted group, select Skip when that item’s name and
current icon displays in the dialog box. That item retains nsu
current icon shape. If you wish to remove the item’s currently ;
assigned icon shape, select Remove. The default icon shape for
that item type will automatically be assigned to that item.

i the final item in
hen you have completed the selection process for .
‘t‘ﬁe selicied group, the dialog box disappears. The new icons for all
selected items appear in the window.

i i i . After setting the
You can also assign an icon shape to a file type
parameters to define the file type, all the files that match the
selected parameters will be assigned the specified icon shape.
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Select the parameters the same way you would set a file mask,
typing in the parameters on the Name line of the Install Window
Icons dialog box. (See Set File Mask in this chapter.)

To assign an icon shape to a specific file type, follow these steps:

1. With a window open, select Install Icon from the Options menu.

Select the Window box from the dialog box. The Install Window
Icons dialog box displays.

2. Type *. followed by the extension (for example, * FNT).

3. Use the scroll arrows to display the desired icon shape. To
assign that icon shape to the files matching the specified
parameters, select Install. The dialog box disappears. All files

that match the selected parameters will be represented by the
new icon.

CHANGING THE ICON IDENTIFIER AND LABEL

To enter a new icon identi

fier and label for an icon, follow these
steps:

1. Highlight the icon you wish to change. Select Install Icon from
the Options menu. The Install Icon dialog box displays.

2. Type the new Icon Identifier letter and press [Tabl. If you wish to
retain the current drive identifier, press [Tab] to move the text
insertion cursor to the Icon Label line.

0 Note: The letters A and B are reserved for floppy disks, and the
lowercase letter ¢ is reserved for the cartridge slot. Uppercase
letters C through P represent logical drives.

3. Press [Esc] to clear the Icon Label line. Type in the new icon
label. You can use up to 12 characters. Select OK.

USING AN INSTALLED PRINTER ICON

An installed printer icon can help you print files in the same way as
the Print command of the Show/Print dialog box (see Opening a
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i iti ired files over
ile in Chapter Five). Drag and position the desire
%?Tnﬁrl:?er icon.plf you have a printer p_roperly connected to your
system, the information from the file will be sent to the printer.
Some files may print only coded or incomplete information.

i [ [ the installa-
installing a printer icon, use Save Desktop to save tne _
#étgr ':'T'mse nex? tirr?e you switch on your system, the printer icon will

appear on your desktop.

Install Application

Using Install Application, you can:

icati i i ifi tension. You
« Link an application to data files with a specified ex
IE?: then T:F:ocess those data files (documents) directly from a
window instead of having to open the application first

icati henever you
. an autoboot status for any application, so W )
gﬁ:ﬁ:ﬂ on your computer the application opens automatically

- Assign a function key to open an application
i ifi lication.

. ify what default directory to use for a specific app
?ﬁgcallgsigned default directory takes precedence over the defaults
assigned by Desktop Configurations f

: T Hoation

e ity full path or filename to an application. The specifica
?a?ﬁzgfgrece?jence over the defaults assigned by Desktop
Configurations

» Assign arguments to programs

ARGUMENTS

open a program file, you are telling the computer to )
;):Irllc?vc ghoeuingtructigns Ei’n that file. The instructions within the ptrt'?
gram file then take over and run the show until you exit from l e
program. Sometimes you need to give the program additiona I
information. such as what to do with a data file. This additiona

information is called an argument.

i i ts, such
rams provide ways for the user to input arguments, ]
la\lﬁsozhpé?:%n Filepcomrnand in a word processing program. In fact, if
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you input the name of an existing data file in the Arguments line,
and you have your input parameters set in such a way that the
program can find the file, the data file will open automatically when
you open the word processing program. But unless you work on
one data file almost exclusively, other options such as linking an
application to a data file type make arguments of this kind clumsy
and unnecessary.

Arguments are used most often with utility programs. These pro-
grams often need complex additional instructions such as a code
sequence to determine which part of RAM will be used to contain
the program instructions. Detailed explanations of the arguments
needed, and the correct syntax for those arguments will be included
in the program’s documentation.

When you open the Install Application dialog box, the text insertion
cursor is already on the Arguments line. Simply type in the argu-
ments and press [Return]. Remember to use Save Desktop to save
the argument, otherwise it will be erased when you switch off the
computer.

LINKING A DOCUMENT TYPE TO AN APPLICATION

Normally, the only way you can process a data file is to first open
an application that can work with the type of data contained in the
file. Then you can open the data file from within the application. If
you attempt to open a data file directly from a window, a dialog box
displays informing you that your options are to show or print the file,
or cancel the request. You cannot edit the data in the file.

But you can use Install Application to link a data file type
(determined by the three character file extension) to an application.
Choose the file type most commonly used by the application. After
linking the application with the document type, the linked application
automatically opens when you open the document.

0 Note: You must pay particular attention to assigning correct default
directories and parameters to an application when linking a docu-
ment type to an application. This is especially frue when you open
the application from its icon on the desktop. Refer to the applica-
tion’s documentation for detailed information on correct default
directories and parameters.
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To use Install Application to link an application to a data file type,
follow these steps:

1. Display the window containing the application you wish to link to
a document type. Highlight the desired application. Select the
Install Application dialog box from the Options menu. The name
of the selected application appears in the Install Application
dialog box.

o Note: You can select more than one application at once for this

o

operation. Highlight all the applications you wish to install, then
open the Install Application dialog box. After completing the
operation on the first selected application, the name of the
second selected application appears in the Install Application
dialog box.

2. Press [Tab] to move the text insertion cursor to the Document
type line. Type in the three character file extension of the file
type you wish to link to the displayed application.

3. Select the appropriate Application type.

4. Choose a Default Directory and Parameter. (See Selecting a
Default Directory and Parameter in this section.)

5. Select Install to enter the selected settings.

Note: When installing multiple applications, selecting Skip will
cause Install Application to skip over the application whose name is
displayed on the Application name line. All current settings will be

retained.

SELECTING A DEFAULT DIRECTORY

Every program that works with supporting files (such as resource
files or help files) has to have, as part of the program, a way to look
for those files. Desktop Configurations tells your computer which
directory should be the default. This is where the program will
access files if the program assumes that it is not installed. Using
Install Application to assign a default directory to a specific
application overrides the Desktop Configuration’s assignment for
that application.
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You can set the default directory to Top (active) Wind
Application (the directory in which the program resideg)”.“ &

Some programs do not look for files in an i
¢ y location other t
default directory. For these programs, select Top Windozv.ha?r?dthe

make sure that the program file an i i i
ity prog d all supporting files are in the

SELECTING PARAMETER

Before an open application can use a data file, it must fi i

open the file. Most programs enable you to search thrtofL':r;lt'lig;ld e
existing directories to locate and open a desired file. These pro-
grams have no preconceived ideas about the location of files. For
these programs you would choose Full Path, so the entire paih-
name of the file is used when a file is opened.

Other programs already have pre-existing partial aths. Thi

that the program contains a partial pathngrﬂe thatpit usesTQ\’fsep;?i?rqz
the program searches for a file. A partial pathname consists of the
drive identifier, and all applicable directories. Only the file name and
extension is input for the search. All files must be in the specified
dlrectoyy. or they cannot be located. Check your program'’s docu-
mentation to determine the program’s default path, and make sure
all of your data files reside in the correct directory.

Always try Full Path first. Then if necessar i i
/S tr) _ . ¥, experiment with oth
combinations until you find one that works with your applicatic?n. °

INSTALLING AN APPLICATION TO OP
FROM A FUNCTION KEYSTROKE e

Any executable file (program) can be installed to 0- en fr

; om a func-

tion key ([F1] through [F10] at the top of the keyboap;d), You carlumc

;r;sr;tteggﬁ sttotgo programs to %pen this way. Use [F1] through [F10]
N programs, and [Shift] [F1] t i

BT et fo b ift] [F1] through [shift] [F10] for

After you assign a function key to a program, you only h

. . d a
to press the assigned function key to open tha); progrgm. 'T'?ﬁe
assigned key will only open the program from the desktop. Once
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you are within an application, the function keys perform the tasks
assigned to them by the application.

To assign a function key to open an application, follow these steps:
1. Highlight the application.
2. Select Install Application from the Options menu.

3. Press [Tabl twice to move the text insertion cursor to the Install
as line.

4. Type the number of the function key you wish to assign to the
application.

5. Select Install.

INSTALLING AN APPLICATION TO AUTOBOOT
OR NORMAL BOOT STATUS

If you mainly use your computer for a single purpose using one
specific application (such as a database, a word processor, or
graphics program), it will save time if you install that application to
autoboot. An application installed to autoboot status will open
automatically whenever you switch on your computer.

Follow these instructions to install an application to autoboot or
return an application to normal status:

1. Highlight the icon or name of the application you wish to install to
au?obgot. Select Install Application from the Options menu. The

Install Application dialog box displays.

2. Select the Boot Status: Auto box. (To restore normal boot stgtus
to an application installed to autoboot, select the Boot Status:

Normal box.)
3. Select the appropriate Application type box.

4. Select Install or press [Return].
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Remember to use Save Desktop to save the selected boot status,
otherwise it will be erased when you switch off the MEGA STE. The

next time you switch on your computer, the selected boot status will
be in effect.

Install Devices

The Install Devices command installs desktop icons for all hard
disk partitions on all properly configured devices. It also installs a
cartridge icon if a cartridge is in the cartridge slot during startup.

To use Install Devices, follow these steps:

1. From the Options menu select Install Devices. Icons for all
configured devices appear on your desktop. Each icon has a
uniqueéjrive identifier letter, and each device icon is labelled
DEVICE.

0 Note: You can change the shape of your desktop icons. See
Install Icon in this chapter.

2. Use the mouse to place the desktop icons where you want them
to appear. Select Save Desktop from the Options menu. The
Save Desktop Dialog box displays. Select OK.

The Save Desktop command saves your desktop configuration in a

file called NEWDESK.INF. This file stores information about which

icons have been installed and the location of each icon on the

desktop. See Save Desktop in this chapter.

Remove Desktop Icon
If you wish to remove an icon from the desktop, follow these steps:
1. Highlight the icon you wish to remove.

2. Select Remove Desktop Icon from the Options menu. The icon
disappears from the desktop.
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ighli [ ication file,
: If the highlighted icon represents a data or applica
0 ggitaeiog boex digsplgys and asks you whether you want to delete
the file or just remove the icon.

i i i ' ted
ber, the information stored on the logical drive represen
E;??gnmoved hard disk icon is still on the hard disk. To r'egal?
access to that information, you can: reinstall a hard disk icon for
that logical drive, or press [Alternate] and the drive letter.

Set Preferences

i hether or not you
Set Preferences option lets you choose w _
Hlseh to have alert boxes display during copy, move, delete, anu;i1 file
overwrite operations. Set Preferences also lets you select monitor
resolution.

When you select the Set Preferences option, the Set Preferences
dialog box appears:

SET PREFERENCES

Confirmation required for:

File Deletes: [THo
File Copies: [Ha
File Oversrites:

Set screen resolution:

[ ST Low |[ST Hediun |[ ST High |

ill di in to
ct Yes, an alert box will display whenever you begin
lciglg.t.le.sglfpy. or overwrite a file (depending on which cf;;:lt_:on y%t,_;
have selected). The alert box requests confirmation of the ctq
mand, giving you the option to proceed or cancel the opﬁra |or;‘
This step can help prevent accidental deletion or overwri |r_1|? c? "
important files. Selecting No skips this step; no alert box will display.
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0 Note: You must save your desktop to save changes made to the
confirmation section of the Set Preferences dialog box. Any change
made to the screen resolution section of the Set Preferences dialog
box causes the computer to warmstart. If you do not save your
confirmation preferences with Save Desktop before you change

screen resolution, the warmstart will erase all of your confirmation
preferences.

Set screen resolution lets you select monitor screen display resolu-
tion. The MEGA STE supports three graphics modes. ST Low
allows 16 colors onscreen, with a resolution of 320 x 200. ST High
is an incredibly crisp resolution of 640 x 400.

MEGA STE Graphics Modes

Resolution Palette Colors Onscreen
ST Low (320 x 200) 4096 16
ST Medium (640 x 200) 4096 4
ST High (640 x 400) 4096 2

You will need a high resolution monitor to display the ST High
resolution.

Click on OK (or press [Return]) to set the selected preferences.
Remember that changing screen resolution causes the computer to

warmstart. Your selected screen preference will be in effect after
the MEGA STE warmstarts.

Read .Inf File

You can have more than one desktop information file on your hard
disk, each containing different information (such as installed desk-
top icons and their placement, and all View and Options menu
options). The Read .INF File command allows you to change to a

different desktop environment without having to transfer files or
reboot.

The default NEWDESK_INF file is in the root directory of your C
drive. You can name the alternate desktop information files any-
thing you like, but the three character extension must be .INF.
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With the Read .INF File command, you instruct the MEGA STE to
read information from a specified alternate desktop information file.
Follow these steps to use the Read .INF File command:

1. Select Read .INF File from the Options menu. The Select an INF
File dialog box displays.

2. Display and highlight the alternate desktop information file.
Select OK, or press [Return]. The new information is read into

your computer.

o Note: If you wish to save the current NEWDESK.INF file before
using the READ.INF command, simply change the name of the
current file NEWDESK.INF file. This will allow you to save your
desktop without losing your current setup.

Desktop Configuration

With the Desktop Configuration dialog box you can set the default
directory and input parameters for all applications, scroll through
assigned function keys, and assign a single keystroke to various
menu commands. The Desktop Configuration dialog box also
displays the amount of RAM still available.

DESKTOP CONFIGURATION
Set default directory as:

Set input parameter:
File Name Only

Function-key Assignments:

1 ) I 5
Define Single Keystroke!

Menu Item:

(_Open... ]} |
Key: 0

System Free Memory: 7515834 bytes

Most applications use the default directory and input parameters
displayed in the Desktop Configuration dialog box. The exceptions
are applications that have been assigned their own specific default
directory and input parameters through the Install Applications

dialog box. You can find detailed information regarding setting the
default directory and input parameters under Install Applications in
this chapter.

You can use the Function-keys Assignment to display the full
pathname of each program that has an assigned function key. Use
the right and left scroll arrows to display hidden parts of the path-
name, and the up and down arrow keys to scroll through the
assigned function keys.

All menu commands can be assigned a keystroke. This enables
you to bypass the menu bar and initiate the command by pressing
a single key. Use Define Single Keystroke up and down arrows to
scroll through the menu commands and their keystroke assign-
ments. To change the keystroke of a displayed menu command
type in the desired keystroke. To clear all menu command '
keystroke assignments, select Clear All.

System Free Memory displays the number of bytes of RAM still
available.

After making changes to the Desktop Configuration dialog box,
select OK to confirm your choices. Use Save Desktop to save your
Isv?é%:;log?_é or they will be erased the next time you switch off your

Save Desktop

You can rearrange the desktop icons and windows to suit your
personal preferences and use the Save Desktop option to save the
new arrangement. For example, you might want to move the trash
can icon, line up the disk icons horizontally, or have the startup
screen display several open directory windows.

Save Eieskttop also sa;es Ofption and View menu selections. The
computer stores saved configurations and menu selections in a
NEWDESK.INF file and places this file on your startup disk or hard
disk drive root directory.

Arrange disk and trash can icons by dragging them to new positions
on the desktop. You may want to ciose all windows first to start with
a clean desktop.
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How you arrange your desktop will depend on your needs, but it's BLiTTER
usually a good idea to place the trash can icon away from the disk
drive icons to protect against unintentionally dragging files to the The BLITTER co- -
trash can instead of to a disk or logical drive icon. greatt:y impr ngg tﬂgoggg‘sa%rgfhtlg;rn atr':g gh;/r'gfrﬁcf -criF CIOmDU_}ﬁr
3 _ ) can be turned splays. This chi
| Arrange directory windows on the desktop by opening, moving, and Options menu‘o\;]vﬁ;r? ft';'ug);es?slzcgﬂg ‘Ee BLITTER option from the 5
| sizing selected windows. You can have up to seven directory BLITTER is turned on. When th €ck next to this option, the
windows open at once on the desktop. Select options from the View disabled. ' ere is no check, the BLITTER js
menu t? determine how wi)ndow items ((folders and files) will be
i shown (as text or as icons) and sorted (by name, date, size, or In most cases, you wi :
f type).‘ If you show window itenjs as text, you may want to narrow faster graphics )jand telit\hggtctigsri]?avbﬁ thﬁ] BLITTER on because
the windows to show only the item’'s name and extension. may run too fast, or not at all, with thz Bf#?r‘éeé.tSorn%applications
: urned on. In these

cases, turn of i ;

If you leave the windows open when you save the desktop, those fhe BLITTER before starting the program.
windows will open to the same size and position the next time you
switch on the computer. The window that is active when you save
the desktop will be the active window the next time you switch on

the computer.

The size and position of closed windows is also saved when you
select Save Desktop. The next time you open the window, it will
open to the size and position it occupied on the desktop the last
time it was opened.

Print Screen

The Print Screen command lets you print the current screen
display. Everything showing on the screen prints.

To use this command, you must have a graphics printer connected
to the computer. The printer must be installed from the Control
Panel and switched on. If you are using an Atari SLM Laser Printer,
the program SDUMP.PRG must be in the Auto folder on your
startup disk. Set up the screen you want to print, then select the
Print Screen option.

Advanced Desktop
4-28 Advancid Desktop
-29




CHAPTER FIVE
DIRECTORIES, FOLDERS, AND FILES

A computer processes information
the information and then told what to dow
information grouped together is called a fil
tion file contains instructions for the comp
information to be used or edited by the pr

ith it. A collection of

ogram or application.

Directories and folders provide a wa

organization and storage. Maintaining an organized structure for

your files and folders_ helps you easily locate files and creates an
efficient working environment.

y to group files together for

DIRECTORIES AND FOLDERS

A directory is the area on a drive (a drive can be either a floppy
disk, or logical drive on a hard disk) that contains a list of the files

. but it must first be provided with

e. A program or applica-
uter. A data file contains

residing on that drive and the locations of those files. The computer

can display directories as either a list of file and folder names, or
graphically, with each file and folder represented by an icon.

Every formatted drive has at least one directory (the main or root
directory), which lists all the files and folders on the disk or logical
drive. Directories can contain other directories, allowing you to

create a hierarchical structure of directories within directories. A
directory within another directory is called a subdirectory or folder.
The terms folder and subdirectory are synonymous.

Identifying Directories and Folders

The root directory is the first directory displayed when you open a
disk icon. When you open a root directory, only the Disk |dentifier
and file mask appear in the window's move bar. For example, the

move bar of a newly formatted floppy disk in drive A would display
the following:

A\x x
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When you open a folder, the folder's name is added to the move
bar. If you opened a folder called LETTERS that resided in the root
directory of a floppy disk in drive A, the move bar would display the

following:
A\LETTERS\* *

Displaying a Directory or Folder

You can view the contents of a directory or folder by opening the
icon representing that directory or folder. A desktop window opens,
displaying the contents of the directory or folder. The contents will
display as either text or icons.

To open a directory or folder, position the pointer over the desired
icon, then double-click the left mouse button. Or highlight the
desired icon, then select the Open command from the File menu.
Once the window displays, you can select the contents (other files
and folders) of the directory or folder.

Directories and folders can contain data files, program files, and
folders. If you have a number of related files, you can place them
inside one folder to keep them together. You can also put folders
and files within other folders. You can create a folder using the
Create Folder command. (See File Menu in Chapter Four.)

FILES AND FILENAMES

A file is a collection of information grouped together under a single
filename. There are two types of files. Executable files (also called
programs or applications) contain instructions for the computer to
carry out. Most of the time the instructions contained in executable
files are used to work with information in data files. A data file is a
collection of information that contains no instructions for the
compulter.

You can place files in root directories and folders. If you choose to
display your folders and files as icons (see View menu in Chapter
Four), you will have as many icons in a directory as you have
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folders and files in that dire i i
oo lemihe ctory. The name of the file or folder will

Filenames and Extensions

Files are identified by filenames. Y
1€S. You can name the files
ggd chla_lngt_a the names of existing files. New files are narﬁgg gi?l%:?'
Info?'l?rfalt?gril%g nv:rl-::n ‘tjhey <:flretrr:]reated, You can also use the Show
_ 'mand under the File menu to rena isti i
(See File menu in Chapter Four for more informatiorT )e e,

The filename is made up of two -

! parts: the name i
three character extension. In the following examsgdt:wheenoapnonal
SAMPLE and the extension is .PRG. i u bil,

ISAI\&‘IF’LEJi—"F!G}

| e i ional;
i xtension (optional; a period (.) and up to three characters)

name (mandatory; up to eight characters)
The name section of a filename can be from one to eight characters

(letters, symbols, or numbers) long. A filename extension can be

from one to three -
period. characters long, separated from the filename by a

! N

* Period (.)

* Quotation Marks (")

* Forward Slash (/)

* Backslash (\)

* Brackets ([ or ])

* Vertical Break Bar (|)

* Less-Than Symbol (<)

* Greater-Than Symbol (>)
* Plus Sign (+)
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« Hyphen/Minus Sign (-) PR :
.PRG GEM i
P . application. (See .APP.)
o i . .TOS A TOS applicati A
Semicolon (;) | 2 bl not%%écfgg’fégfos file is a non-GEM application. It

« Comma () the mouse. SINirohmentana may not sven use

 Asterisk (*) TTP A
o Buastion Mark (7) - b .aT}F(’) (ST gﬁes}lgrzibzirt:rggﬁgst) apﬂlication, A TTP file
that will control the program's ope oy cmeters (data

; gram's operation). Whe
) ; : 3 ’ . a.TTP f Pt : N you open
Filenames usually refer to the information contained in the file, such requestil’_tg-yaonu?é";gtéppllcailon dialog box appears
as TAXES for tax information, or TAXES87, TAXES88, and , .TTP program’s docu r some parameters. Consult the
TAXESS8S for a series of tax information files. mentation for more information.

Note: When yo i
An extension often indicates the file type, and certain types of files o by their extenléio'.;]\vsfrt files by type, they are arranged alphabetically

must have specific extensions. For example, the PRG extension
indicates to your computer that the file is an executable GEM appli-
cation. If you remove the extension, the computer would not

recognize the file as an application. Pathnames

A pathname is a description of a folder's or file's location. A

et io g e et appicaton crealos For coch appicae )t g i e e
example, word processors often use .DOC or .TXT as an extension sl L wpi‘ﬂljatﬁ fml(s s e
for documents. See the documentation suppliéd with the ggagﬁ);yr:sr}geencj#ﬂg }Nithl Pty ini;eh&;ﬁ:ﬂgﬁ 'fgltdheer e
s. The final element of a pathname is the
name and

application for more information. extension of the file or fold
e or folder. The move bar di
Each of the following executable file types has a unique file pathname of the displayed file or folder. SPiRYE the complele

extension by which it can be recognized. These extensions should Let's bui
be used only for executable files: .PRG, .TTP, .TOS, .ACC, and Ce ts build an example. You have a floppy disk in drive A which
"APP. Files with any of those extensions cannot be opened if the Bﬂ? ;g:jsa?g Jr?tas 3?|%S‘and marketing reports for all sales reg;ons
Mt eres indi -
extension is deleted or changed. Reklaf calas regior?, In finding the July 6th sales report from the
The five most common extensions and their definitions are listed First you open the disk
below: : U open the disk icon for floppy drive A. A wi
glspla_xélng drive A's root directory. The move barvéligggﬁsogslns{h
ACC A GEM Desktop accessory. The system accesses .ACC b”VE lI en?liler and file mask. The file mask is the * * foliowi yth 3
files which appear under the Desk menu. Use accessories ackslash: ; ngiine
by selecting them from the Desk menu. You can have up At +

to six active accessories on the system at a time.

il _APP A GEM application. An .APP file is a GEM application and 0 Note: For a full explanation of file masks, pl :
; ) Mask under Fil : . Please refer to set File
will usually take advantage of the GEM environment by above arsk e Menu In Chapter Four. The asterisks in the file mask

using windows, icons, and drop-down menus. , known as wild card characters. Wild card
: : . cha
explained in the section on File Specification in this chap;g?ers e
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One of the items in the displayed root directory is a folder called
SALES. When that folder is opened, the name of the folder is
added to the pathname. The pathname then consists of the Disk
Identifier and the folder name like the example below:

A\NSALES\* *

The window now displays the contents of the SALES folder. One of
the items in the displayed directory is a folder called WESTERN.
When that folder is opened, the name of the folder is added to the
pathname. Now the pathname looks like this:

A\SALES\WESTERN\* *

In the displayed directory of the WESTERN folder you find the file
you are looking for, called JULY_B.DOC. If you opened that file
from within an application, the following entire pathname may
display in the move bar:

A\SALES\WESTERN\JULY_6.DOC.
The file mask is replaced by the actual file name and extension.

0 Note: Do you notice something odd about the filename
JULY_6.DOC? An underline character separates JULY from 6.
Since the space character is an illegal character (you cannot use it
in file or folder names), sometimes the underline character is used
to simulate a space.

Opening a Program File

When you open a program file, the computer carries out the
instructions contained in the file. This is also called starting,
running, or launching the program.

There are many ways to open a program file from the desktop. You
can position your pointer over the file's name or icon (located either
in a window or on the desktop) and double-click the left mouse
button. You can highlight the file, then: select the Open option
under the File menu, or press the assigned command key (the
default command key for opening a file is [0]). You can also use an
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assigned function key to open the program. (See o i
Menu in Chapter Four.) . e A

Other methods of opening a program file are explained i
icati 3 plained in the
Application section under Options menu in Chapter Four.) -

File Selector

The File Selector is a special dialog box that can onl

e S ( y be accessed
from within a program. You will use the File Selector for loading and
saving files. Many applications programs use the File Selector

dialog box.
_ FILE SELECTOR
Directory:
D:\ADMIN\FAX_MEMO\*.DOC______________
Selection: | _____
__351 ;
FaxJapan.0oc | 2| [E1[F
FAX_CHCG.DOC 3 H
FX_1.9 .pOC J
MEMO .DOC K I
————— e il H
P S e ] i
-------- A el
2 [ Cancel |

When you display the File Selector dialog box, the Directory field
dlspla‘ys the current directory’s pathname. The pathname consists
of a disk identifier, folder name(s), and a file specifier.

The Selection field shows the currently selected file (if one has
been selected) and can be edited like the Directory field.

The directory window shows the current directory’s folders and files
that can be accessed by the application. The folgers are listed first
in the directory window, and then all files are listed. (For further
information on sorting see Sorting Files and Folders in this chapter.)
If the directory contains more files than it can display in the window
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at one time, scroll the window to view the hidden files. (See Scroll-
ing a Window in Chapter Three.)

The drive selector shows the currently selected drive.

il , l8log
te: When you make a change within the File Selector dia ‘

0 {)qt?x related fiyt‘B|dS automatically show that change. For instance, if
you'change the drive with the drive selector, the drive letter in the

Directory field also changes.

SELECTING A FILE

Place the pointer on the filename you wish to select. Select a file by
one of these methods:

« Click the left mouse button. Select OK.
« Double-click the left mouse button.
« Enter the filename on the Selection field, then select OK.

SELECTING A DIRECTORY

) . , ina the

om the directory window, open a folder qlrectory by selecting
If:orlder name. Theycurrent directory window's folders appear at the
top of the directory, marked with a folder symbol. To close a folder
directory, select the close box button. The current directory’s path-
name appears in the Directory field.

: : . . ¢
the Directory field, you can select a directory by typing tha
i:rlcc’i?r's |::tathr|an'|e}fr To do this, erase the Directory field, type the
new pathname, and press [Return]. The pathname contains a disk
identifier, and may contain folder names and a file specification.

Directories, Files, and Folders
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SELECTING A DRIVE

You can select a drive from the drive selector or the Directory line.

To select a drive with the drive selector, position the pointer over
the desired drive's letter. Click the mouse button to view the drive's
directory.

@ Note: The drive letter is part of the disk drive identifier. The disk
drive identifier includes a letter specifying the disk drive, a colon (:),
and a backslash (\).

THE FILE SPECIFICATION

The file specification in the Directory field is a search criterion that
may include letters, numbers, and special characters called wild-
cards (* and ?). The file specification determines which files will
appear in the directory window. By editing the file specification, you
can choose which files or types of files to display.

The file specification is similar to a filename. It contains a manda-
tory name of up to eight characters and an optional extension of up
to three characters. A file specification uses the asterisk (*) and the
question mark characters as wildcards.

An asterisk in a file specification stands for all characters and
combinations of characters, and can replace an entire name or
extension. For example, the file specification ** calls for the
display of all filenames with all extensions.

A file specification will often have an asterisk as the name but
specify an extension. For example, the file specification *DOC
allows all filenames with the .DOC extension to appear in the
directory window. This file specification would show the files:

REPORT.DOC
STOCK.DOC
MEMO.DOC
This file specification would not show:

FINANCE.TXT
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i ' i f
e asterisk must be the last characi(_ar in the‘ name or extension o
;rf‘ile specification. For example, the file specification TAX*.DOC
is valid, but the file specification T*X.DOC is not valid. The letter
following the * is of no importance since the * before the letter

specifies all characters.

i i i ificati ingle character.
The question mark in a file specification replaces a sing '
For eqxample. the file specification MEMO?.LET specifies all files
which begin with MEMO, which have any character in the fifth 1
position of the file's name, and which have the extension .LET. This

file specification would display the files:

MEMO1.LET
MEMO4.LET
MEMOZ.LET

This file specification would not display the files:

BID.LET
MEMO33.LET
MEMO1.DOC

i i 20L€T2T
You can combine wildcards and characters. For example, 7
and F*. T* are both valid file specifications which would display

FILE.TXT.

; e il . 7 rectory
To change a file specification, edit the specification in the Direc
field, the% update the directory window by pressing [Return].

Opening a Data File

You can open the application file first (see Opening a Program File in

i ion) and then open the data file using the File Selector. Or
%3 Sc?;r:'lngaae a step by szsing Install Application to link the data file
type (identified by the three character ‘extgnsmn) to an application.
If the data file type is linked to an appllcatton,_you can use one of
the four methods for opening a file (see Opening a Program File in
this chapter) as if you are opening the data file from the dfesk‘top_‘
The computer will open the selected file. (See Install Application in

Chapter Four.)
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Note: You can also open a file by dragging a data file over the icon
for the program file.

If you attempt to open a data file whose file type is not linked to an
application, the Show/Print dialog box displays.

Select Show to display the data file on screen. If the file contains
readable text, the text displays. If the file is longer than one screen,
the message -More- appears at the bottom of each screen of text.
You can scroll through the file in the following ways:

* One screen at a time by pressing [Spacebar] or the mouse button
= One half screen at a time by pressing [D] or [Control] [D]
* One line at a time by pressing [Return]

Note: You can only scroll forward. You cannot scroll back through
text you have already viewed.

If you press the left mouse button or [Space Bar] while scrolling text
by the screen or half-screen, the screen will continue to scroll until it
displays a full or half screen starting from where you last pressed
the left mouse button or [Space Barl. The message -End of file-
appears when the entire file has been displayed . Press [Space Bar]
to return to the desktop. To return to the desktop at any time before
-End of file- appears, press the right mouse button, [Q], [Control] [cl,
or [Undo].

Select Print to print the data file. You can stop printing at any time
by pressing [Q], [Control] [C], or [Undol.

Select Cancel to return to the desktop without displaying or printing
the data file.

Note: Not all data files contain readable text. When you print or
show such a file, the screen may display only coded or incomplete
information.

Directories, Files, and Folders
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FILE AND FOLDER MANAGEMENT

Copying. moving, deleting, and other file and folder operations
allow you to better organize your disk space. If you maintain good
file and folder organization, you will conserve disk space and create
an efficient working environment.

Copying Files and Folders

You can copy window items (files and folders) onto a floppy disk,
logical drive or folder. When you copy a folder, the subdirectory
information and all the folder’s contents (files and other folders) are

copied to the new location.

To copy a window item, select the item and drag it to its new
position on the desktop. You can drag a window item to another
window. disk icon, or folder icon. The item's destination icon will
highlight when the item is positioned on top of the destination icon.

0 Note: If you drag a data file on top of an application, the application
will run. The data file will be used as a parameter and will open

automatically.

When you begin a copy operation on a single or on multiple window
items, the Copy File(s) dialog box appears. You must select OK to
continue the copy procedure. With single disk drive systems, you
will need to switch disks occasionally to complete the procedure.
The computer provides alert dialog boxes to tell you when to switch
disks. The Copy File(s) dialog box shows the name of the destina-
tion folder, and displays each item’'s name as that item is copied.

0 Note: The Copy File(s) dialog box will not appear if the File Copies
confirmation option has been turned off. See Set Preferences under
Options Menu in Chapter Four for more information on the File

Copies confirmation option.

You can halt the copy operation by pressing [Undo] while the bee
icon displays. On a single disk drive system, press [Undol while the
source disk is in the drive. When the Abort Operation dialog box
appears, select Yes to halt the operation, or No if you wish to

continue copying.
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To copy an entire disk, drag the disk icon to the copy destinati
(floppy disk, logical drive, or folder). Copying a diskpi{:on tgnaa}gjlger
adds the contents of the disk to the folder without disturbing the
contents of the folder. If the destination folder's window is open
copying a file or folder updates the displayed directory. '

Warning: Copying from one floppy disk icon to a '

_ \g frorm _ nother flo d
icon erases all existing information on the destination disk. Wrs:erfk
you begin this operation, an alert dialog box appears to make sure
you do not erase information you need.

Note: When copying from one disk icon to another, both di
be the same format (single or double-sided). r, both disks must

Name Conflict During Copying

A name conflict occurs when you attempt to co i i
: ) _ py a window item t
a floppy disk, logical drive, or folder that already contains an item gf
the same name. Depending on the File Overwrites confirmation
setting (see Set Preferences in Chapter Four), the Name Conflict
ﬁlﬁgud:\aflig?tbox a’ppeatLS warning you that a name conflict occurred.
o replace the existing item with the |
g bl g e item of the same

You could also choose to change the name of the window item you
are copying so no name conflict will occur when you continue the
copy operation. You can change the item's name from within the
Name Conflict alert dialog box. The text insertion cursor is already
positioned at ﬂje end of the Copy's Name line. Press [Backspace] to
clear the Copy's Name line one character at a time, or press [Esc]
to clear the entire field. Now type in the new file or folder name and
g?ilgiﬁla(l:i?py or I;?ress [_He_lutrn] to continue the copy operation. The
em will remain intact, and the iedi i ini
destination under the new name. SORERRRRAlConamRin It

When copying multiple window items, select Skip i i

! r : p if a name conflict
occurs and you wish to skip over that particular item, but you wish
to continue the copy operation on the other selected items.
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Moving Files and Folders

Moving a window item allows you to transfer that item to a new
location, deleting the item from its initial location.

To move window items, highlight one or more items. Then hold
down [Control] as you click on and drag the items to a new location.
The Move File(s) dialog box appears, showing you the number of
items involved in the Move operation.

Select OK to complete the move. To cancel the move operation,
select Cancel. When you select OK, the Move File(s) dialog box
shows the destination folder (if there is one) and the name of the

item moved.

You can halt a move operation in progress by pressing [Undo] while
the bee icon displays. When the Abort Operation dialog box appears,

select Yes to stop the operation.

Renaming Files and Folders

You can rename files and folders with the File Information dialog
box. The Show Information command displays the File Information
Dialog Box. For more complete instructions, refer to Show Informa-

tion under File Menu in Chapter Four,

Filenames can have from one to eight characters. Optionally,
filenames are followed by a period (.) and a three-character
extension. Folders can have from one to eight characters, and
usually do not have an extension.

0 Note: As a general rule, avoid modifying the three-character
extension. A change in the extension may prevent the system or an
application from using program, resource, data, and other files

correctly.
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Deleting Files and Folders

You can delete unwanted window items to free u roo i

or in a folder. There are two ways to delete windc’JJw items?n\’?)tflggn

highlight the desired item and drag it into the trash can icon on the

desktop. The trash can icon highlights and the Delete File(s) dialog

box displays. You can also highlight the desired item and choose

B::Z:e Item from the File menu or use an assigned keystroke for
e.

When the Delete Folders/ltems dialog box a

3 ppears, you can
confirm or cancel the delete operation. To conti i
and delete the item, select OK. i &t

Q Note: If the Delete File(s) dialog box does not a '
_ _ _ ppear, the File
Delete's %or:\farmatlon ofpnon has been turned off. See Set Prefer-
ences IN Chapter Four for more information on i
confirmation option. L il

You can halt a delete operation in progress b i

_ ‘ . y pressing [Undo
while the bee icon displays. Deleting files is a fapst oper%t[ion s]o you
must act quickly to halt the process. When the Abort Operat'ion
dialog box appears, select Yes to stop the delete operation. This
will not retrieve those files already deleted. '

Warning: Deleting a folder deletes all files and folders withi

thin the
selected folder. Once the bee icon disappear it i
any files and folders. e T

@ Note: You cannot delete a file if its read/write status is s
et at Read
_Cr)glghg}l]so. tyhou cala?ot_;:ielete a folder containing a Read Only f(ializl
( ge the read/write status of a file, select :
File menu, then select Read/Write. T LRl e
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CHAPTER SIX
DESK ACCESSORIES

Desk accessory programs are unique because they can be opened
not only from the desktop, but also while you are running another
program. For example, if you want to change how fast a key
repeats while you are working in a word processor, you can use
the Control Panel desk accessory to change keyboard repeat time
without exiting the word processor. Most programs that use the
menu bar will allow you to access desk accessories. Desk acces-
sories can be accessed from the far left menu item (usually the
Desk menu).

Installing a desk accessory is easy. Whenever you switch on your
MEGA STE, the operating system checks the main directory of your
startup disk for files that need to be run during startup. One of the
criteria used in identifying those types of files is the ACC (desk
accessory) file extension. Any file ending in .ACC and residing in
the main directory will be read and loaded during startup.

To install a desk accessory, simply place a copy of the program file
into the main directory of your startup disk. (Make sure the desk
accessory's file extension is ACC.) Then you must restart your
system, since the file can only be properly read and loaded during
the startup procedure. The desk accessory will now appear under
the Desk menu.

You can load up to six desk accessories at one time. If you store
more than six desk accessories on your startup disk, make sure that
the six desk accessories you currently wish to use have the ACC
extension. The ACC extension means the file is active. Change the
extension on all other desk accessories to ACX (or any extension
other than ACC). Inactive files will not be recognized or loaded
during startup.

0 Note: No harm will be done if you have more than six active desk
accessories on the startup disk's main directory. The first six active
desk accessories will load in the order that the files appear on the
disk, and any additional active desk accessory files will be ignored.
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XCONTROL.ACC, the control panel desk accessory included with
your MEGA STE, is already installed. The file resides in the main
directory of your USA Language disk, and in the drive C main
directory of your internal hard disk drive. The Control Panel will be
loaded automatically the first time you switch on your MEGA STE.

To open a desk accessory, first display the Desk menu. Position the
pointer over the desk accessory and click. The desk accessory
opens into a dialog box or window.

CONTROL PANEL

The Control Panel coordinates many smaller programs called
control panel extensions (CPXs). The initial Control Panel screen
displays the names of all currently loaded CPXs. You can open a
CIF’);_ by positioning the pointer over the desired CPX and double
clicking.

The Control Panel also contains a pull down Options menu. When
no CPX is highlighted, the Options menu displays two menu
choices: About and Setup. Two additional Options menu choices
display when a CPX name in the main Control Panel window is
highlighted. The three additional options are Open CPX, CPX Info,
and Unload CPX.

To select an option, position the pointer over the Options menu.
Then click the mouse button. The Options menu displays. Move the
pointer until the desired option highlights. Click the mouse button to
select the highlighted option.

Whenever you open a Control Panel or CPX window, you are
usually given the following options: Save, OK, or Cancel. Clicking
on the close window box is the same as selecting OK and then
closing the Control Panel.

Selecting Save places the currently displayed setting information in
a file on the startup disk. The MEGA STE will read this file during
startup, and load in the saved settings.

Select OK if you just wish to change a setting for one session. The
Control Panel window will close, and the changes will remain in
effect only until you switch off the MEGA STE. The most recently
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saved settings will be in effect then next ti :
MEGA STE. xt time you switch on the

Selecting Cancel will always return you to the main Control Panel
window.

About...

When you select About, Control Panel information (such as ;
number and copyright date) displays. YRIsion

Setup...

You can use the Setup dialog box to change a CPX's status (acti

inactive), reload CPXs without restarting thge MEGA STE, set(tall-lcn:ewe{

gmqunt tof mg;n)?rg_ reserved for basic CPX information, and
esignate a irectory path. You can also use the cal

clock to set the MEGA STE's time and date. p-enuenand

Tima

|

4:44 PH 8/16/98
Minimum Number

12/24 Hour Time——
Reload CPXs

Minmmum Number of Slots

|___CPX Directory Path |
K CAYTTTCN 7 — )

]
[_Save FRN 0K Qi Cancel ]
CPX Directory Path

Date and Time

The computer uses the date and time to mark individual files with
the date and time they were created or revised. This feature is

useful when you want to determine which file was most recently
changed or created.
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You can use 12/24 Hour Time to set the Control Panel clock to 12
or 24 hour time. This does not affect the way files are dated, only
the way the time is displayed in the Contol Panel window.

To set the clock or calendar, follow these steps:

1. Open the Control Panel. Select date or time by positioning the
pointer over the desired selection and clicking the mouse button.

2 Press the Left Arrow key to position the cursor in the window, or
press [Backspace] or [Esc] to erase the window. [Backspacel]
-erases the characters in the window one character at a time.
[Esc] erases the entire window.

3. Type in the desired time or date.
4. Click on the new time or date.

To change between 12 and 24 hour time, position the cursor over
the selection box to the left of the word Time. Click the mouse
button. Both the 12 and 24 hour selection boxes display. Move the
cursor until the desired box is highlighted. Click the mouse button

again.

CPX Mover and Reload CPXs

Only active CPXs are loaded during startup. All active CPXs appear
in the main Control Panel Window. If you need to use an inactive
CPX, you can use the CPX Mover to change the status of the CPX
from inactive to active. Then when you select Reload CPXs, the
newly active CPX will display in the main Control Panel window.

You can also remove a CPX from the main Control Panel Window
by changing the status of the CPX from active to inactive.

To change the status of a CPX, follow these steps:
1. Open the Control Panel. Select Setup from the Options menu.

2 Select the CPX Mover. The CPX Mover window displays.
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CONTROL PANEL :

GENERAL
COLOR

Move Box

3. Select the desired CPX by positionin i
by g your pointe
name of the CPX and clicking. The CF’g( hig?ﬂightsr. oavnedr ttI[?s
appropriate operation appears in the Maove box.

0 Note: You can select multiple CPXs for the mo
\ _ sele ve CP =
tion. Use shift-clicking or rubber banding to highlight nfosrg%?erlan
one CPX. If you use rubber banding, the rubber band box will not
actually appear, but it still works the same way.

4. Select the operation by clicking in the Move box.

If you have transferred a CPX from inactive to active status, you

must reload before you can use t
these steps: y e the CPX. To Reload CPXs, follow

1. Open the Control Panel. Select Setup from the Options menu.

2. Sel i ' i
S;:é:tt cI;)Iglloa\d CPX. When the confirmation dialog box appears,

Advanced Setup Options

Setting the Minimum Number of Slots and the CPX Di

X Directory Path
are advanced features of the Setup dialog b i 4
use these options infrequently. i AR
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2. Click anywhere on the CPX Directory Path box. The File

MINIMUM NUMBER OF SLOTS /
Selector displays.

CPXs are stored in an external memory device (hard disk or floppy

disk). During startup or reloading, only basic information about each 3. Use the File Selector to select a new path. When you open a
active CPX (such as the CPX’s name and icon) is loaded into RAM. directory, the directory name is added to the File Selector's
When you actually open an active CPX, the bulk of the file is then Directory line. When the desired directory path is displayed,
loaded into RAM so you can use the CPX. When you close the select OK. The new path will appear in the CPX Directory Path
CPX, the file is erased from RAM until the next time you open it. boX.

0 Note: CPXs with Resident status do not follow the above pattern,
but are copied into RAM at startup time. Open CPXs...
The MEGA STE has to know how much RAM to reserve for CPX You can open a CPX by first highlighting the CPX on the Control
basic information. When you set the Minimum Number of Slots, you Panel main window, and then selecting Open CPXs from the
are telling the MEGA STE to reserve enough RAM to be able to Control Panel Options menu. You can also open a CPX by double
store basic information for that number of CPXs. If the number of : clicking on its box in the Control Panel main window.

active CPXs at startup time exceeds the Minimum Number of Slots,
the MEGA STE will reserve enough RAM for that number of CPXs.

You can select from 5 to 99 slots. CPX Info...
To change the Minimum Number of Slots, follow these steps: When you highlight a CPX and then select CPX Info from the

: Control Panel Options menu, the CPX Info window displays. The
1. Open the Control Panel. Select Setup from the Options menu. window contains the selected CPX’s filename, version number, ID

] number, and Resident/Non Resident status.
2. Use the scroll arrows to display the desired number of slots.
Select OK or Save. Filename is the CPX's actual filename as it appears on the disk.
Version and ID are assigned by the CPX's programmer. Two
versions of the same CPX can have the same ID number. In this

CPX DIRECTORY PATH _ case, only the most recent version will be loaded. If you have
several versions of the same CPX, you can look at the version
The CPX Directory Path tells the Control Panel where to look for number to determine which is the most recent version.
CPX files. You will probably want to store all of your CPX files in
one folder, and set the directory path to that folder. But if you store You can use Configure CPXs (see Configure CPXs) to change the
CPX files in more than one place, the CPX Directory Path must be resident status of a CPX. You will probably want most of your CPXs
set to the directory that contains the CPX files you wish to use. to have Resident: No status. This means that the bulk of the pro-
_ ' _ gram is stored in external memory (hard or floppy disk) and only
0 Note: If the CPX Directory Path is too long to display in the box, read into RAM when you open the CPX. But if you have a CPX that
use the left and right scroll arrows to display the hidden sections of you use frequently, you may want to give it Resident: Yes status.
the path. CPXs that have a Resident: Yes status on startup will be read direc-
tly into RAM and will remain there until you switch off the computer.
To change the CPX Directory Path, follow these steps: Resident CPXs run a bit more quickly, but may take up a great deal

’ of RAM.
1. Open the Control Panel. Select Setup from the Options menu.
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Note: When you change a CPX’s status to Resident: Yes, the
status change will not be in effect until the next time you start your
system. The only time a CPX can be installed into RAM with Resi-
dent status is during startup. In addition, changing a CPX's status to
Resident: No status will not actually remove it from RAM until you

switch off your system.

Unload CPX...

Unload CPX does not change the status of the CPX to inactive.
It simply removes a CPX from the CPX list on the Control Panel
main window. You can use Reload CPX to place the CPX back

on the list.

0 Note: You cannot unload a resident CPX.

CPXs

ghis section describes in detail each CPX included with your MEGA
TE.

Window Colors

Window Colors allows you to assign different colors (depending on
the selected resolution) to different elements of desktop windows.
You can assign colors to each of the 15 elements of the active

window and 5 elements of inactive windows.

Even though the MEGA STE color palette contains 4,096 colors

in most resolutions, the colors available depend on the selected
resolution (from 2 to 16 colors on the screen at any one time). You
can use the Color Setup CPX if you wish to create a custom set of
available colors. See Color Setup. You can also use the factory
assigned default color set, or use function keys 1 through 10 to
select one of Window Color’s preassigned color sets.

Desk Accessories
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Window Title Active Window

Inactive Window

i
Close Box—— Hindowu
Information Box—— I Tnfp L Inacive Windaw Titte
Border | @ P __nfo T A"W Window Information Box
T!_:!'t 8 ———Vertical Seroll Box
Fl. “ 1] = Window Vertical Scroll Bar
i Vertical Scroll Bar Slider Space
Right Arrow R g:::"el::‘)*
Horizontal Scroll Box I Inactive Window Size B
o ][ Cancel ]
Leh Arrow
Horizontal Scroll Bar Slider Space

Inactive Window Honizontal Scroll Box

You can choose four options for each window e

allows you to choose the color of the narrow borlgrerﬁlqtétss?.lrr?s[mds
each window element. Use Text to choose the color of any text or
icon (as in the case of the Full box) that appears within the selected
window element. Fill is the background color of the selected
:L?prggm_.l ga?jfr‘ g;lu cuandafstcr:] cthose one of the eight fill patterns
g pgner:n.er e Fill scroll bar. The fill color will appear

The Mode box allows you to tog i

| : gle between having text a
directly on the fill pattern, and having text S o opeal
background over the fill pattern. 5 afpeatwitin solid

When you assign active window elem
) ent colors and then s
aﬁ-lvdeovovr (Bﬁ th_e Qew tcholctzrs will display the next time you oglta?r?ta
- ANy window that was opened befo i
new active window element coIoFr)s. S ilnotretlectine

Before you assign window element col

. ors, choose the color
wish to use. You can: use the factory assigned default color 23 e
press a function key (1 through 10) fo use a Window Colors preas-
signed color set, or use Color Setup to create a custom color set,
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Follow these steps to assign active and inactive window element
colors:

1. Select a window element for color assignment. A box outlines
" the selected element.
i ign Border, Text,
i d drag the appropriate scroll box to assign B :
¥ ggng?I?colorsg to the highlighted window element. Click on the
desired Fill Pattern.

Select the desired Mode. Repeat steps 1 through 4 until all the
" desired colors have been selected.

to permanently save the selected window element
- Sggss.eOSKa¥: selgct and use the current colors until iogl _I_sgvttlt']c;'s
off the MEGA STE (the next time you start the MEG Risdhe.
most recently Saved colors will appear), Cancel to exi inag
Colors and return to the Control Panel menu (no change

saved).

Color Setup

i i lution you
ding on your monitor type and the screen reso
E:\?: rs"elerg;]ted, up to 16 colors ?an display e;t i?)nl'?at\lfr:?:l iggl g;)gé .
. You can choose the colors you wis _ .
:CégfeﬂteYoi 4 096 available colors (except in ST High resolution,

which is monochrome only).
Color Setup allows you to choose which colors from the color

palette you wish to have available for use when you assign window
colors. See Window Colors.

Pen Number———=

p——RGB Color Tuning Scroll Bars
Pen Number Scroll Bar——

5

Bank Display Box
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Think of the 4,096 available colors as a collection of pens. The Pen
Display Box can display up to 16 pens at one time. The number of
pens displayed will be the same as the number of colors your
resolution is able to display on the screen at one time. The number
of pens that can display in your resolution at one time is your color
palette of pens.

Different inks will display in the Pen Display Box as you use the Pen
Number Scroll bar to scrol| through the different combinations of
pens. Each display will contain 2,4, or 16 pens, depending on the
number of colors your chosen resolution is able to display on the
screen.

Follow these steps to modify the pens in the displayed bank:

1.

Use the Pen Number Scroll bar to scroll through the available
pen collections (if applicable to the selected resolution). Display
the collection that contains the pens that most nearly matches
the pen colors you desire.

. Select the pen you wish to modify by: moving the pointer over

the desired pen and clicking the mouse button, or using the Pen
Number Scroll Box to display the number of the desired pen. A
black box outlines the pen selected for modification.

- Now use the RGB Color Tuning Scroll Bars to change the color

of the highlighted pen. Changing the ratio of Red, Green, and
Blue will change the color of the highlighted pen.

Repeat steps 3 and 4 for every pen to be modified.

- After you modify the displayed bank as desired, select Save to

permanently save the palette, OK to select and use the bank
until you switch off the MEGA STE (the next time you start the
MEGA STE the most recently Saved banks will appear), Cancel
to exit the Color Setup CPX and return to the Control Panel
menu (no changes are saved), or Reload to display the most
recently saved defaults. If you wish to return the banks to the
factory set defaults, press [cir Homel].

Note: You can restore the currently displayed collection of pens to
the condition it was in before you opened it. Simply press [UNDOI.
Use Reload to restore all pens.
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Configure CPXs

Configure CPXs allows you to change the name, choose the
displayed text and icon color, and change the RAM resident status

of CPXs.

Name Line
(= =]

GENERAL

Ram Resident Box

To configure a CPX. you must first display the name of the desired
CPX in the name line. Use the left and right scroll arrows to scroll
through the CPX list.

When the Configure CPXs window displays, the text insertion
cursor is already positioned at the end of the CPX Name line. To
change the name of the displayed CPX, press [Esc] to clear the
entire Name line, or press [Backspace] to erase one character at a
time. Then type in the new CPX name.

To select Text and icon colors, use the appropriate scroll arrows to
display the 16 different available colors. The name and icon dis-
played on the Name line will display the selected colors.

You can also set the RAM resident status of the selected CPX.
Position the pointer over the shaded RAM resident box and click
the mouse button. move the pointer to highlight the desired status.
Click the mouse button to save the highlighted selection.
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When the desired text/icon color selection displays, and th '
RAM resident status is selected, click on OK cﬁ Sya\'r:.n s

Note: RAM resident status takes effect only at start up fi
when you change resolutions. 4 p time and

General Setup

The General Setup CPX allows you to set the keyboard response
and repeat rate, the mouse double click response rate, and the
audio feedback. It also allows you to toggle on and off the CPU

Cache option and display system statistics such as :
number and amount of available RAM. L2 yersian

iew Opti
NTROL PANEL Tooo ]

Response Rate :

IS CPU Speed E@En%ﬂ'oub!e Click Speed Selector
. 16 HMHz Double
'

Click! s —Double Click Speed Test Box

STATUS

Select the Status box to display the TOS version numb
and the number of total bytes available. er and date,

AUDIO FEEDBACK

The computer has two kinds of audio feedback, a click signali
‘ . in
each keystroke and a bell signaling keyboard or mouse egrrors, ¥

To control audio feedback, select the keytop button or the bell
button. A gray image means that the sound has been turned off.
A clear image means that sound is turned on.
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SOUND

want all sound turned off, position the pointer over the Sound
gg)?.uCIick the mouse button. Move the pointer until the word Off

highlights, and click the mouse button again.

KEYBOARD RESPONSE

Every key on the computer keyboard responds when pressed, and
every key (except [Shift], [Control], [ESC], [CapsLock] and
[Alternate]) repeats its character if held down. The keyboard repeat
controls how much time it takes for the keys to repeat when they
are pressed, and how quickly they repeat after the repeat process
begins.

The upper slider controls how soon a key starts to repeat. Moving
the slider to the left makes the keys repeat sooner. Drag the slider
to the desired position, then release the left mouse button.

The lower slider controls the speed at which the keys repeat once
they start repeating. Move the slider to the left to make the keys
repeat faster. Drag the slider to the desired position, then release

the left mouse button.

Test the new settings by turning the sound on, if required, and
pressing [Space Barl. You will hear a click each time you press the
space bar. Listen to the clicks to judge the repetition speed of the

keyboard.

DOUBLE-CLICK RESPONSE

‘ You can adjust the MEGA STE's response to double clicking. To

\; slow the computer’s response to double-clicking, allowing you to
double-click more slowly, select a numbered box nearer to the
resting mouse icon. To quicken the computer’s response to double-
clicking (for fast double-clicks), select a numbered box nearer to the

running mouse icon.

After setting the double-click response, you can test the setting by
double-clicking on the Double-Click Response Test box. When you
double-click at the set rate or faster, the box will briefly highlight.
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Modem Setup

The ports labeled Modem on the back of the computer are RS232
serial ports. By connecting a modem to the computer, you can
communicate with other computers. You can also connect a serial
printer or any other RS232 device to the modem ports.

The Modem Setup CPX lets you configure the computer's modem
ports to work with your modem or other serial device. Refer to the
manual supplied with your peripheral for specific information on
which parameters to choose. The parameters needed by the com-
puter with which you are communicating (the remote device) is
known as the communications protocol.

SERIAL PORT SELECTOR

The Serial Port Selector allows you to tell the computer which of
the available serial ports to recognize as active. Select the port you
are using for the connected modem.

BAUD RATE

Baud rate is the speed at which data is transmitted. Baud, the stan-
dard unit measure of transmission speed., is the number of signal
elements per second. The fastest rate available to youis 19,200
baud; the slowest is 50 baud. Set the baud rate to accommodate
both your modem and the remote computer’s modem. (The baud
rate for bulletin board systems is usually listed along with the phone
number for the board.)

To set the baud rate, position the pointer over the Baud Rate box.
Click once. Use the up and down arrows to scroll through the baud
rate selections. When the desired baud rate displays, move the
cursor to highlight the desired rate. Click the mouse button to select
the highlighted rate.
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PARITY

i telephone lines, there
uters transmit data through
i\‘;!zec%eavr?crecfhn;?some of the _inf_ornp]atllpn Wllébﬁffgz %?:g:efhgglfing
i ions and noise within the lines. Pa '
::c;c;?gc:?ljlzclthat computers use to examine m_ftorgnatlon and
determine whether data was cleanly transmitted.

i the total number
ity bit is added to a group of bits to make identi-
;rfh gitgatrrg):-nsbriilt?ead odd or even. Transmission errors ;:ahnﬂtzz Ipdaerrl-?slr
fied when the number of bits in a group does not ma 3 the remote
chosen (odd or even). Dg:ﬁencl\ijlggeorggg rg?gsgnn?jr;rity (Refer to
i i se either ; ' eh b
ol st Yo meder o e Foraton

i iti i ded Parity box.
osition the pointer over the sha ] /
-I(;ﬁcskectart:;:pﬁggihpe cursor to highlight the desired parity. Click the
mouse button to select the highlighted option.

BITS/ICHAR

i lly a byte is
is stored in memory as one byte. Usua
Enaacdhecnj]; Ene;cet?g;f:?bsits. Depending ﬂn bits tFI'J_]BI' g!&gg:}e{;f%si{esdptg the
device, you may need to change the
E:?]?P;gter whenytransmittlng through the RS232 port.

iti i ded Bits/Char
i r, position the pointer over the sha
goxseéﬁtc'lke g;ztgfecfhljsepthe cursor to highlight the deswﬁd ir.:_urtrgltizue‘-r]tgfd
bﬁs'per character. Click the mouse button to select the highlig

option.

STOP BITS

it indi hronous RS-232 char-
t indicates the end of an async
lgtirs.t?’%t?iwill normally use 1 stop bit, but you may need to use

1.5 or 2 stop bits.

To set the number of stop bits, position the pointer over the shaded

Stop Bits box. Click once. Use the cursor to highlight the desired

number of stop bits. Click the mouse button to select the highlighted

option.
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FLOW CONTROL

You can choose between two flow-control protocols: Xon/Xoff, and
Rts/Cts. Flow control protocols are procedures that allow your com-
puter and the remote device to signal one another when to start or

stop sending information. Choose the flow control supported by the
remote modem.

To select a Flow Control protocol, position the pointer over the
shaded Flow Control box. Click once. Use the cursor to highlight the

desired flow control protocol. Click the mouse button to select the
highlighted option.

Printer Setup

Any program may access the printer configurations set by the
Printer Setup CPX. For example, the Print Screen option under the
Options menu uses the printer setup information. Other utilities or
applications may not. Check the manuals supplied with your
programs to see if a program can use the printer setup information.

o Note: You cannot configure an Atari SLM laser printer with the

Install Printer dialog box. Instead, refer to the Atari SLM Printer
Emulator User’s Manual (supplied with the SLM laser printer) for
instructions on changing printer settings. If you have both an SLM
and dot-matrix or daisy wheel printer connected to your computer
you may be able to select the printer type within your application. If
not, you must turn off one of the printer driver programs.

To configure your printer, display the Printer Setup CPX window.
Position your pointer over the shaded box representing the setting
you wish to change. Click the mouse button. Move the pointer over
the desired setting. When the setting highlights, click the mouse
button to select the highlighted setting.

PRINTER TYPE

The choices are Dot (dot matrix printers) and Daisy (daisy wheel
printers). Select the appropriate box for your printer.
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COLOR

The choices are B/W (black and white, or monochrome) and Color.
Select the appropriate box for your printer.

PIXELS/LINE

i i i i i ion. Pixel

ix graphics printers use the Pixels/Line option.
?nglgniogiQS:; elgempent‘ On dot matrix printers, a pixel is a dot. _Dtc:t
matrix printers print a certain number of pixels per line whﬁn Erln
ing in graphics mode. If you have an Atari dot matrix grap lct:ible .
printer, select 1280. If you have an Epson, or Epson-compa e
matrix graphics printer, select 860. Both values assume an eig
inch printed line.

QUALITY

ix pri ' [ t Draft for
matrix printers use the Quality option. Selec :
dorzlf{—gﬂtality prin?ing. Select Final for letter or near-letter quality

printing.

[ f the print head
de, the printer may make only one pass of the _
wh[g;agrmtci)ng. For Earker printing, select Final. Keep in mmdft?ﬁt in
Final draft mode the printer will generally make two passes of the
print head, thus taking twice as long to print the page.

Note: Do not select Final if your printer does not support near-letter
quality printing.

PAPER

i ’ f a tractor or
rinter feeds paper automatically by means o
girﬁgiir-sheet feeder, select Feed. If youlq prlnﬁe;?g?ﬁags grr'lqg g;l‘;:t
at a time which you must insert manually, sele ;
option prevents the printer from printing beyond the end of a page
on documents longer than a single sheet.
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PORT

If you have a parallel printer, select Printer. Parallel printers connect
to the port marked Printer on the back of the computer. If you use

a serial printer, select Modem. Serial printers connect to the port
marked Modem (the RS232 port) on the back of the computer.

0 Note: For most serial printers, Xon/Xoff flow control is set to On.
This setting enables the printer to signal the computer to tempo-
rarily stop sending data so it can print data it has already recejved.
(See Rs232 Configuration earlier in this chapter.)

Sound Setup

The Sound Setup CPX allows you to adjust the balance, volume,
bass, and treble stereo sound output. To generate a tone to test the

current sound settings, position the pointer over the face icon and
click the mouse button.

All Sound Setup settings can be adjusted in two ways. You can use
the scroll arrows to scroll through every possible setting, or you can
click on and drag the scroll box from one setting to another.

The Balance setting determines the strength of the audio signal
sent through both the right and left speakers. You can adjust for an
even balance, or send a stronger signal through the right or |eft
speaker. You can use the Bass and Treble settings to adjust the

strength of low and high register tones, respectively. The Volume
setting adjusts the volume of sound.

When the setting highlights, click the mouse button to select the
highlighted setting.

Accelerator

The Accelerator CPX allows you to adjust the speed at which the

onscreen cursor responds to the movement of your mouse. The
Accelerator also contains a screen saver.
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Mouse Accelerator

Fast
Off
Screen Saver Delay Slider

Screen Saver Box

Maodem Recognition

[ Save ||| OK || Cancel |

There are three Mouse Accelerator settings: Off, Fast, and Super
Fast. Choose the Off setting if you do not wish to increase the
response speed of the cursor. Select Fast or Super Fast to increase
the cursor response speed.

To select a new cursor response speed, position the pointer over
the desired setting and click the mouse button.

The Screen Saver will automatically darken the screen after a set
period of inactivity. To activate the Screen Saver, select the Screen
Saver box. When the Screen Saver is active, the Screen Saver
Delay slider and the Modem Recognition icon appear as solid
objects on the screen. When the Screen Saver is inactive, the
Screen Saver Delay slider and the Modem Recognition icon appear
as outlines.

When the Screen Saver is active, it will automatically darken the
screen after a period of mouse and keyboard inactivity. You can set
the number of minutes of inactivity in two ways. You can use the
clock icons on either side of the Screen Saver Delay slider as scroll
arrows, or you can drag the scroll bar. Release the mouse button
when the desired number displays in the scroll bar.

Modem Recognition allows you to choose whether or not you want
the Screen Saver to recognize modem activity. |f the Modem
Recognition is on, the Screen Saver will recognize any modem
activity and will not activate. If the Modem Recognition is off, the
Screen Saver will ignore modem activity and will activate after the
set delay period of keyboard and mouse activity has passed.
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APPENDIX A
MEGA STe PANELS AND PORTS

Back Panel Ports
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APPENDIX B
POINTER CONTROL
‘ QUICK REFERENCE

, The following table lists mouse functions and keystroke
' combinations. You may copy this page and post it near your
computer for quick reference.

Action Mouse Function Keystrokes
Move pointer. Roll mouse in desired [Alternate] any arrow -
direction. key moves pointer eight
pixels in the direction of
the arrow.

[Alternate] [Shifi] any
arrow key moves pointer
one pixel in the direction

of the arrow.

Select item. Position pointer on item. Position pointer on an item.
Click left mouse button, Press [Alternate] [insert].

Select and Position pointer on item. Position pointer on an item.

open item. Double-click left mouse Press [Alternate] [insert]

: button. twice.

Drag item. Select item. Hold down Position pointer on an item.
left mouse button. Rol| Hold down the [Alternate]
mouse in desired [Insert] keys and use arrow

| direction. keys to move the item.

Right Click right mouse [Alternate] [CIr Home].

| button button.
| functions.

Pointer Control Quick Reference
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APPENDIX C
ADVANCED HARD DISK UTILITIES

This appendix contains information about the Atari Advanced Hard
Disk Ultilities disk. This disk contains programs and files that allow
you to:

e Park and Unpark the read/write heads

« Install or remove the hard disk driver file
» Format and partition the hard disk

» Erase the contents of a logical drive

* Extend the system-wide folder limit

« Mark bad sectors

e Create an Extended Partition Scheme

You will not use these programs as part of the hard disk’s daily
operation. Instead, the programs allow you to start the drive for the
first time, perform functions that are required from time to time, or
maximize your use of the hard disk drive. This chapter will help you
choose the programs and utilities you need.

PARKING AND UNPARKING
THE READ/WRITE HEADS

Whenever you move your computer, you should park the hard drive
heads to prevent damage to the hard disk and the data it contains.
Parking the hard disk drive heads moves the read/write heads of
the drive away from the disk media. Parked heads cannot damage
the disk media during moving or shipping. The Atari Advanced
Hard Disk Ultilities include two types of head parking programs. One
type parks the disk heads of all hard drives connected to your
system. The other parks the disk heads of individual units.

@ Warning: If you fail to close all hard disk windows before parking

the drive heads you may damage data on your hard disk.

Advanced Hard Disk Utilities



Parking Drive Heads on all Units
To park the hard disk drive heads on all hard disks connected to
your system, run SHIP.PRG. You must run this program from a
floppy disk in drive A or B.

) Note: SHIP PRG will not park the heads of a Megafile 44
Removable Hard Disk Drive.

With a directory of the Atari Advanced Hard Disk Utilities disk
displaying, follow these instructions to run SHIP.PRG.

1. Open the HDX folder.
2. Close all other open windows.
3. Run SHIP.PRG.

4. Switch off your hard disk units as soon as the desktop appears.

Parking Drive Heads on Selected Units

To park a specific hard drive, you must select a physical unit to be
parked. With your hard disk utilities disk in drive A or B, follow these
instructions to park the heads on individual physical units:

1. Run the HDX program.

2. Close all other open windows.

3. Select the Ship option on the Disk menu.

4

. When the Select physical unit(s) dialog box appears, select the
physical units that are to have their heads parked. Select OK.

0 Note: You can select any physical unit connected to your

system (formatted or not). The unit number boxes of connected
devices appear shadowed.

Advanced Hard Disk Utilities
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5. An alert box message appears on screen offeri
ing you a
chance to cancel the head parking procedure. = las}

Select OK to park the heads.

6. Qi;il?al alert box appears, instructing you to turn off your hard

Select OK and switch off the power to your disk drive(s).
Note: If you are preparing to move your entire syst i
o your computer at this time. i HEemmadianan

Unparking the Drive Heads

The next time you start your system the drive
automatically unparked. y heads are

INSTALLING AND REMOVING
THE HARD DISK DRIVER FILE

The HINSTALL.PRG program installs or removes the hard disk

driver file. The hard disk driver allows you t
el you to start your system from

Installing the Hard Disk Driver

Display the directory of the HINSTALL fol
install the hard disk driver: SR SIRpRiio

1. Run HINSTALL.PRG.
2. Select Install from the File menu.

3. Select a logical drive for the operation. You can only s
_ (  the ’ elect
logical drives that are highlighted in shadowed boxgs. Select OK.

4. From the displayed dialog box, select OK to in '
Cancel to abort the operation. Stall theidriver, or

Advanced Hard Disk Ulilities
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Removing the Hard Disk Driver

Display the directory of the HINSTALL folder. Follow these steps to
remove the hard disk driver:

1. Run HINSTALL.PRG.
2. Select Remove from the File menu.

3. Select a logical drive for the operation. You can only select
logical drives that are highlighted in shadowed boxes. Select OK.

4 From the displayed dialog box, select OK to install the driver, or
Cancel to abort the operation.

Bypassing the Hard Disk Driver

As an alternative to removing the hard disk driver, you can simply
bypass the driver. To do so, switch off your computer (or perform a
keyboard coldboot) and make sure there is a floppy disk in drive A
that does not contain a hard disk driver file. Switch on the system.
The drive light comes on, and then goes off. Immediately hold down
[Alternate]. Release [Alternate] when the floppy drive’s busy light
goes back on.

FORMATTING AND PARTITIONING
THE HARD DISK

@ Warning: The HDX Format and Partition options described in this
chapter completely erase all data on your hard disk. Back up all of

your valuable files before proceeding.

Formatting

You will probably never have to re-format your hard disk. The hard
disk has already been formatted at the factory. Formatting the hard
disk creates magnetic patterns called tracks and sectors. The
process also marks and logs bad sectors, areas on the disk with
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surface damage or other imperfections. Data stored in th
r : ese are
could be corrupted or lost. During hard disk operations, the com-as
g:_ater avmids setitors marlreg and logged as bad. The formatting
ocess also automatically divides the hard disk into st
called partitions or logical drives. S e

The internal hard disk drive is already formatted. Formatti

: , . : tti
all information from a disk and prepares the disk to ac:cep:1 cgia?;iilses
You may need to format the hard disk if the factory format becomes
erased due to mishandling or if the hard disk develops bad sectors.

Display the directory the HDX folder. Foll i i
b BV Ie Shedle ollow these instructions to

1. I_Snilr?gt HDX.PRG. Then select the Format option from the Disk

2. Read the alert message that appears on screen. If nec
back up all your data before proceeding. B

Select OK to continue.

3. Select a physical unit (hard disk drive) for formattin
formatting only the internal hard disk, select UNIT Ogblyyyoouuaarree
formatting an additional hard disk, select a unit that corresponds
o the pard disk’s DIP switch settings. (See your hard disk drive
owner's manual for information about DIP switch settings.) Units
Lr;gtr:%jowed boxes are the units that are connected to your

M Select The Physical Unit

L& [

Select OK to continue. A dialog box may a . ) )
of hard disk unit types. Y appear, displaying a list
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C-5




4. Select the hard disk type showing your drive's model name.

Select the unit type:
[HEGAFILE 68] [MEGAFILE 44] [MEGAFILE 38]
[HEGAFILE z8][ SH285 ][ SH204 |

o] [EAwee]

Select OK to continue.

5. Read the alert message that appears on screen.

Select OK to format the unit. A message appears informing you

that formatting is in progress.

Note: When the partitioning message disappears, the formatting
operation is complete.

ing i ’ tomatically
ormatting is complete, the Format option au
m{;gtnei. the Marglltbad and Partitioning options. To find out more

about these functions, refer to the sections on Marking Bad Sectors

and Partitioning.

The default partition quantity and size is determined by the hard
disk drive model.

Partitioning

TE's internal hard disk drive is already partitioned.
ggﬁilt\foaﬁg 2 hard disk is a process that divides the hdlsk Inlt_]c(): L
sections. Setting a partition size tells the hard drive how n?he
storage capacity to assign to each partition. You can useacit o
factory-set partition capacities or change the stctj:rage capacity
each partition to suit your file organization needs.

Advanced Hard Disk Utilities
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Partitioning divides your physical hard disk into data storage
areas called logical drives. Each logical drive is pre-installed and
will automatically appear on your desktop unless you re-partition
the disk. Partitioning allows you to store and access your data

efficiently by allowing you to group files and folders in different
logical drives.

Use the Partition option to create partitions in sizes best suited to
your disk storage needs. The Partition option lets you use an
editing menu to set the size of each partition or select a sug-
gested partitioning scheme without having to reformat your disk.

Note: When you repartition your hard disk, you must use the
Install Devices command to install desktop icons for the logical
drives.

Selecting a Unit to Partition

Display a directory the HDX folder. Follow these instructions to
partition a hard disk:

1. Select HDX.PRG from the HDX folder. Then select the Partition
option from the Disk menu.

2. Select a physical unit for partitioning. To partition your hard disk,
select the unit number of the device you want to partition. Only
units in shadowed boxes can be selected.

Select OK to continue.
3. Select a partitioning scheme.

There are two ways to select a partitioning scheme. You can use
the Choose a Partition Scheme dialog box to choose from preset
partitioning schemes. Or you can use the Edit Partition Scheme
dialog box to create a customized partitioning scheme. The follow-
ing sections fully describe each method.

Advanced Hard Disk Utilities
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Selecting a Partitioning Scheme

After you select a physical unit for partitioning, the Edit Partition
Scheme dialog box displays.

Use the Edit Partition Scheme dialog box to create a customized
partitioning scheme. If you wish to select a preset partitioning
scheme, click on Menu to display the Choose a Partition Scheme

dialog box.

From the Choose a Partition Scheme dialog box you can click on
the Edit box to return to the Edit Partition Scheme dialog box.

Creating a Customized Partitioning Scheme

The Edit Partition Scheme dialog box displays information about the
selected unit's current partition scheme.

Total # of Partition(s): 4
Hemory Left: OMb
# ||

[© MEU][UNDO ][ oK ][CANCEL

Information lines appear at the top of the dialog box. The Total line
displays the current total number of partitions. The Left line displays
the number of megabytes on your disk that have not yet been

assigned to any partition.

Each partition’s size is displayed to the right of the partition number
in the edit box. Minimum partition size is 1 megabyte. Maximum
partition size is determined by the capacity of your hard disk. You
can allocate all of the memory on your hard disk to one partition.
For example, a 40 megabyte hard disk can have a single partition

containing all 40 megabytes of memory.
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Use the scroll bar to scroll through iti i

Al ; partition boxes. To view the 28
partitions you can click on the shaded ar f

through four partitions at a time. s ol banta.acroll

Click on the partition box you wish to create i i
_ or edit. Then click
itrt:grggsaengr cclj%vcwr'mearrcws tﬁ_the right of the partition size box to -
ase partition size. Clicki
i licking on an Unused box

Note: There must be available bytes listed i

_ ) on the Left
%:JL:JStcan increase the size of any partition. 1 megabyte Ici??n%?éore
activa?gg.ear in the Left box before an unused partition can be

To return to the most recent partition scheme. select Undo.
OK initiates the partitioning process.
If you want to return to the HDX.PRG main menu, select Undo.

The Expert option is shaded and cannot be selected u

have‘ more than four partitions. You need to use the EE;I)E;? c:;‘:t'ijon
only if you plan to use more than one operating system. If you are
planning to use more than one operating system with the same
hard disk, see Appendix E, Extended Partition Schemes.

Selecting a Preset Partitioning Scheme

The Choose a Partition Scheme dialo
. g box appea
select Menu from the Edit Partition Scheme d?a?logrgxr.]en e

Choose a partition scheme;
ME-11-11-11 [13-13-9-9 | [15-15-7-7
(1537

| [Edit 5]
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iti i ides a list of
Partition Scheme dialog box provi
;‘Sg?gggt%célsga?ﬁtioning schemes. Select thelsfchem% you \ggr;t from
the list. Select Edit to return to the Edit Partition Scheme :

After you select a partitioning scheme, select OK to partition the
disk.

ERASING THE CONTENTS
OF A LOGICAL DRIVE

from a selected logical drive with the Zero
th?oimagf ?rr\aesﬁsl)l(%ar?gram. Erasing (or zeroing) a logical %r;\{ae é;sr "
useful if you want to clear the drive to make _roci:rgt for a?tvr\:out
you want to erase damaged data from a logica £ nkve
reformatting (and thus erasing) the entire hard disk.

Display a directory of the HDX folder. Follow these steps to erase
the contents of a logical drive.

1. Select HDX.PRG. Then select the Zero option from the Disk
menu.

2 Read the alert box that appears on screen. Select OK to
continue.

3. Select a drive for zeroing from the Select the Logical Drive
. dialog box. Select OK to continue.

4. An alert box appears giving you a final chance to quit the
- program before proceeding.

Select OK to continue.

Advanced Hard Disk Utilities
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EXTENDING THE SYSTEM
WIDE FOLDER LIMIT

You can run FOLDER100.PRG to extend the number of folders
your system recognizes. Though most users will be able to create
as many folders as they wish without problems, you can still use
FOLDR100.PRG to extend the folder limit even further.

To use this program, display the AUTO folder directory on drive
C containing the FOLDR100.PRG file. Then change the 100 in
the filename to any value between 001 and 999 using the Show
Info option from the File menu. The value you enter is the number
of folders beyond 40 you can now access. For example, to
extend the limit to 240 folders, you would change the filename

to FOLDR240.PRG.

The FOLDR program must be stored in the AUTO folder of the
startup disk (partition C on the hard disk if physical unit 0 is the
startup disk).

The new folder limit takes effect when you reboot your system.
During the boot procedure, a message appears that shows how
many extra folders you have designated and how many bytes of

RAM are allocated to the extra folders. Each folder uses 132 bytes
of RAM.

MARKING BAD SECTORS

Error messages stating that the data on your disk may be damaged
might indicate the presence of bad sectors on your disk. If such
error messages frequently appear, you should check your hard disk
for bad sectors. This process identifies and flags defective areas on
the hard disk. Hard disks may develop defective spots after the
drive has been in use. Once these spots have been logged with
Markbad, they will not be used for your hard disk operations.

The Atari Advanced Hard Disk Utilities disk includes two versions of
Markbad. One version is run automatically during the HDX Format
option. This version operates on the entire selected physical unit
and erases all data on the disk during formatting. The other version
operates on the selected logical drive when you run the HDX

Advanced Hard Disk Utilities
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Markbad option. This version helps you preserve data by letting you
decide whether or not to erase data containing bad sectors.

Both versions of Markbad display a log of any bad sectors found.
The cumulative tally of bad sectors in the log appears during
subsequent Markbad operations.

Note: You can use the HDX Markbad option on hard disks
formatted with a previous version of HDX.

Display the directory of the HDX f‘older. Follow these steps to mark
bad sectors on selected logical drives:

1. Select HDX.PRG. Then select the Markbad option from the Disk
menu.

2 Select a logical drive from the Select the Logical Drive dialog
box.

Select the logical drive
| TR - {7
T | O T e 5 | S T
| [ 7l | BT [ ==l i

Select OK to continue.

3. While Markbad scans the logical drive for bad sectors, a
message appears telling you that the program is marking bad
sectors. |f bad sectors are found in a file, select a course of
action for the file from the Logical Drive Markbad dialog box.
This box displays the name of the file, the address location of the
bad sector and cluster in the logical drive, and your choices for a

course of action.

Note: The Logical Drive Markbad dialog appears only when
Markbad flags bad sectors in allocated clusters. An allocated cluster

is a cluster that has been assigned to a file.

Advanced Hard Disk Utilities
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/M Logical Drive Markbad /A
File
E:\SAMPLE, DOC

Bad sector: 627.
Cluster: 266.

| Delete file |

Skip over bad sector
[ Tgnore bad sector |

Select Delete File to erase the file or Ski
_ p Over Bad Sect
greserve the undamaged portions of the file. Select IgnorgrEt’.gd
ector to leave the file unchanged. (Select Ignore Bad Sector if
you want to examine the file before taking action.)

If bad sectors are found in a subdirectory fi

. ‘ y file, selecta c
action for the subdirectory from the Logical Drive Markboa%r?aig :
This box displays the name of the subdirectory, its address loca-
tion, and your choices for a course of action.

Select Delete Directory Only to delete the direc

save the deleted directory files to the root directtgg %qufltgsre s
§aved_lto the root directory will be named "TMPnnnn" where
nnnn" stands for the starting hexadecimal cluster address of the
file. Select Delete Directory And Files to delete the directory

structure and all of its files. Select Ignore B - ,
want to take any action at all. . Sd:SeRonikyauTdontt

0 Note: If a bad sector is found in a lost clust
b | er, an alert box
gﬂ;?;rs giving you tth? ct'i)ptlczl';1«:}f marking the cluster. A lost
( Is a segment of data that is unaccoun
inaccessible to the system. iRdieranY

5. When Markbad finishes scanning the disk, a Logi i
. ; ogical D
Markbad tally box with the total count of newly f%und bral\éesectors
and the count of all previously found bad sectors appears.

Advanced Hard Disk Utilities
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ORGANIZING AND MAINTAINING %?gu%%ey%‘utpitg?gi hlard disk optimizer programs available
YOUR HARD DISK I St aler or Atari user groups (see Customer
The larger storage capacity of a hard disk means that careful folder
and file organization is more important than ever. When planning EXTENDED PART|T|ON SCHEMES
and using your folder structure, keep the following tips in mind. A
reating an extended partition i ;
« Use folder names that describe the types of files in the folders. users. You will probabl?; never rs]gggrpoedssea Th?m'o’t'.‘ for advanced
Keep files organized in folders so you can easily find them. operation of your computer. = aplion In-thei normal
« Keep as few files as possible in the root directory. Thete are fo
_ e four slots on your hard di o
« Keep the files you use most often in the first level of directories. ;_I;ﬂormatron‘ You can fitlyeach slgt gﬁi}; ?zzakrfc?aﬁctir;a:)g:tﬁifo%agmgn
; ! iti ,an
« Delete unneeded files to free up disk space for new files. O?Vyeos%%Taaﬁlrgt:]%noﬁ?gfs:&tesf o e desktop by a logical drive.
obtain more than four logical drﬁss\.ml an extended partition to
- . |
Backing Up the Hard Disk . An extended partiion is subdivided info more than one partion
hatalot ve more than one logical drive representing

It is important to frequently back up your hard disk data. Other-

As a general rule, it is good practice to back up new or modified standard partit
As a general ule, itis good practice o b _ anaard partition. This partition is always ass; i

' | ¥ou cannot select the first slot to contai% the é?{?:r?dzaodth: ?'rl’St o
To back up your data, regularly copy important files or folders onto ctendad pariinae, O e three remaining siots to cont nyour
floppy disks and store them in a safe place. In addition to the copy =SSR, o
option, you can use one of the many hard disk backup p{rograms Supporting TO
available through your Atari dealer or Atari user groups (see porting TOS as your primary operati :
availabie through y automatically choose slot numbzzr tI\J/vc: atgnc%fnﬁfr;dubr{%?tﬁnzadm“

partition. However, if you plan to use more than one operatir?g

system, it may be useful to choose the specifi
. K assi L pecifics of the partitio
Optimizer Programs eifé%'&?c??gfﬁsngﬂq§c%%?122t'r}9h§ys‘e{¥-‘°‘ will not recognize an
- : partitions you use with th

s : operat s ese
An optimizer program checks the structure of your hard disk and perating systems must be standard partitions.
rearranges files and free space on the disk. The multiple sectors of The Ex ; . i,
each file are grouped together. Contiguous free space is placed you to gf‘?cﬁ)gept\lh?f:]icor: :‘,Tc?t IE\.rci’ll|t CF;?::”-'O” Scheme dialog box allows
either at the top of the disk (to increase the speed of writing new which of four slots will : ain the extended partition, and
files to the disk) or at the bottom of the disk (to increase the speed contain standard partitions.

of accessing existing files). Back up your data, then use a file The Select the extended partition scheme dialog box displ
X displays the

optimizer program regularly to increase the speed and efficiency of : current oo al
your hard disk drive and to reduce the possibility of data corruption side.of tﬁ:tg?ggg Eg;t’gﬁgvf:rt‘ﬁ;n;érmgnP:Ltlfign section on the left
7 mber, s
of each partiion. The Extended Parttion Range dialog box o tog

and loss.
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right side of the dialog box allows you to choose which slot will APPENDIX D

contain the extended partition scheme. TR OUBLESHOOTlNG AND
The Extended Partition Range dialog box displays each slot's range PREVENTIVE MA'NTENANCE

of partitions.

In the example below, all four slots contain partition information. TROUBLESHOOTING

The first slot contains partition one. The second slot contains the

extended partition, which is subdivided as partitions two through bt il eablams bl EomeRin g An e ST ating st coT
eight. The partitions included in the extended partition are always Ditar Tt Subios Y Br o prebably Ty FooLraat Th o
highlighted. The third slot includes partition nine, and the fourth slot S oy o e il st Bl st
contains partition ten. Slots one, three and four contain standard

partitions. Note: The most common and easily fixed problem is failure to

switch on the power to the computer or the monitor. Always check
this first before exploring other possibilities.

Partition  Extended Partition Range

It Will Not Switch On

i poh
#7._ :
:;,_ 12232 If the power light will not come on or the video display stays dark--
4 X the remedy is easy. Follow these steps:
¢ fron #4 to 1D

1. Sv_vitch off all components in your system (the computer, external
drives, the monitor, and all other peripherals).

1Mb
W 'ﬁ]ﬁ' fe_EbxT) [k ] [CAReEL]
2. Make sure all cables are correctly and securely fastened. Check
the power cables and the video cable.

OTHER ADVANCED HARD DISK 3. grhgggnyaont.::rewall socket or power strip by plugging in a desk lamp
UTILITIES DISK FILES :

« HDX.RSC is 2 GEM resource file used by HDX.PRG

4. Switch on all components.

5. Check the brightness and contrast adjustments on your monitor

« WINCAP is a text file that includes information used by or TV. Turn up the adjustment knobs if necessary.
HDX .PRG.

« HINSTALL.RSC is a GEM resource file used by
HINSTALL.PRG. No Desktop

o SHDRIVER.RAW is used with HINSTALL.PRG to create If the power lights come on, the monitor brightens, and the busy
SHDRIVER.SYS, the hard disk driver file that directs your lighite tor the inferal {Ba0Y a1 Rafd dives Busy iiohs light up. but
system to start from a hard disk. the desktop does not display, you may have a bad desk accessory

file in your startup disk or folder.

Advanced Hard Disk Ulilities Troubleshooting and Ere;ventive Maintenance
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With the computer switched off, place a disk in floppy drive A (do
not use the Advanced Hard Disk Utilities disk). Switch on your
system. (If you need to bypass an installed hard disk driver, hold
down [Alternate] when drive A's busy light comes on. Release the
key when the busy light shuts off.) The basic desktop displays.

Next, remove the disk from drive A. If the questionable desk acces-
sory resides on a floppy startup disk, insert the floppy disk into drive
A. Remove the file from the disk. If the questionable desk accessory
resides in the root directory of your hard disk, remove the file from
drive C.

Switch off your computer and restart in your usual way.

Software Problems

If you have problems with an application, it may be that the soft-
ware contains imperfections (bugs). Try coldstarting your system,
then switch it on again. Reopen the application. If this helps, it may
mean the application experienced a momentary failure.

If you still experience problems, make a new working copy of the
application from the original application disk onto a newly formatted
floppy disk. Run the application from the new copy. If you are
running the application from your hard disk, remove the file from the
hard disk and copy it again from the original application disk back
onto the hard disk. If this works, the problem is probably with the
original working copy of the file. If none of your disks work properly,
you may need to replace your original application disk.

You may find that some older programs do not run properly with the
BLITTER option turned on. If you think this may be the problem,
make sure the BLiTTER option is off before running the program.

Bombs @

Sometimes applications develop errors that are potentially damag-
ing to the computer’s operating system. When such an error occurs,
TOS detects the error and terminates the program. As a signal to
you, TOS displays one or more bombs across the screen and
attempts to recover from the error.

Troubleshooting and Preventive Maintenance

To protect the computer’s operating system, immediately perform a
keyboard coldboot when you see bombs displayed. If the problem
recurs, discontinue using the program.

The Hard Disk Drive

Some symptoms identify the hard disk drive as the source of
the problem. Many problems can be easily remedied using the
Advanced Hard Disk Drive utilities.

Common Problems

Use the following table to identify and correct common hard disk
drive problems.

Problem Suggested Solution

Hard disk drive icon C does If you are starting your system from a
not appear when you switch floppy disk drive, make sure the startup
on your system. disk contains AHDI.PRG in the AUTO

folder. If you are starting your system from
the hard disk, AHDI.PRG must be in the
AUTO folder on drive C. If you have
AHDI.PRG in the proper folder and the
system still does not display disk icon C,
you may need to reformat the drive. (See
Formatting in Appendix C.)

The system will not start Run the hard disk driver installation

from the hard disk. program (HINSTALL.PRG.) If the
problem continues, the hard disk should
be backed up and reformatted. (See
Backing Up the Hard Disk and
Formatting in Appendix C.)

An application program The program contains garbled data or
will not start from the was not designed to start from a hard
hard disk. disk. Try starting your system from the

floppy disk drive with a working copy of the
program. Attempt to run the program from
the program disk. If it still will not run,
contact the program’'s manufacturer for
more information.

Troubleshooting and Preventive Maintenance
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Identifying and Replacing or Erasing Corrupted Data

If you still have problems, your hard disk may have developed
unusable data. Unusable data appears altered or is unusable. Try
erasing individual bad files and replacing them with valid backups. If
replacement is not possible, follow these steps to try and recover

data:

1. Run the Markbad option of the HDX program on the Atari
Advanced Hard Disk Ultilities disk (as described in Marking Bad
Sectors in Appendix C) in each logical drive containing
unreadable data. Recover as much data as possible.

2. Back up the data recovered from the logical drive onto floppy
disks.

3. Erase all data in the problem logical drive(s) with the Zero option
of the HDX program and run Markbad on the logical drive again.

4. Copy the data you backed up on to the logical drive.

If the main drive (drive C) contains unreadable data, you may not
be able to start your system from the hard disk. Use a working copy
of the Atari Advanced Hard Disk Utilities as a floppy startup disk to
start the system. Follow the steps above, then install the hard disk
driver as described in this appendix.

Error Messages

If an error message appears while you run one of the Atari
programs from the Atari Advanced Hard Disk Ultilities disk, the
problem is usually something easily remedied. If you aren't sure
what to do when an error message appears, read the message
carefully for a suggested solution. If there is no suggested solution,
find the message in the alphabetical list below and try the solution

suggested.
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Error
Message

Bad Sector List is corrupted!
Try backing up the disk
anlg]reformaning it.

Cannot create driver
file at destination!
[OK]

Cannot find format
parameters for disk type
<disk type name>

[OK]

Cannot find partition scheme
<selected partition scheme>
[OK]

Cannot format
<selected unit>!
Try checking all the
connections and
reformatting.

[OK]

Cannot open driver
source file!
[OK]

Cannot partition
<selected unit>!
Try reformatting.
[OK]

Program
andl/or
Option

HDX
Format
Partition
Zero
Markbad

HINSTALL
Install

HDX

HDX
Partition

HDX
Format

HINSTALL
Install

HDX
Partition

Suggested
Solution

See message.

Your root directory may be full.
You need to delete data to
make room for the driver file.
Or, your root directory may be
corrupted. If so, back up as
much data as you can and
reformat the drive.

Make sure the original
WINCAP file is on the disk
with HDX.

This partition scheme is not
recognized by HDX. Make
sure you are using your
original WINCAP file.
Warning: Do not modify the
WINCAP file. Doing so may
destroy the disk.

Make sure your hard disk is
securely connected as
explained in Chapter 1.
Then reformat the drive.

Make sure the
SHDRIVER.RAW file is
on the disk with
HINSTALL.PRG.

See message.

Troubleshooting and Preventive Maintenance
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Error
Message

Cannot read Bad Sector
List from the disk!

Try backing up the disk
and reformatting.

[OK]

Cannot read Boot Sector
from the logical drivel
Try backing up the disk
and reformatting.

[OK]

Cannot read File Allocation
Table from the logical drive!
Try backing up the disk and
reformatting.

[OK]

Cannot read from directory!
Try re-running Markbad on
this logical drive when the

current Markbad is completed.

[OK]

Cannot read Root Directory
entries from the logical drive!
Try backing up the disk and
reformatting.

[OK]

Cannot read Root Sector
from the disk!

Try backing up the disk
and reformatting.

[OK]

Cannot save any more
files in the root directory!
Deleting the remaining lost
clusters of the subdirectory
will free up disk space.
[OK] [CANCEL]

Program
andlor
Option

HDX
Format
Partition
Zero
Markbad

HDX

Zero
Markbad
HINSTALL
Install

HDX
Partition
Zero
Markbad

HDX
Markbad

HDX
Markbad

HDX
Partition
HINSTALL
Install
Remove

* HDX

Markbad

Suggested
Solution

See message.

See message.

See message.

See message.

See message.

See message.

When the Markbad option
found a bad sector in a sub-
directory, you directed the pro-
gram to save the deleted direc-
ory’'s files to the root directory.
here is no more room in the
root directory for the files.
Either select OK to delete the
rest of the directory’s files or
select CANCEL to use a disk
utility that can recover the
directory's files.
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Program
Error and/or Suggested
Message Option Solution
Cannot write Bad Sector HDX See message.
List to the disk! Format 5
Try backing up the disk Partition
and reformatting. Zero
[OK] Markbad
Cannot write Boot Sector HDX See message.
to the logical drive! ZERO
Try backing up the disk and HINSTALL
reformatting.
[OK]
Cannot write driver HINSTALL HINSTALL cannot write to
file to destination! Install the root directory of the
[OK] drive. Try backing up the
hard disk and reformatting it.
Cannot write Header HDX See message.
to the logical drive! Zero
Try backing up the disk
and reformatting.
[OK]
Cannot write Root Directory HDX See message.
entries to the logical drivel Markbad
Try backing up the disk and
reformatting.
[OoK]
Cannot write Root Sector HDX See message.
to the disk! Format
Try backing up the disk Partition
and reformatting. HINSTALL
[OK] Install
Remove
Cannot write to directory! HDX See message.
Try re-running Markbad on Markbad
this logical drive when the
current Markbad is completed.
[OoK]
Driver file does not exist! HINSTALL The driver file
[OK] Remove SHDRIVER.SYS

has not been installed or is
missing.
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Error
Message

File Allocation Table is
corrupted!

Try backing up the logical
drive and zeroing.

[OK]

Format parameters in the
root sector are corrupted!
Please reformat the disk.
[OK]

HDX.RSC
[OK]

No menu items available
for this disk's capacity.
[OK]

Not enough system memory!
Cannot continue.
[oK]

Reserved sectors are bad!
Try backing up the disk
and reformatling it.

[OK]

Selected partition scheme
is for a bigger capacity unit.
Please select another one.
[OK]

Too many bad sectors to
record. Try backing up
the disk and reformatting.
[OK]

Too many logical drives!
You cannot have more than
14 |ogical drives.

[OK]

Program
andl/or
Option

HDX
Markbad

HDX
Partition

HDX

HDX
Partition

HDX
HINSTALL

HDX
Format
Partition

HDX
Partition

HDX
Markbad

HDX
Format
Partition

Suggested
Solution

Back up the logical drive,
erase its data with the HDX
Zero option, run Markbad,
and restore your data.

See message.

The HDX.RSC file is either
missing or damaged. Copy
the HDX.RSC file from the
original Atari Advanced Hard
Disk Utilities disk onto your
working copy of the disk.

Use the Edit Partition
Scheme dialog box to set
partition sizes.

Your computer's memory
capacity is too low to run
these programs. You need
a minimum of 512 kilobytes.

See message.

See message.

See message.

You cannot have more than
14 logical drives on your
system. Repartition disks as
necessary.

Troubleshooting and Preventive Maintenance
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Error
Message

Unrecognized boot sector!

Either this logical drive's

boot sector is corrupted, or

another utility was used to
artition this disk.

OK]

WINCAP file not found!
Cannot continue.
[OK]

Your system will have to
reboot when you quit HDX,
for new disk information

to take effect.

The Mouse

Program
andl/or
Option

HDX
Zero
Markbad

HDX

HDX
Format
Markbad

Suggested
Solution

Before you can use Zero or
Markbad, you must back up
your hard disk (if necessary)
and reformat with HDX
Format.

Copy the WINCAP file on
the Advanced Hard Disk
Utilities disk to the disk from
which you are running HDX.

No action required. Your
system will reboot when you
quit HDX so the disk
parameters you changed [OK]
can take effecl. Any data in
RAM will be lost.

With time, the mouse may begin to move slowly or sporadically.

If this happens, make sure the mouse is plugged firmly into mouse/
joystick port 0. If the problem persists, the mouse may need clean-
ing. (See the Atari Mouse manual for instructions.)

Monitors

If you have both an Atari color monitor (or TV) and an Atari
monochrome monitor set up side by side, make sure only the one
connected to the computer is switched on. With both monitors
switched on, you may get interference patterns on the screen. If
you only have one monitor switched on and you get interference
patterns, some other peripheral may be causing the trouble. Try
moving power supplies, printers, and modems as far away from the

monitor as possible.

Troubleshooting and Preventive Maintenance




PREVENTIVE MAINTENANCE

To ensure top performance from your computer system, follow the
guidelines in this section.

Caring for the Computer

Always place the system securely on a firm, level surface.
Avoid dusty or greasy work areas.

Keep all components away from extreme heat or moisture.
Keep all components out of direct sunlight.

Do not move the components unnecessarily.

Avoid smoking near the computer system.

Keep liquids away from the components.

Always switch off the system before cleaning it. Clean the outside of
the components with a soft, slightly damp, lint-free cloth only. Do
not use cleansers, abrasives, or solvents.

Always switch the computer off before inserting or removing a
cartridge.

Always switch the computer and peripherals off before connecting
or disconnecting components.

When you switch off the computer, wait at least ten seconds before
you switch it on again.

To ship or store the system, repack it in the original factory packing
materials. Always park the hard disk before moving your computer.

Troubleshooting and Preventive Maintenance
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Caring for Floppy Disks

Do not switch the floppy disk drive off while its busy light is lit.
Do not insert or remove disks while the floppy drive’s busy light is lit.
Do not leave disks in the floppy drive when the drive is off.

Keep_ disks away from sources of magnetism (such as monitors,
televisions, electric motors, and telephones).

Never leave disks in direct sunlight.

Never touch or clean a disk’'s magnetic recording surface inside the
plastic casing.

A FINAL NOTE

Your MEGA ST[E computer system is designed for low maintenance
and high reliability. But like anything electronic and mechanical, the
equipment can break down.

If you experience problems that appear serious, take the computer
(or any other component) to an authorized Atari service center. For
the location of the nearest Atari service center, contact your Atari
dealer or Atari Customer Support. (See Customer Support at the
end of this manual.)

Troubleshooting and Preventive Maintenance
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APPENDIX E

MEGA STe COMPUTER SPECIFICATIONS

Processor

Math Cog)rocessor
(optional

Memory
Graphics Resolutions

Color

Interfaces

Sound Generator

Keyboard

Power Consumption

16 MHz 68000 processor

68881/2 floating point coprocessor

2 or 4 megabytes of RAM, depending on the model
ST Low (320 x 200 x 16)

ST Medium (640 x 200 x 4)

ST High (640 x 400 x 2)

Palette of 4,096 colors

Midi In and Midi Out ports

VME-compatible Eurocard (A24, D16) expansion
slot

Monitor port

Television port

Parallel port

1 Serial port

2 fully configured RS232 Modem ports
Floppy Disk port (includes controller)
LAN Interface

ACSI DMA port (10 megabits per second DMA
transfer rate)

ROM Cartridge port (128 kilobytes capacity)
Mouse/Joystick and Joystick ports
Slereo ports

Pulse Code Modulated (PCM) sound (8-bit digital-
to-analog sound converters)

3 voices from 30 Hz to above audible range; built-in
amplitude envelopes and noise generator

95-key intelligent keyboard using its own
microprocessor

96 Watts (maximum)

MEGA STE Computer Specifications
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41 to 113:F (5to 45“(3). operating or idle, - APPENDIX F
b LR D e SoRE A AT CONNECTOR PINOUT
SPECIFICATIONS

Ambient Temperature

Relative Humidity 20to 80%, operating or idle; (noncondensing) up to
95%, storage or transport

Physical Characteristics MODEM 1 \ a8
Height: 3.54 inches (80 mm)
Width: 19.29 inches (490 mm) DB9 Male

Depth: 11.41 inches (290 mm) "
Internal power supply

1 -- Carrier Detect Input
) a 2 - Received Data Input
Internal Floppy Disk Drive 3 - Transmitted Data Output
4 -- Data Terminal Ready Output
Storage Medium 3Y2-inch floppy disks, double-density, double- 5 - Ground i
or single-sided, 135 tracks per inch & - Not Connected
7 - Request To Send Qutput
Storage Capacity 360 kilobytes per side (formatted MFM); 8 - Clear To Send Input
720 kilobytes total 9 -- Ring Indicator Input
Track Density 135 tracks per inch
T 2 3 4 8
Head Positioning Stepper motor MOREM €
Mechanism DBS Male
Data Transfer Speed 250 kilobits per second i
1 -- Not Connected
2 -- Received Daia Input
3 -- Transmitted Data Output
4 -- Data Terminal Ready Ouiput
5 -- Ground
6 -- Not Connected
7 -- Request To Send Output
8 -- Not Connected
9 -- Not Connected

A Connector Pinout Specifications
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1 2 3 4 38

SERIAL 2
DB9 Male

& T 8 9

1 -- Carrier Detect Input

2 -- Received Data Input

3 - Transmitted Data Output
4 -- Data Terminal Ready Output
5 -- Ground

6 -- Data Set Ready Input

7 -- Request To Send Qutput
8 -- Clear To Send Input
9 -- Synchronous Clock Input
-- -- Synchronous Clock Output

392 %1 0 9 &8 T & % 4.1 2 1

ARALLEL PRINTER W
P \.... /

DB25 Femaie 25 24 23 22 2 0 9 @ 17 16 15 WM
o

-~ Strobe Output
-- Data0 =7

-- Data 1 =

-- Data 2 -

-- Data 3 ==
Data 4 ik

-- Datab =

-- Datab =

-- Data?7 =

--  Not Connected o=

-- Busy Input
--  Not Connected =&
Ground s

—OWo~NNOOAEWN —
1

—_

12-
18

| Connector Pinout Specifications
|

M —
o~
!
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MIDI OUT

5-pin DIN female

O b WP —

MIDI IN

== THRU Transmit Data

-- Shield Ground

-~ THRU Loop Return 2 .
== OUT Transmit Data 5 f
-~ OUT Loop Return 2

5-pin DIN female

D wWwrn =

MONITOR

13-pin DIN

CLOUP~JONHEWN —

—
WA —

== Not Connected

== Not Connected

-- Not Connected 3
-- IN Receive Data

-- IN Loop Return 3

w
-

{art D.6}

--  Audio Out

-- Composite Video

-- Clock Select

--  Monochrome Detect/Clock In

-~ Audio In

-- Green : L
-- Red b '
-- Reserved

-- Horizontal Sync

== Blue

-~ Monochrome

- Vertical Sync

== Ground

Connector Pinout Specifications
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ACSI DMA

ACSl Interface, DB 19 Female

TELEVISION

Shielded connector

Core -- RF Modulated Video e 1 - Data0
Shield -- Ground 2 -- Datal
3 -- Data?2
4 -- Data3
g -- Data 4
-- Datas
FLOPPY DISK 7 -- Data &
g~- Data 7 ST 5 R peaat
14-pin DIN female --  Chip Select e
’ 10 - Interrupt Request \'.'. ok .'.'.'.'.'7
1 -- ReadData 11 -- Ground ——
2 -- Side 0 Select 12 -- Reset =
3 -- Ground 13 -- Ground
4 -- Index Pulse 14 -- Acknowledge
5 -- External Drive Select e 10 15 -- Ground
6 - Internal Pull-up 0 . 16 - Al
7 - Ground 7 o 17 - Ground _
8 -- Motor On 18 -- Read/Write
9 -- DirectionIn * : 19 -- Data Request
10 -- Step LR T
11 -- Write Data
12 -- Write Gate
13 -- Track 00 Detect
14 -- Write Protect

Connector Pinout Specifications
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CARTRIDGE ' MOUSE/JOYSTICK 0
40-pin PCB Edge Connector, Female | DB9Y Male
1 - +5VDC I 1 — XBIU
2 — +5VDC 2= XA.-‘DEwn
3 - Data 14 | 3 -- YAlLeft i85 48
4 - Data15 | 4 - YBIRight
5 -- Data12 5 -- Middle Button/Joystick Up H
6 -- Datai3 6 -- Lelt Button/Fire e
7 -- Data10 7 - +5\VDC
8 -- Datal1 8 -- Ground
9 -- Data8 -- i i ;
-y S 9 Right Button/Joystick 1 Fire
11 -- Dataé
e = By JOYSTICK 1
14 -- Datab
15 -- Data 2 DB9 Male
16 -- Data3
17 -- Data0 1 - Up
18 S Data l 13 5 7.8 M WS TH N DB T HNN BTN 2 = Down 12 %2 4 8
19 -- Address 13 NEE R E e R
20 -- Address 15 e ® 008 808 800808080 ECe S0 £ o F!ight
21 -- Address 8 2 4 B 8 10 12 14 5 18 20 22 24 26 78 30 32 M 36 33 40 5 -- Reserved
22 -- Address 14 | 6 -- Fire Button =
23 -- Address 7 7 = 5 VDC
24 -- Address 9 8 -- Ground
25 -- Address 6 9 -- Not Connecled
26 -- Address 10
27 -- Address 5
28 -- Address 12
29 -- Address 11
30 -- Address 4
31 -- *ROM Select 3
32 -- Address 3
33 -- *ROM Select 4
: 34 -- Address2
35 -- *Upper Data Strobe
36 -- Address i1
37 -- *Lower Data Strobe

38-40 -- Ground

Connector Pinout Specifications
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- | APPENDIX G
STEREO AUDIO OUTP | POWER CONNECTION

Dual Jacks L IN THE UNITED KINGDOM
Tip -~ Audio ;
Shield -  Groun MAINS PLUG
In the United Kingdom, the Atari MEGA STE computer operates on
LAN

240VAC, 50 Hz mains supply. The wires in the main lead of the

MEGA STE are colored as follows:
8 pin Mini-DIN female RS-422

1 -- Handshake Output Output gIrL.Ie:mYe”ow : ﬁigl{;éﬁ)m
2 Handshake Input or Internal Clock Input .

3 -- *Transmit Data Output Brown _ Live (L)

g = EF:gggﬁed Data Input Green/Yellow

6 -- Transmitted Data Output

7 -- General Purpose Input Input |

8 -- Receive Data Input

Fuse

Brown

Cord
Grip

If the colors of the wires do not correspond to the colored markings
identifying the terminals in your plug, proceed as follows:

1. Connect the GREEN/YELLOW wire to the terminal in the plug

marked by the letter E or by the safety earth symbol, or colored
GREEN or GREEN/YELLOW.

2. Connect the BLUE wire to the terminal marked with the letter N
or colored BLACK. Connect the BROWN wire to the terminal
marked with the letter L or colored RED.

3. If you use a 13-amp (BS1363), you must fit a 3-amp fuse. If you
use any other type of plug, you must fit a 3 or 5-amp fuse in
either the plug, the adapter, or on the distribution board.

Power Connection in the United Kingdom
G-1
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MAINS PLUG ADAPTER

The wires in the mains lead are colored in accordance with the
following code:

Blue - Neutral (N)
Brown - Live (L)

If the colors of the terminals in this device do not correspond with
the colors of the terminals in your plug, proceed as follows:

1. Connect the BROWN colored wire colored to the terminal
marked with the letter L or colored RED.

2. Connect the BLUE colored wire to the terminal marked with the
letter N or colored BLACK.

3. If you use a 13-amp (BS1363), you must fit a 5-amp fuse. If you
use any other type of plug, you must fit a 5S-amp fuse in either
the plug, the adapter, or on the distribution board.

Power Connection in the United Kingdom
G-2

GLOSSARY

.ACC The desk accessory extension.

ACSI Atari Computer System Interface. ACSI is a hardware and software
control procedure used to connect devices to the computer’s Hard Disk port
(DMA channel).

active window The window on GEM Desktop that is currently available for
desktop operations such as selecting, copying, moving, and deleting items.
The active window is the only window that you can scroll, update, move, or
resize.

alert box A dialog box designed to bring something to your attention. Alert
dialog boxes are punctuated with stop signs, question marks, or exclamation
points.

.APP An executable GEM program file extension.

application A program written to solve a specific problem or produce a specific
result, and can be executed by a computer. That is, the computer is applied
to the task. (See program.)

back up To make an archive copy of a disk or file. Backing up disks ensures
that information is not lost if the disk is accidentally damaged or erased.

baud The standard unit of transmission speed of data through a modem,
calculated in signaling elements per second.

baud rate The speed at which data are transmitted from one source to
another, usually from one computer through a modem fo another computer.

bee icon The icon displayed on screen whenever the computer transfers or
retrieves information from the disk drive. You cannot proceed to another
action while the bee icon is on screen.

bit The smallest unit of computer data (a binary digit). Eight bits equal one
byte. (See byte.)

boot Initial system load procedure. If the procedure for loading your system is
in ROM, booting is accomplished by switching on your system. (See
coldstart and warmstart.)

boot disk A disk containing the system files needed to boot a computer. (Not
needed for MEGA STE computers, since all MEGA STE system files are in
ROM.)

busy light The light on a disk drive indicating that the drive is reading from or
writing to a disk.

Glossary
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byte A unit of computer data. Each byte consists of eight bits, providing 256
possible values. For example, the letter "a" is stored in memory as one byte.
(See bit and kilobyte.)

cartridge A device (usually containing files and data in ROM) that plugs into
the cartridge slot. Cartridge programs load instantly and do not use any of
the computer's Random Access Memory to load. The cariridge in the
cartridge slot is designated by the c: identifier.

CD-ROM drive A computer-controlled device that reads high-capacity optical
discs and sends the output to the computer.

click To quickly press and release a mouse button. A click on the left mouse
button selects items on the desktop. (See double-click and shift-click.)

clock/calendar The file-dating feature built into the computer and set from the
Control Panel.

close box The small box in the upper left corner of an active window, used to
close the current window.

coldstart Booting the computer by switching the power off and on or pressing
[Control] [Alternate] [Right Shift] [Delete]. A coldstart can be initiated
while the computer is running by switching off the power for 10 seconds,
then switching it back on. A coldstart completely initializes the system.
(Compare to warmstart.)

configure To customize the computer system to your preferences by setting
colors, baud rate, confirmation, and so on.

control panel A desk accessory used to alter and set many of the system'’s
features and options, such as the color palette, mouse and keyboard
response, and the clock/calendar.

copy A command used to duplicate the information in a file, folder, or disk.

current directory The directory currently displayed in a window, as specified
by the pathname in the move bar.

cursor A marker that appears on the screen to indicate the position of the next
action. Text cursors are usually either a blinking block or a solid vertical line.
The mouse pointer is sometimes called a cursor.

daisywheel printer A type of printer that uses a rotating wheel to impact
characters against a ribbon and onto the paper.

data file A collection of information used by an application. Data file icons look
like sheets of paper with one folded corner.

Glossary
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default A value, option, or setting that the computer automatically selects until
you direct it otherwise. For example, items on the deskiop are shown as
icons, by default, unless you change the option in the View menu.

desk accessory An application loaded into memory from the stariup disk
v.fhen you switch on your computer. Desk accessories can be accessed
either directly from the desktop or from an application that uses the menu
bar format. Desk accessory files are identified by the .ACC extension.

desktop The main screen for the computer. It includes (but is not limit
menu bar, two disk icons, and the trash icon. Retane

destination disk The disk that information is written to during a copy
procedure.

dialog bo; An interactive message box that the computer uses o communi-
cate with you. To exit a dialog box, you must acknowledge the message or
choose an option.

direclory_ A list of files. (See current directory, root directory, and
subdirectory.)

disk Idrive: The most common data storage device. The computer uses the
disk drive to read information from or write information to a disk.

disk identifier The letter in a pathname indicating which disk is in use. The
letter is always followed by a colon (:) and a backslash (\). A disk identifier
appears by itself in the move bar of a directory window when the root
directory displays.

diskcopy A procedure that duplicates data from one disk to another disk.

DMA port A high-speed peripheral port for attaching a hard disk drive, CD
RQM drive, or other DMA device to the computer. DMA is an acron‘yrn for
Direct Memory Access. (See ACSL.)

document A collection of data you create or modify using an application. Docu-
ments can contain text, graphics, or both. Also called a file. (See file.)

document type See extension.

dot m_allrix printer A type of printer that forms characters and graphics by
printing small dots.

double-click Two quick clicks on a mouse button. A double-click on the left
mouse button opens a file, disk, or folder.

double—silded Allowing use of both sides of a disk. A double-sided disk has
both sides of its magnetic media certified as safe for storing data. A double-
sided disk can store up to 726,016 bytes of data. A double-sided disk drive
can read, write to, and format both single- and double-sided disks.
(Compare to single-sided.)

Glossary
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drag To move an item on the desktop. To drag, point the mouse pointer at an
item, press and hold down the left mouse button, and move the mouse.
While the item is being dragged, a ghost outline of the item appears on the
desktop.

drop-down menu A list of options that appears below a menu heading when
you touch the menu bar heading with the mouse pointer.

editable text field A dashed line in a dialog box where you can type
characters.

expansion connector An internal connector that permits 'ms}allalion of_
additional specialized hardware with your computer. The signals provided
include a direct extension of the microprocessor bus.

extension The characters to the right of the period in a filename. Extensions
that represent the file type are mandatory. An extension can hgve up to
three characters (letters and numbers). Some common extensions are
.ACC, .APP, .PRG, .TOS, and .TTP.

file A collection of information that can be stored on a disk or in the computer's
memory.

file selector A dialog box, opened from an application, that lists files and
folders. The File Selector dialog box can be accessed from the application.

file specification The search criteria used in a file selector.

filename The name of a file, made up of a mandatory name and an extension,
separated by a period. (See extension and filename.)

floppy disk A magnetic medium used to store informalipn generated on a
computer. The disk is made of material similar to audio tape.

folder A subdirectory for storing files and other folders. A folder appears as a
folder icon (manila folder) on the desktop, or with a folder symbol (small box)
next to its name when shown as text.

format To set the circular patterns on a floppy disk th_at enable it to store )
information. Formatting erases all information previously stored on the disk.

full box The small box in the upper right corner of a window, used to change
the size of a window alternately between a smaller screen and a full-screen.

function keys The keys [F1] through [F10] along the top edge of the _
computer keyboard. Many applications use these keys to perform special
actions.

GEM The portion of TOS that creates and manages all the windows, icons,
menus, and graphics features of the MEGA STE computer. GEM is an
acronym for Graphics Environment Manager.

Glossary
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hard disk A device used to store data on a magnetic surface. A hard disk drive
can store far more data than a floppy disk drive, and can read and write
information many times faster.

hardware The actual physical apparatus of your computer system. (Compare
to software.)

icon_A picture on the desktop that represents a disk, file, folder, or procedure.
The disk icon looks like a filing cabinet: the data file icon looks like sheets of
paper with one corner folded; the program file icon looks like a small
desktop; the folder icon looks like a manila folder: the trash icon looks like a
trash can; and the bee icon looks like a bee.

information line The line at the top of a directory window immediately below
the move bar, telling how many bytes are used by the items listed in the
directory, and how many items there are.

initialize To set the computer 1o its starting configuration.

input/output (/O) The communication process that takes place between the
computer and a peripheral device such as a disk drive or printer. Input is
information the computer receives (that is, it is sent in); output is information
the computer transmits (that is, it is sent out),

interface An electronic connection that allows communication between the
computer and a peripheral.

kilobyte 1,024 bytes of data. (See Byte.)

laser printer A high-speed, high-resolution printer that electrophotographically
produces an image on paper. The Atari SLM804 is a laser printer.

LAN (Local Area Network) is a communications channel that connects
computers and other devices together.

megabyte 1,024 kilobytes of data. The abbreviation for megabyte is MB. (See
kilobyte.)

memory The internal or external media that the computer uses to store data
and programs. There are two kinds of computer memory: RAM (Random
Access Memory) and ROM (Read-Only Memory). RAM loses its dala if the
power is turned off; ROM retains its information whether the computer has
power or not.

menu bar A bar at the top of the desktop. When you first start up your system,
the headings on the menu bar are Desk, File, View, and Options. Other
application programs may have different headings in the menu bar.

Glossary
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MIDI A standard interface designed to connect a computer to a number of
electronic musical devices. MIDI is an acronym for Musical Instrument Digital
Intertace.

modem A device that enables you to connect your computer directly to
telephone lines in order to establish a communication link with other
computers and on-line information networks. Also, the port on the computer
for connecting a modem or other serial device. Modem is a contraction of
MOdulator/DEModulator.

monitor See video display.

mouse A small, hand-manipulated device connected to your computer that
controls the movement of a pointer on the desktop. As you slide the mouse,
a small roller on the bottom tracks the movements. The mouse has two
buttons. The left button is used for most desktop operations. The right
button is used with some applications.

move To move files or folders from their original locations to a different folder
and/or disk.

move bar The bar at the top of an active window. Use the move bar to drag a
window to a new location on the desktop.

MS-DOS Microsoft Disk Operating System. An operating system used with
IBM PC's and compatibles. Floppy disks formatted on the MEGA STE are
compatible with PC systems using MS-DOS and 3% -inch floppy drives.

name The identifying name of a file. A name is mandatory and can have up to
eight characters (letters and numbers).

NEWDESK.INF The file that holds your customized desktop data.
NEWDESK.INF must be in the root directory of the boot disk in order for the
computer to read it during booting.

option Anitem in a drop-down menu that enables you to manipulate the
desktop and the elements on it.

parallel port An interface which accepts the simultaneous transmission of
more than one bit. (See serial port.)

parameter Data given to a program that controls its operation.

pathname The list of items that specifies the path through the subdirectories
on the disk to the current directory. A pathname consists of a disk identifier
and a string of folders separated by backslashes (for example
A:\documentitext\). It may also contain a file specification.

peripheral Any external device, such as a disk drive, monitor, or printer, that
you connect to your computer.

Glossary
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pixel A dot on the computer's video display. Pixels are arranged in a grid, and
set to either 320 x 200, 640 x 200, or 640 x 400 dots per grid, depending on
your screen resolution. Pixel is short for picture element.

pointer The small image on the screen that moves when you move the mouse.

The mouse poilnter is usually an arrow, but it may change to other shapes
such as a bee icon during certain procedures.

.PRG A GEM application file extension.

program A detailed and explicit set of instructions for accomplishing some

purpose, expressed in a language that can be read by a computer. (See
also Application.)

program file A file that contains an applications program. The program file
icon Iooks_ like a small desktop. Double-click the left mouse button on a
program file to execute the program.

prompt Any symbol or message on screen indicating that the computer is
awailing input from the user.

RAM The part of the computer’s memory used to write data to and read data
from a disk. When you work with your computer, the information displayed

on the monitor screen is in RAM. RAM is an acronym for Random Access
Memory.

RGB The color signai_s that the computer produces to create its special color
display. The combinations of 16 different intensities each of red, green, and

blue enable you to create 4,096 colors with the MEGA STE computer. RGB
stands for Red, Green, Blue.

ROM The part of the computer's memory containing the operating system.
ROM never changes. and retains its information with or without power to the
computer. ROM is an acronym for Read-Only Memory.

root y:lireclory Thg first directory displayed when you open a disk. The root
directory is specified by the disk identifier alone (such as AN,

RS232 An industry-standard connection for serial peripherals. The RS232 port
on the back of the computer is labeled "Modem." This port is sometimes
referred to as the serial port.

scroll Scrolling allows different areas of a window to be displayed. You can
scroll left, right, up, or down.

scro!l bar One of two bars that border an active window on the bottom and
right edges. The scroll bars contain the scroll arrows and are shaded if part
of the window's contents cannot be seen. The larger the shaded portion, the
greater the percentage of the window’s contents that is hidden from view.

Glossary
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seclor A section of a track on a hard or floppy disk. Sectors are usually 128,
256, 512, or 1024 bytes long. On a floppy disk, the sectors are 512 bytes
long. (See track.)

selecting Clicking the left mouse button on an icon, file, or menu option.
Selected icons and files highlight to indicate the selection.

serial port An interface which accepts the transmission of data one bit at a
time. (See parallel port.)

shift-click Clicking with the mouse button while holding down the [Shift] key.

single-sided Allowing use of one side only of a floppy disk. A single-sided disk
has only one side of its magnetic media certified as safe for storing data. A
single-sided disk can store up to 357,376 bytes of data. A single-sided disk
drive can read, write to, and format only single-sided disks, or double-sided

disks that have been formatted as single-sided. (Compare to double-
sided))

size box A small box at the lower right corner of a window, used to change the
window's size or shape.

sizing The process of changing the size or shape ot a window.

software The instructions used by your computer to process data. (Compare
to hardware.)

source disk The disk from which information is copied during a Diskcopy
procedure.

startup disk A disk that usually contains desk accessories, applications, and a
desktop configuration (DESKTOP.INF) file. Insert a startup disk in the
floppy drive before the computer is switched on.

subdirectory A directory inside a directory; often called a folder. (See root
directory.)

.TOS The TOS application file extension.
TOS The operating system for the MEGA STE computer,

track One of the circular sections of a disk that can store data. Each track is
made up of smaller sections called sectors. (See sector.)

trash can GEM Deskiop icon used to permanently delete files or folders from
the desktop.

.TTP The TOS-takes parameters file extension.

video display A device containing a video screen that you and your computer
use to communicate.

Glossary
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VMEbus allows you to connect standard VME devices for high speed
asynchronous parallel data transfer.

warmstart Rebooting the computer by pressing the Reset button on the back
of the computer or pressing [Control] [Alternate] [Delete]. A warmstart
only partially initializes the system. (Compare Coldstart.)

wildcarc'l‘ A question mark (?) or asterisk (*) character used in a file
specification to specify the search criterion. "2" replaces one character; "*"
replaces all characters to the end of the first name or extension.

window The work area that the computer uses to display files and folders or to

run programs. Up to four directory windows can be open on the desktop at
one fime.

mile—_;I)tmt?ctTTo mechanically prevent a disk from being formatted, erased. or
written to. To write-protect a disk, move the write-protect tab so vo :
through the notch. P you can see

Glossary
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CUSTOMER SUPPORT

Atari Corporation welcomes inquiries about your Atari computer products.
We also provide technical assistance. Write to Customer Relations at an
address listed below,

Atari user groups also provide outstanding assistance. To receive a list
of Atari user groups in your area, send a self-addressed, stamped enve-
lope to an address below.

In the United States, write to:

Atari Corporation
Customer Relations

Post Office Box 61657
Sunnyvale, CA 94088-61657

In Canada, write to:

Atari (Canada) Corp.
80 Gough Road
Markham, Ontario
Canada L3R 5V5

In the United Kingdom, write to:

Atari Corp. (UK) Ltd.
P. O. Box 555

Slough

Berkshire SL2 5BZ

Please indicate User Group List, Technical Assistance. or the subject of
your letter on the outside of the envelope.
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INDEX

A

About, 6-3
.ACC extension, 4-3, 5-54
ACSI,
port, 1-11 through 1-12
devices, 1-11 through 1-12
active window, 3-13
advanced hard disk utilities*
advanced hard disk utilities
disk files, C-16
erasing the contents of a
logical drive, C-10
extended partition
schemes, C-15, C-16
extending the system wide
folder limit, C-11
formatting and partitioning
the hard drive,
C-4 through C-10
formatting, C-4 through C-6
partitioning, C-6 through C-10
installing and removing the
hard disk driver file, C-3, C-4
installing the hard disk driver, C-3
removing the hard disk driver, C-4
bypassing the hard disk driver, C-4
marking bad sectors, C-11 through C-13
organizing and maintaining
your hard disk, C-14 through C-15
backing up the hard drive, C-14
optimizer programs, C-14 through C-15
parking and unparking the read/
write heads, C-1 through C-3
alert box, 4-1, 4-2
alphanumeric keys, 2-8
[Alternate] [CIr Home] keys, B-1
[Alternate] [Help] keys, B-1
[Alternate] [Insert] keys, 3-5, 3-6
[Alternate] key, 3-4
[Alternate] [Shift] keys, 3-4
.APP extension, 5-4

application,
installing, 4-18
installing to normal or autoboot
status, 4-22
installing to open from function
keystroke, 4-21, 4-22
arguments, 4-18, 4-19
arrow keys, 2-9
audio feedback, 6-13

B

backup copy, 3-18, 3-19
baud rate, 6-15
bell button, 6-13
bit, 2-1

bits/char, 6-16
BLITTER, 4-29
bottom to top, 4-8
brackets, 1-4
busy bee icon, 2-7
byte, 2-1

bytes used, 3-12

C

calculator keypad, 2-9
[Caps Lock] key, 2-8
cartridge, 1-9 through 1-10, 3-3
CD-ROM disc, 2-2

clicking, 3-4

close box, 3-12

close directory, 4-7

close top window, 4-8

[CIr Home] key, B-1

coldstart, 2-10

color, 6-18

connector pinout specifications, F-1 through F-8




Control Panel, 4-4, 6-2 through 6-20
About, 6-3
Setup, 6-3 through 6-8
Advanced Setup Options, 6-6, 6-7
CPX Info, 6-7, 6-8
CPX Mover and Reload
CPXs, 6-4, 6-5
Date and Time, 6-3, 6-4
Open CPXs, 6-7
Unload CPX, 6-8
CPXs, 6-8 through 6-2
Accelerator, 6-21, 6-2
Color Setup, 6-10, 6-11
Configure CPXs, 6-12, 6-13
General Setup, 6-13, 6-14
Modem Setup, 6-15 through 6-17
Printer Setup, 6-17 through 6-19
Sound Setup, 6-19
Window Colors, 6-8, 6-9, 6-10
copy operation,
copying a disk, 3-18, 3-19
file, 3-21
folder, 3-21
source disk, 3-19
CPX directory path, 6-6, 6-7
CPXs, 6-2 through 6-20
cursor, text, 2-9

D

daisy chaining, 1-12
Delete, 4-7
default directory, 4-20, 4-21
define single keystroke, 4-26, 4-27
deleting files and folders, 3-21, 3-22
desk accessories,
Control Panel, 6-1 through 6-20
installing, 6-1
opening, 6-2
Desk menu, 4-3, 4-4
desktop,
files, 3-2
folders, 3-2
icons, 2-6, 2-7, 3-2
initial screen display, 2-6
menu bar, 2-7
pointer, 2-7
windows, 3-2

Desktop Configuration, 4-26, 4-27
Desktop Information, 4-4
destination disk, 3-19

dialog box, 4-1, 4-2

directories and folders, 5-1, 5-2
disk drive, built-in hard disk, 1-7
disk drive, external floppy, 1-11
disk drive, external hard,

ACSI port, 1-12
connecting, 1-11, 1-12

disk drive, built-in floppy, 1-8

disk,

DMA

floppy,

copying, 3-18, 3-19

destination, 3-19

double-sided, 3-16 through 3-19
formatting, 3-16, 3-17, 3-18, 4-9, 4-10
icon, 2-7

inserting, 3-1, 3-2

MS-DOS format compatibility, 3-17
removing, 3-1, 3-2

single-sided, 3-16 through 3-19
source, 3-19

storage capacity, 2-2, 3-16

write protecting, 3-20

'por!, 1-12
devices, 1-12

double clicking, 3-4

double click response, 6-14
dragging, 3-8, 3-9

drive selector, 5-9

E

exclamation point, 1-4
expansion slot, 1-10, 1-13

F

File Mask, 3-12, 5-5
File menu, 4-4 through 4-9

file,
copying, 3-20, 5-12, 5-13
deleting, 4-7, 5-15
invalid file name characters, 5-4
moving, 3-8, 3-9, 5-12, 5-13
naming, 4-5, 4-6, 5-13
opening, 5- 7 through 5-12
pathname, 5-6
program, 5-6
renaming, 4-5, 4-6, 5-14

filename, 5-2, 5-3

file selector, 5-7 through 5-10

file specification, 5-9, 5-10

fill patterns, 4-13

floating point coprocessor, 1-1

filh::ppy gilst, see disk, floppy

Oppy disk drive, see disk dri

flow control, 6-17 e ey

folder,
copying, 3-20, 5-12, 5-13
creating, 4-7
g:leletfna, 4-7, 5-15
invalid folder name characters, 5-5
moving, 3-8, 3-9, 5-14
naming, 4-5, 4-6
opening, 3-11, 3-12
renaming, 4-5, 4-6, 5-14

format floppy disk, 4-9

full box, 3-12

function keys, 2-9, 4-26

G

GEM, 2-3, 2-6
graphics modes chart, 4-25

icon,
changinq the icon identifier, 4-17
changing the icon label, 4-17
desktop, 3-2
floppy disk, 2-7
hard disk, 2-6, 2-7

trash can, 2-7
. window, 3-2
information line, 3-12
;nptl.n"parameter, 4-26, 4-27
nstall application, 4-19 =
install devices, 4-23 B
installing,
applications, 4-18
desk accessories, 6-1
devices, 4-23
icon, 4-14 through 4-18

J

joystick, 1-14

K

keyboard,
alphanumeric keys, 2-8
arrow keys, 2-9
calculator keypad, 2-9
connecting, 1-5
function keys, 2-9, 4-26

) response, 6-14

kilobyte, 2-1

L

LAN, 1-13

I;aS(_er printer port, 1-12
linking a document type to an

application, 4-19, 4-20
logical drive, 3-2

M

main directory, 5-1
mains plug, G-1
mains plug adapter, G-1




megabyte, 2-1
memory,
external memory, 2-1, 2-2
internal memory, 2-1, 2-2
menu bar, 2-7, 3-2, 4-3 through 4-28
MIDI, 1-15
minimum number of slots, 6-6
modem, 1-13
modem recognition, 6-20
monitor, 1-5, 1-6
mouse,
clicking, 3-4
connecting, 1-4
double clicking, 3-4
moving, 3-3
move bar, 3-12
musical instrument digital interface, see MIDI

N

name conflict during copying, 5-13
naming,

files, 4-5, 4-6

folders, 4-5, 4-6
NEWDESK.INF, 4-10, 4-14, 4-26
no sort, 4-11
notations, special, 1-4

o]

on/off switch, 1-6
Open, 4-4, 4-5
Options menu, 4-13 through 4-28

P

palette, 1-1, 4-13

panels and ports, A-1

paper, 6-18

parallel printer, 1-12

parity, 6-16

pathname, 5-5, 5-6

peripheral, see individual listings
pinout specifications, F-1 through F-8
pixel, 3-4

Index
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pointer,
control, quick reference, B-1
controlling with keystrokes, 3-3, 3-4
controlling with the mouse, 3-3
port,
ACSl, 1-12
external floppy drive, 1-11
joystick, 1-14
LAN, 1-13
MIDI, 1-15
modem, 1-13
mouse, 1-4
parallel printer, 1-12
serial, 1-13
power conneclion in the UK, G-1, G-2
.PRG, 5-5
Print Screen, 4-28
printer type, 6-17
processor, 1-1

Q

quality, 6-18
R

RAM, 1-1, 2-2

READ.INF file, 4-25, 4-26
remove desktop icon, 4-23, 4-24
reset button, 1-9

resolution, 4-25

[Return] key, 2-8

ROM, 2-1, 2-2

rubber band box, 3-9, 3-10, 3-11

S

Save Desktop, 4-27, 4-28
screen resolution,
setling, 4-25
available, 4-25
screen saver, 6-19, 6-20
scroll arrow, 3-12
scroll bar, 3-12
scroll box, 3-12

SDUMP.PRG, 4-28

search, 4-6, 4-7

select all items, 4-8

selecting,
a single item, 3-4, 3-5, 3-6, 3-7
anicon, 3-6
default directory, 4-20, 4-21
menu heading, 3-6, 3-7
multiple icons, 3-9
parameter, 4-21
with the mouse button, 3-4, 3-5
with keystroke combinations, 3-5

serial port selector, 6-14

set color and style, 4-12, 4-13

set file mask, 4-8, 4-9

Set Preferences, 4-24, 4-25

setup, 6-3 through 6-8

shift-clicking, 3-10, 3-11

[Shift] key, 2-8

Show as Icons, 4-10, 4-11

Show as Text, 4-10, 4-11

Show Information, 4-5, 4-6

size box, 3-12

size to fit, 4-11

Sort by Date, 4-11

Sort by Name, 4-11

Sort by Size, 4-11

Sort by Type, 4-11

sound, 6-14

source disk, 3-19

specifications, E-1 through E-2

starting your system,
from a hard disk drive, 2-4
from a floppy startup disk, 2-5

status, 6-13

stereo, 1-14

stop sign, 1-4

stop bits, 6-16

switching off the system, 2-9, 2-10

T

television, connecting, 1-6 through 1-8
TOS, 2-2, 2-3

.TOS extension, 5-5

trash can icon, 2-7

troubleshooting, D1 through D-11
.TTP extension, 5-5

U

updating a directory display, 4-1

v

View menu, 4-10 through 4-13
VMEbus, 1-13

w

warmstart, 2-10

warning icon, 1-4

wildcards, 5-9, 5-10

windows,
active, 3-13
closing, 3-11, 3-12
moving, 3-14
opening, 3-11, 3-12
scrolling, 3-15, 3-16
sizing, 3-13

write protecting floppy disk, 3-20

X
XCONTROL.ACC, see Conirol Panel
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